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1  Welcome to the Bluetooth options
The R&S SMM-K60 is a firmware application that adds functionality to generate signals
in accordance with the Bluetooth version 4.2.

Option R&S SMM-K117 adds support for Bluetooth LE signals according to the core
specification v5.4 for Bluetooth wireless technology. This option is an extension of
R&S SMM-K60.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMM100A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMM100A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMM100A service manual.

1.1  Key features

Option R&S SMM-K60 provides Bluetooth signals for basic rate (BR) and enhanced
data rate (EDR) burst types. In addition, it provides also low energy (LE) signals limited
to LE 1 Msymbol/s physical layer.

The following BR and EDR features are supported within R&S SMM-K60:
● Support for three transport modes, the ACL+EDR, SCO, eSCO+EDR transport

modes.
● Support of all packet types for both the basic rate and the enhanced data rate

modes.
● Generation of signals with up to 5238 frames sequence length.
● Configuration of the packet contents with a convenient packet editor or all data

packets, both with optional data whitening.
● Generation of signals in accordance to the "Dirty Transmitter Test" specification for

both, the basic and enhanced data rates. The test enables you to change the start
phase, the frequency drift rate and the frequency drift deviation.

● Power ramp control with possibilities to choose ramp time, rise and fall offset
● Configuration of the clipping, filter and modulation settings

The following LE features are supported within R&S SMM-K60:
● Support for two channel types, the "Advertising" and "Data" channel types.
● Support of all Bluetooth packet types for LE 1 Msymbol/s physical layer (LE 1M

PHY).
● Convenient packet editor for all supported packet types including optional data

whitening.

Key features

https://www.rohde-schwarz.com/manual/smm100a
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● Dirty transmitter test, compliant to the RF test specification with options to change
start phase, frequency drift rate and frequency drift deviation.

● Support of CRC corruption for every 2nd packet
● Power ramp control with configurable ramp time, rise and fall offsets.
● Clipping, filter and modulation settings supported.

The following LE features are supported within R&S SMM-K117:
● Support for two channel types, the "Advertising" and "Data" channel types.
● Support of all Bluetooth packet types for uncoded LE 2 Msymbol/s physical layer

(LE 2M PHY)
● Support of all Bluetooth packet types for LE coded 1 Msymbol/s physical layer (LE

coded PHY)
● Support of CRC corruption for every 2nd packet
● Convenient packet editor for all supported packet types including optional data

whitening.
● Dirty transmitter test, compliant to the RF test specification with options to change

start phase, frequency drift rate, frequency drift deviation, and modulation index
mode.

● Support of Bluetooth Direction Finding using Constant Tone Extension methods
Angle of Arrival or Angle of Departure

1.2  Accessing the Bluetooth dialog

To open the dialog with Bluetooth settings

► In the block diagram of the R&S SMM100A, select "Baseband > Bluetooth".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.3  What's new

This manual describes firmware version FW 5.30.047.xx and later of the
R&S®SMM100A.

Compared to the previous version, it provides the new features listed below:
● Time-based triggering, see "Time Based Trigger" on page 99 and "Trigger Time"

on page 99.
● Editorial changes

What's new
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1.4  Documentation overview

This section provides an overview of the R&S SMM100A user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smm100a

1.4.1  Getting started manual

Introduces the R&S SMM100A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMM100A is not included.

The contents of the user manuals are available as help in the R&S SMM100A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.4.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.4.4  Instrument security procedures

Deals with security issues when working with the R&S SMM100A in secure areas. It is
available for download on the internet.

Documentation overview

http://www.rohde-schwarz.com/manual/smm100a
https://gloris.rohde-schwarz.com
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1.4.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.4.6  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMM100A. It also lists
the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smm100a

1.4.7  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smm100a

1.4.8  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smm100a

1.4.9  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-1: Product search on YouTube

Documentation overview

http://www.rohde-schwarz.com/brochure-datasheet/smm100a
http://www.rohde-schwarz.com/firmware/smm100a
http://www.rohde-schwarz.com/application/smm100a
https://www.youtube.com/@RohdeundSchwarz
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1.5  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMM100A user manual.

1.6  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  About the Bluetooth options
The R&S SMM100A provides you with the ability to generate signals in accordance
with the core specification 5.4 for Bluetooth wireless technology.

This section lists required options and provides background information on basic terms
and principles used in Bluetooth technology.

2.1  Required options

The basic equipment layout for generating Bluetooth signals includes the:
● Baseband Generator(R&S SMM-B9)
● Frequency option (e.g. R&S SMM-B1006)
● Baseband realtime extension (R&S SMM-K520)
● Option Bluetooth EDR (R&S SMM-K60)
● Option Bluetooth 5.x (R&S SMM-K117)

You can generate signals via play-back of waveform files at the signal generator. To
create the waveform file using R&S WinIQSIM2, you do not need a specific option.

To play back the waveform file at the signal generator, you have two options:
● Install the R&S WinIQSIM2 option of the digital standard, e.g. R&S SMM-K255 for

playing LTE waveforms
● If supported, install the real-time option of the digital standard, e.g. R&S SMM-K55

for playing LTE waveforms

For more information, see data sheet.

2.2  About Bluetooth BR/EDR

The frequency band defined for Bluetooth devices is the unlicensed 2.4 GHz Industrial,
Scientific and Medical (ISM) frequency band.
Table 2-1: Operating band

Regulatory range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k = 0 to 78, f = k * 1 MHz + 2402 MHz

Two modulation modes are used for Bluetooth: the mandatory basic rate (BR) and the
optional enhanced data rate (EDR). The BR mode uses binary FM modulation and pro-
vides a data rate of 1 Mbps. The EDR mode uses two types of PSK modulation, the
π/4-DQPSK or 8DPSK, and achieves data rates of 2 Mbps and 3 Mbps, respectively.
All modulations schemes have the symbol rate equal to 1 Msymbol/s.

A time division duplex (TDD) scheme for duplex transmission is defined for both
modes.

About Bluetooth BR/EDR
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The following sections describe signal characteristics in detail:

● Bluetooth packet types for BR/EDR........................................................................13
● Bluetooth transport modes......................................................................................16
● Packet structure and fields......................................................................................16
● Bluetooth modulation schemes...............................................................................19

2.2.1  Bluetooth packet types for BR/EDR

2.2.1.1  ACL packets

The ACL packets are used for asymmetric links and they contain user data or control
data. The table and the figures below give an overview of the ACL packets and their
structure.
Table 2-2: ACL packet - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

DM1 1 0-17 2/3   

DH1  0-27 no  1

DM3  0-121 2/3   

DH3 2 0-183 no Yes, 16-bit 3

DM5  0-224 2/3   

DH5  0-339 no  5

AUX1 1 0-29  no  

Figure 2-1: Packet structure of ACL packets - basic rate

Table 2-3: ACL packets - enhanced rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

2-DH1  0-54   1

2-DH3  0-367   3

2-DH5 2 0-679 no Yes, 16-bit 5

3-DH1  0-83   1

3-DH3  0-552   3

2-DH5  0-1021   5

About Bluetooth BR/EDR
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Figure 2-2: Packet structure of ACL packets - enhanced data rate

2.2.1.2  SCO and eSCO packets

The SCO and eSCO packets are used for symmetric links. The SCO packets are used
for 64 kb/s speech transmission and for transparent synchronous data. The eSCO
packets are also used for 64kb/s speech transmission and transparent data at 64 kb/s
but also at other rates.

The tables and the figures below give an overview of the SCO and eSCO packets and
their structure.
Table 2-4: SCO packets

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

HV1  10 1/3   

HV2 n.a. 20  no  

HV3  30 2/3  n.a.

DV 1 (data only) 10+(0-9) 2/3 (data only) Yes, 16-bit
(data only)

 

Figure 2-3: Packet structure SCO packets

Figure 2-4: Packet structure SCO packets (data only)

Table 2-5: eSCO packets - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

EV3  1-30 no  1

EV4 n.a. 1-120 2/3 Yes, 16-bit 3

EV5  1-180 no (Data only) 3

About Bluetooth BR/EDR
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Figure 2-5: Packet structure eSCO packets - basic rate

Table 2-6: eSCO packets - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

2-EV3  1-60   1

2-EV5 n.a. 1-360 no Yes, 3

3-EV3  1-90  16-bit 1

3-EV5  1-540   3

Figure 2-6: Packet structure eSCO packets - enhanced data rate

2.2.1.3  Link control packets for ACL, SCO, eSCO transport modes

There are some common kinds of packet types. An overview of these packet types is
given in the table below.
Table 2-7: Common link control packets

Transport modes Type Payload
Header
(bytes)

FEC CRC Application

SCO, eSCO, ACL ID    Paging, inquiry, response

SCO, eSCO, ACL NULL n.a. n.a. n.a. Carries Link information to the source,
e.g. about successfully received signal
(ARQN) or the state of the receiving
buffer (FLOW)

SCO, eSCO, ACL POLL    Similar to NULL packet, used by the
Central to poll the Peripheral devices,
must be confirmed

SCO, ACL FHS 18 2/3 Yes Page Central response, inquiry
response, in roll switch

Table 2-8: Common link control packets: packet structure

Packet Type ID Packet Types NULL and PULL Packet Types FHS

About Bluetooth BR/EDR



About the Bluetooth optionsR&S®SMM-K60/-K117

16User Manual 1179.2054.02 ─ 06

2.2.2  Bluetooth transport modes

There are three different transport modes defined in the Bluetooth core specification,
each of them with special applications:
● Synchronous connection-oriented (SCO)

The SCO transport mode is used for a symmetric point-to-point link establishment
between a Central and a specific Peripheral in the piconet.

● Extended synchronous connection-oriented (eSCO)
The eSCO transport mode is used for a symmetric or asymmetric, point-to-point
link establishment between the Central and a specific Peripheral.

● Asynchronous connection less (ACL)
The ACL transport mode is used for a point-to-multipoint link establishment
between the Central and all Peripheral participating on the piconet.

There are some common transmitted packets used by all transport modes and some
specific packets defined for each transport mode.

2.2.3  Packet structure and fields

Almost all Bluetooth transmitted packets have standard format and consist of the
access code, the header and the payload with useful information. The exceptions are
the ID packet which consists of the access code only and NULL and POLL packets
which carry only the access code and the header.

2.2.3.1  Access code

The access code is used for synchronization, DC offset compensation and identifica-
tion. The fields of the access code are shown in the figure below and their meaning is
explained in the table below.

Table 2-9: The access code fields

Field Description Packets

Preamble A fixed zero-one pattern of 4 symbols, used to facili-
tate DC compensation

All packets

Sync word A 64-bit code word derived from a 24-bit address,
improves timing acquisition

All packets

Trailer A fixed zero-one pattern of four symbols, extended
DC compensation

All packets, except ID

2.2.3.2  Header

The header contains link control information. The fields of the header are shown in the
figure and their meaning is explained in the table below.

About Bluetooth BR/EDR
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Table 2-10: The header fields

Field Description Packets

LT_ADDR Logical transport address, indicates the destination Peripheral for a packet in a
Central-to-Peripheral transmission slot and the source Peripheral for a Periph-
eral-to-Central transmission slot

 

TYPE Type code, specifies which packet type is used  

FLOW Flow control, used for flow control of packets over the ACL logical transport.
When the RX buffer in the recipient is full, a STOP indication must be returned.
When the RX buffer can accept data, a "Go" indication must be returned.

All packets,
except ID

ARQN Automatic repeat request number, acknowledgement indication, used to inform
the source of a successful transfer of payload data with CRC can be positive
acknowledged ACK or negative acknowledged NAK,

 

SEQN Sequential numbering scheme to order the data packet stream  

HEC Header-error-check to check the header integrity  

2.2.3.3  Payload format

The payload structure depends on the type of the data field and the data rate. Two
fields are defined in the payload: the synchronous data field and the asynchronous
data field. The ACL packets only have the asynchronous data field and the SCO and
eSCO packets only have the synchronous data field. The exception is DV of SCO
transport mode which has both data fields, synchronous and asynchronous.

Synchronous data fields

Asynchronous data fields

About Bluetooth BR/EDR
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Synchronous and asynchronous data fields

The meaning of some payload fields is given in the table below.
Table 2-11: The payload fields

Field Description

CRC The cyclic redundancy error check

Guard, sync The guard time and synchronization sequence, used for physical layer change of modula-
tion scheme

LLID The logical link identifier, specifies the logical link

Flow Field which controls the flow on the logical channels

The payload format and content of the FHS packet are different from other packets.
The fields of the FHS packet are shown in the figure below and their meaning is
explained in the table below.

Table 2-12: The payload fields for the FHS packet

Field Description

Parity bits Form the first part of the sync word of the access code of the device that sends the FHS
packet

LAP Contains the lower address part of the device that sends the FHS packet

EIR An extended inquiry response, provides miscellaneous information during the inquiry
response procedure

Undefined Reserved for future use and must be set to zero

SR The scan repetition field, indicates the interval between two consecutive page scan win-
dows

Reserved Must be set to 10

UAP Contains the upper address part of the device that sends the FHS packet

NAP Contains the non–significant address part of the device that sends the FHS packet

Class of
device

Contains the class of device of the device that sends the FHS packet. This field is defined
in Bluetooth assigned numbers.

LT_ADDR Contains the logical transport address

About Bluetooth BR/EDR
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Field Description

CLK27-2 Contains the value of the native clock of the device that sends the FHS packet, sampled at
the beginning of the transmission of the access code of this FHS packet

Page scan
mode

Indicates which scan mode is used by default by the sender of the FHS packet

2.2.4  Bluetooth modulation schemes

The modulation used for the basic data rate packets is GFSK (Gaussian Frequency
Shift Keying) with a bandwidth bit period product BT = 0.5. The modulation index is
between 0.28 and 0.35.

The modulation scheme used for enhanced data rate packets changes within the
packet. The access code and packet header have a GFSK modulation scheme and are
transmitted with the basic rate 1 Mbps. The subsequent synchronization sequence,
payload and trailer sequence have a PSK type of modulation and are transmitted with
a data rate of 2 Mbps or optionally 3 Mbps.

The PSK modulation, namely π/4 rotated differential encoded quaternary phase shift
keying (π/4–DQPSK) is defined for the 2 Mbps transmission.

The PSK modulation, namely differential encoded 8-ary phase shift keying (8DPSK), is
defined for the 3 Mbps transmission.

The modulation types and corresponding packet types are given in the table below.
Table 2-13: The modulation types and corresponding packet types

Modulation type Packet types

GFSK ID, NULL, POLL, FHS, DM1, DH1, DM3, DH3, DM5, DH5, AUX1, HV1, HV2, HV3,
DV, EV3, EV4, EV5

GFSK + π/4-DQPSK 2-DH1, 2-DH3, 2-DH5, 2-EV3, 2-EV5

GFSK + 8DPSK 3-DH1, 3-DH3, 3-DH5, 3-EV3, 3-EV5

2.3  About Bluetooth LE

The R&S SMM100A provides you with the ability to generate signals in accordance
with the Low Energy (LE) specification for Bluetooth wireless technology.

Bluetooth LE provides data transfer from low-power devices running on the smallest of
batteries to a larger device, such as a PC, a mobile phone, or a PDA. Bluetooth LE
establishes a connection, e.g. to a wristwatch, a heart rate sensor, or a data transfer
from a digital camera. The generated packets do not support audio content.

A time division duplex (TDD) scheme for duplex transmission is defined. The frequency
band defined for Bluetooth devices is the unlicensed 2.4 GHz "Industrial, Scientific and
Medical" (ISM) frequency band.

About Bluetooth LE
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Table 2-14: Operating band

Regulatory range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k = 0 to 39, f = k * 2 MHz + 2402 MHz

Table 2-15: Channel index

RF channel RF center frequency in MHz Data channel index Advertising channel index

0 2402 - 37

1 to 11 2404 to 2424 0 to 10 -

12 2426 - 38

13 to 38 2428 to 2478 11 to 36 -

39 2480 - 39

Figure 2-7: RF channels

red = advertising channels (primary)
blue = data channels and secondary advertising channels

The core specification of Bluetooth wireless technology defines the limits of output
power level at the maximum power setting. The minimum output power is limited to -20
dBm. The maximum output power for LE is limited to 10 dBm.

The maximum output power for LE is limited to 20 dBm.

The following sections describe signal characteristics in detail:

● Packet formats for LE..............................................................................................20
● Packet types for LE.................................................................................................22
● Packet structure and fields......................................................................................23
● Modulation scheme.................................................................................................26
● Direction finding...................................................................................................... 27

2.3.1  Packet formats for LE

Packet formats for LE uncoded PHY

The following packet format is defined for the LE uncoded PHYs and is used for both
advertising channel packets and data channel packets.

CTEPreamble Access Address PDU CRC

Figure 2-8: LE uncoded PHY packet format
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Each packet consists of four mandatory fields: preamble, access address, PDU, and
CRC. For Bluetooth Direction finding, the optional field Constant Tone Extension (CTE)
is added at the end.
Table 2-16: Packet format for LE uncoded PHY

Physical layer Preamble Access address PDU CRC CTE

LE 1 Msymbol/s 1 octet 4 octets 2 to 257 octets 3 octets 16 µs to 160 µs

LE 2 Msymbol/s 2 octets 4 octets 2 to 257 octets 3 octets 16 µs to 160 µs

The preamble is transmitted first, followed by the access address, followed by the PDU
followed by the CRC and optionally followed by CTE. The entire packet is transmitted
at the same symbol rate. Option R&S SMM-K60 supports LE uncoded 1 Msymbol/s
(LE 1M) physical layer (PHY).

Option R&S SMM-K117 supports optional modulation scheme LE uncoded 2
Msymbol/s (LE 2M) PHY.

Packets take between 44 µs and 2120 µs to transmit. The period extends by an addi-
tional 16 µs to 160 µs, if CTE is active.

Packet formats for LE coded PHY

The following packet format is defined for the LE coded PHY and is used for both
advertising channel packets and data channel packets.

Preamble Access address CI PDUTERM1 TERM2CRC

FEC block 1 FEC block 2

S = 8 coding S = 2 or 8

Figure 2-9: LE coded PHY packet format

Each packet consists of the preamble, FEC block 1, and FEC block 2. The preamble is
not coded. The FEC block 1 consists of three fields: access address, coding indicator
(CI), and TERM1. These fields use the S=8 coding scheme. The CI field determines
which coding scheme is used for FEC block 2. The FEC block 2 consists of three
fields: PDU, CRC, and TERM2. These fields use either the S=2 or S=8 coding scheme,
depending on the value of the CI field.

The entire packet is transmitted with 1 Msymbol/s modulation. The following table cap-
tures the size and duration of the data packet fields.
Table 2-17: Packet format for LE coded PHY

 Pream-
ble

Access
address

CI TERM1 PDU CRC TERM2

Number of uncoded bits 80 32 2 3 16 - 2056 24 3

Duration in µs for S=8 coding 80 256 16 24 128 - 16448 192 24

Duration in µs for S=2 coding 80 256 16 24 32 - 4112 48 6
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Packets take between 462 μs and 17040 μs to transmit.

2.3.2  Packet types for LE

Test packet types

The test packet PDU is subdivided into a PDU header and the payload field. The PDU
header indicates the payload content type and the payload length expresses in octets.
RFU field means reserved for future use.

PDU

Header
2 octets

Payload
0-255 octets

LSB MSB

PDU type
4 bits

RFU
4 bits

Length
8 bits

LE test packets are described in the "Air Interface Packets" section of core specifica-
tion for Bluetooth wireless technology, volume 6, part B.

Advertising channel packet types

The advertising channel PDU has a 16-bit header and a variable size payload. The
header fields of the advertising channel PDU are as shown in "Header" on page 23.
Table 2-18: Advertising packet types:

ADV_IND  SCAN_REQ

ADV_DIRECT_IND SCAN_RSP

ADV_NONCONN_IND CONNECT_IND

ADV_SCAN_IND  

Table 2-19: Additional advertising packet types within R&S SMM-K117:

ADV_EXT_IND  AUX_SCAN_REQ

AUX_ADV_IND AUX_SCAN_RSP

AUX_CHAIN_IND AUX_CONNECT_REQ

AUX_SYNC_IND AUX_CONNECT_RSP

Data channel packet types

The data channel PDU has a 16-bit header, a variable size payload, and can include a
message integrity check (MIC) field as shown in "Header" on page 26.

The MIC field is not included in an unencrypted link layer (LL) connection, or in an
encrypted LL connection with a data channel PDU with a zero length payload. The MIC
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field is included in an encrypted LL connection, with a data channel PDU with a non-
zero length payload. The MIC calculation is specified in the section 1 of core specifica-
tion for Bluetooth wireless technology, volume 6, part E.

Besides the data packet type, instrument supports the following CONTROL_DATA
packet types.
Table 2-20: Control data packet types

Opcode CONTROL_DATA  Opcode CONTROL_DATA

0x00 LL_CONNECTION_UPDATE_IND  0x07 LL_UNKNOWN_RSP

0x01 LL_CHANNEL_MAP_IND  0x08 LL_FEATURE_REQ

0x02 LL_TERMINATE_IND  0x09 LL_FEATURE_RSP

0x03 LL_ENC_REQ  0x0A LL_PAUSE_ENC_REQ

0x04 LL_ENC_RSP  0x0B LL_PAUSE_ENC_RSP

0x05 LL_START_ENC_REQ  0x0C LL_VERSION_IND

0x06 LL_START_ENC_RSP  0x0D LL_REJECT_IND

Table 2-21: Additional control data packet types within R&S SMM-K117:

Opcode CONTROL_DATA  Opcode CONTROL_DATA

0x0E LL_PERIPHERAL_FEAT_REQ  0x14 LL_LENGTH_REQ

0x0F LL_CONNECTION_PARAM_REQ  0x15 LL_LENGTH__RSP

0x10 LL_CONNECTION_PARAM_RSP  0x16 LL_PHY_REQ

0x11 LL_REJECT_EXT_IND  0x17 LL_PHY_RSP

0x12 LL_PING_REQ  0x18 LL_PHY UPDATE_IND

0x13 LL_PING_RSP  0x19 LL_MIN_USED_CHANNELS_IND

2.3.3  Packet structure and fields

2.3.3.1  Advertising channel packet structure

Header

PDU

Header
2 octets

Payload
1-255 octets

LSB MSB

PDU type
4 bits

RFU
1 bit

TxAdd
1 bit

ChSel
1bit

Length
8 bits

RxAdd
1 bit
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● The possible PDU types, indicated in the header of advertising channel PDU, are
listed in the previous tables, see Table 2-18.
The following table shows which channels are supported by which PHYs.

Table 2-22: PDU type vs. PHYs

PDU
type

PDU name Channel Permitted PHY

LE 1M LE 2M LE
coded

0000b ADV_IND Primary advertising x - -

0001b ADV_DIRECT_IND Primary advertising x - -

0010b ADV_NONCONN_IND Primary advertising x - -

0011b SCAN_REQ Primary advertising x - -

 AUX_SCAN_REQ Secondary advertising x x x

0100b SCAN_RSP Primary advertising x - -

0101b CONNECT_IND Primary advertising x - -

 AUX_CONNECT_REQ Secondary advertising x x x

0110b ADV_SCAN_IND Primary advertising x - -

0111b ADV_EXT_IND Primary advertising x - x

AUX_ADV_IND Secondary advertising x x x

AUX_SCAN_RSP Secondary advertising x x x

AUX_SYNC_IND Secondary advertising x x x

AUX_CHAIN_IND Secondary advertising x x x

1000b AUX_CONNECT_RSP Secondary advertising x x x

Others Reserved for future use

x marks supported PHYs

● The ChSel, TxAdd and RxAdd fields contain information specific to the PDU type.
If the ChSel, TxAdd or RxAdd fields are not defined as used in a given PDU then
they are considered Reserved for Future Use.

● The Length field indicates the payload field length in octets.

Payload

The advertising channel PDU types can be divided into the following three groups.
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Table 2-23: Advertising channel PDU types

Advertising
PDUs

ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND, ADV_SCAN_IND

within R&S SMM-K117 also ADV_EXT_IND, AUX_ADV_IND, AUX_SYNC_IND,
AUX_CHAIN_IND

Scanning PDUs SCAN_REQ, SCAN_RSP

within R&S SMM-K117 also AUX_SCAN_REQ, AUX_SCAN_RSP

Initiating PDUs CONNECT_IND

within R&S SMM-K117 also AUX_CONNECT_REQ, AUX_CONNECT_RSP

The following parameters are transmitted in the advertising PDU:
● AdvA, AdvData for ADV_IND, ADV_NONCONN_IND and ADV_SCAN_IND
● AdvA, TargetA (formerly InitA) for ADV_DIRECT_IND
● Extended header length, AdvMode, extended header, AdvData for

ADV_EXT_IND, AUX_ADV_IND, AUX_SYNC_IND and AUX_CHAN_IND
Extended header contains
– AdvA, TargetA, ADI, AuxPtr, Sync Info, Tx power, ACAD, and AdvData

fields

The following parameters are transmitted in the scanning PDU:
● ScanA, AdvA for SCAN_REQ

Within R&S SMM-K117 also for AUX_SCAN_REQ
● AdvA, ScanRspData for SCAN_RSP
● Extended header length, AdvMode, extended header, AdvData for

AUX_SCAN_RSP
Extended header contains
– AdvA, TargetA, ADI, AuxPtr, Sync Info, Tx power, ACAD, and AdvData

fields

The following parameters are transmitted in the initiating PDU:
● InitA, AdvA, LLData for CONNECT_IND

Within R&S SMM-K117 also for AUX_CONNECT_REQ
LLData contains
– AA, CRCinit, WinSize, WinOffset, Interval, Latency, Timeout, ChM, Hop,

and SCA fields
● Extended header length, AdvMode, extended header, AdvData for AUX_CON-

NECT_RSP
Extended header contains
– AdvA, TargetA, ADI, AuxPtr, Sync Info, Tx power, ACAD, and AdvData

fields

For more details, refer to in the section 2.3 Advertising Channel PDU of core specifica-
tion for Bluetooth wireless technology, volume 6, part B.
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2.3.3.2  Data channel packet structure

Header

PDU

Header
2 octets

Payload
0-251 octets

LSB MSB

LLID
2 bits

NESN
1 bit

MD
1 bit

SN
1 bit

Length
8 bits

RFU
3 bits

MIC
4 octets

The 16-bit header field consists of five fields:
● The LLID field of the header specifies the payload format, refer to "Payload"

on page 26.
● The NESN bit indicates a nextExpectedSeqNum used by the peer to acknowledge

the last PDU sent, or to request resending.
● The SN bit indicates a transmitSeqNum to identify packets sent by the link layer.
● The MD bit indicates, whether the device has more data to send.
● The Length field indicates the length of the payload and MIC if included.

Payload

● An LL data PDU is used to send L2CAP data. The LLID field is set to either 01b or
10b.
– For the LLID field set to 01b, the LL data PDU is a continuation fragment of an

L2CAP message, or an empty PDU.
The LL of the Central sends an empty PDU to the Peripheral to allow the
Peripheral to respond with any data channel PDU, including an empty PDU.

– For the LLID field set to 10b, the LL data PDU is a start of an L2CAP message
or a complete L2CAP message with no fragmentation.

● An LL control PDU is used to control the LL connection. The payload consists of
Opcode and CtrData fields. All LL control PDUs have a fixed length, depending on
the Opcode. The Opcode field identifies different types of LL Opcode PDU, see
Table 2-20.

For more details, refer to in the section 2.4 Data Channel PDU of core specification for
Bluetooth wireless technology, volume 6, part B.

2.3.4  Modulation scheme

The modulation is Gaussian frequency shift keying (GFSK) with a bandwidth bit period
product BT = 0.5. The modulation index has to be between 0.45 and 0.55. The manda-
tory modulation scheme is 1 Msymbol/s modulation. It uses a shaped, binary FM to
minimize transceiver complexity.
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Option R&S SMM-K60 supports LE uncoded 1 Msymbol/s (LE 1M) physical layer
(PHY).

Option R&S SMM-K117 supports LE coded 1 Msymbol/s PHY and optional modulation
scheme LE uncoded 2 Msymbol/s (LE 2M) PHY.

2.3.5  Direction finding

Since Bluetooth version 5.1, a Bluetooth LE device can transmit its direction informa-
tion to a Bluetooth receiver. The information is transmitted in direction finding enabled
packets in the LE uncoded PHY. In combination with location information sent on pro-
file-level, the Bluetooth LE receiver can calculate its position.

Angle of Arrival (AoA) method

A Bluetooth LE transmitter sends direction finding enabled packets using a single
antenna. A receiving Bluetooth LE peer device consists of an antenna array linked to
an RF switch which forwards the combined antennae signal to a Bluetooth LE receiver.

The peer device switches its antennae while receiving parts of the packets and captur-
ing I/Q samples. The I/Q samples are used to calculate the phase difference of the
radio signal received by different antennae of the array. For an array of two antennae
with distance d, frequency f of the radio signal and speed of light c, the phase differ-
ence ψ calculates as follows:

ψ = 2πd * cos(Θ) * f / c

The angle of arrival Θ is calculated as follows:

Θ = arccos((ψ * c) / (2πd * f))

Figure 2-10: Angle of Arrival method
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Angle of Departure (AoD) method

A Bluetooth LE transmitter sends direction finding enabled packets using an antenna
array. A receiving Bluetooth LE device, consisting of a single antenna, captures I/Q
samples and the geometry of the antenna array from profile-level information.

For an array with two antennae with distance d, frequency f of the radio signal and
speed of light c, the phase difference ψ calculates as follows:

ψ = 2πd * cos(Θ) * f / c

The angle of departure Θ is calculated as follows:

Θ = arccos((ψ * c) / (2πd * f))

Figure 2-11: Angle of Departure method

The geometry of the antenna array is information that is shared between Bluetooth LE
transmitter and receiver on a profile-level. The antenna switching pattern and the
method of angle estimation is specified by Constant Tone Extension.

For more information, refer to section 8 Direction Finding Using Bluetooth Low Energy
of core specification for Bluetooth wireless technology, volume 1, part A.

Constant tone extension

To transmit direction finding information in packets in the Bluetooth LE Uncoded PHYs,
the link layer packet format is extended by an optional field Constant Tone Extension
(CTE) as illustrated in Figure 2-8. The field has a length between 16 µs and 160 µs
and consists of a constantly modulated series of unwhitened 1s. This modulation
results in a CW tone shifted by 250 kHz (LE1M) or 500 kHz (LE2M) from the LE chan-
nel center frequency.
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The presence, type and length of CTE is specified in the CTEInfo field available for
ADV_SYNC_IND and ADV_CHAIN_IND PDUs.

CTETime RFU CTEType

CTEInfo (8 bit)

Figure 2-12: CTEInfo field

The parts of the CTEInfo field are described in the table below. CTEType specifies, if
AoA or AoD method is used for direction finding.

CTEInfo field Length Value Description

CTETime 5 bit 2 to 20 CTE length = 8 µs * Value

Other values are reserved for future use.

RFU 1 bit 1 to 2 Reserved for future use

CTEType 2 bit 0 AoA Constant tone extension

  1 AoD Constant tone extension with 1 µs slots

  2 AoD Constant tone extension with 2 µs slots

  3 Reserved for future use

If Bluetooth LE devices support AoA/AoD CTE, the antennae within the array follow a
switching pattern specified by the Host. After a guard and reference period, time slots
of 1 µs or 2 µs provide periods for antenna switching and I/Q sampling.

The following figure illustrates the CTE structure for AoA method. On the transmitting
side, there is no antenna switching. On the receiving side, antenna switching and I/Q
sampling alternate in the time slots after the guard and reference period.
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Figure 2-13: CTE structure for AoA method

The following figure illustrates the CTE structure for AoD method. On the transmitting
side, antenna switching and I/Q sampling alternate in the time slots after the guard and
reference period. On the receiving side, I/Q sampling only is performed in every sec-
ond time slot after the guard and reference period.
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Figure 2-14: CTE structure for AoD method

For more information, refer to section 2.5 Constant Tone Extension and IQ Sampling of
core specification for Bluetooth wireless technology, volume 6, part B.
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3  Bluetooth configuration and settings
Access:

► Select "Baseband" > "Bluetooth".

The remote commands required to define these settings are described in Chapter 5,
"Remote-control commands", on page 106.

Settings:

● General settings......................................................................................................32
● Dirty transmitter test settings...................................................................................35
● Channel settings - BR/EDR.....................................................................................40
● Packet configuration - BR/EDR...............................................................................41
● Channel settings - LE..............................................................................................49
● Event / Frame configuration - LE............................................................................ 54
● Packet configuration - LE........................................................................................62
● Test packet configuration - LE.................................................................................88

3.1  General settings

Access:

► Select "Baseband" > "Bluetooth".

The tab provides general settings to call default settings and the "Save/Recall" set-
tings. Also it provides Bluetooth version information, Bluetooth mode settings and
access to further settings.

General settings
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Settings:

State..............................................................................................................................33
Set To Default................................................................................................................33
Save/Recall................................................................................................................... 34
Generate Waveform......................................................................................................34
Bluetooth Version.......................................................................................................... 34
Bluetooth Mode............................................................................................................. 34
Transport Mode.............................................................................................................34
Dirty Transmitter Test.................................................................................................... 35
Filter/Clipping................................................................................................................ 35
Power Ramping.............................................................................................................35

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:STATe on page 110

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

State Not affected by "Set to default"

Bluetooth version R&S SMM-K60: 4.2

R&S SMM-K117: 5.4

Bluetooth mode Basic Rate + EDR

Transport mode ACL(Asynchronous)+EDR

Packet type DH1

Sequence length 1 Frame

Slot timing Tx Test Mode

Data whitening Off

Dirty transmitter test Off

Filter Gauss(FSK)

Clipping state Off

Power ramping function Cosine

Trigger mode Auto

Marker mode Restart

Clock source Internal

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRESet on page 109

General settings



Bluetooth configuration and settingsR&S®SMM-K60/-K117

34User Manual 1179.2054.02 ─ 06

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog on page 109
[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD on page 110
[:SOURce<hw>]:BB:BTOoth:SETTing:STORe on page 110
[:SOURce<hw>]:BB:BTOoth:SETTing:DELete on page 110

Generate Waveform
With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.
Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate on page 112

Bluetooth Version
Displays the version of the standard that the firmware supports.
The displayed version for Bluetooth wireless technology depends on installed options.
For example, "Bluetooth Version" > "5.4" in accordance with Bluetooth core specifica-
tion v5.4, requires R&S SMM-K117.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:VERSion? on page 111

Bluetooth Mode
Determines the Bluetooth mode.
"Basic Rate +EDR"

Selects the standard Bluetooth mode (BR+EDR).
Specific settings of the basic mode are described in Chapter 3.3,
"Channel settings - BR/EDR", on page 40.

"Bluetooth Low Energy"
Selects the Bluetooth LE mode. Specific settings of this mode are
described in Chapter 3.5, "Channel settings - LE", on page 49.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:BMODe on page 109

Transport Mode
Requires "Bluetooth Mode > Basic Rate + EDR".
Selects the transport mode.

General settings
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"ACL+EDR" The transport mode selected is used for a point-to-multipoint link
establishment between the Central and all the Peripherals participat-
ing on the piconet.

"SCO" The transport mode selected is used for a point-to-point link estab-
lishment between a Central and a single Peripheral in the piconet.

"eSCO+EDR" The transport mode selected is used for a symmetric or asymmetric
point-to-point link establishment between a Central and a specific
Peripheral.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TMODe on page 111

Dirty Transmitter Test
Accesses the Dirty transmitter test settings dialog, see page 35.

Filter/Clipping
Accesses the dialog for setting baseband filtering, the modulation settings and clipping,
see Chapter 4.1, "Filter/clipping settings", on page 90.

Power Ramping
Accesses the dialog for setting power ramping, see Chapter 4.2, "Power ramping set-
tings", on page 96.

3.2  Dirty transmitter test settings

Access:

1. Select "Bluetooth" > "General".

2. Select "Dirty Transmitter Test".

Dirty transmitter test settings
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The dialog provides setting to configure dirty transmitter test settings. These set-
tings contain parameters that you can change for the central device signal. It is
used to test the connection under 'dirty transmitter' conditions, and to define the
influence on the receiver quality (bit error rate tests).

The following tables list dirty transmitter parameters according to the Bluetooth test
specification. foffset is the frequency offset, Δterror is the symbol timing error and h is the
modulation index.
Table 3-1: Dirty transmitter test parameters for BR

Set foffset Δterror/ppm h

1 75 -20 0.28

2 14 -20 0.30

3 -2 20 0.29

4 1 20 0.32

5 39 20 0.33

6 0 -20 0.34

7 -42 -20 0.29

8 74 -20 0.31

9 -19 -20 0.28

10 -75 20 0.35

Table 3-2: Dirty transmitter test parameters for EDR

Set foffset Δterror/ppm

1 0 0

2 65 20

3 -65 -20

Table 3-3: Dirty transmitter test parameters for LE

Set foffset Δterror/ppm hstandard hstable *)

1 100 -50 0.45 0.495

2 19 -50 0.48 0.498

3 -3 50 0.46 0.496

4 1 50 0.52 0.502

5 52 50 0.53 0.503

6 0 -50 0.54 0.504

7 -56 -50 0.47 0.497

8 97 -50 0.50 0.500
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Set foffset Δterror/ppm hstandard hstable *)

9 -25 -50 0.45 0.495

10 -100 50 0.55 0.505

*) hstable requires R&S SMM-K117.

Settings:

Set To Default................................................................................................................37
Dirty Transmitter Test.................................................................................................... 37
Start Phase................................................................................................................... 37
Modulation Index Mode.................................................................................................38
Frequency Drift Rate..................................................................................................... 38
Frequency Drift Deviation (+/-)......................................................................................38
Number of Packets per Set........................................................................................... 38
Dirty Transmitter Setting................................................................................................38

└ State................................................................................................................38
└ Carrier Frequency Offset kHz......................................................................... 39
└ Symbol Timing Error....................................................................................... 39
└ Modulation Index.............................................................................................39

Set To Default
Calls the default settings for the dirty transmitter test. Default settings are according to
the specification for Bluetooth wireless technology. The setting corresponds the
selected Bluetooth mode.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault on page 115

Dirty Transmitter Test
Activates or deactivates the dirty transmitter test.
The setting is available for the following packet types:
● BR: DH1, DH3, DH5
● EDR: 2-DH1, 2-DH3, 2-DH5, 3-DH1, 3-DH3, 3-DH5, 2-EV3, 2-EV5, 3-EV3, 3-EV5
● LE: See the tables Table 3-4 and Table 3-5.
For basic rate packets, each enabled set of parameters in the "Dirty Transmitter Set-
ting" is used for a duration of 20 ms. After 20 ms, the following enabled set is used,
continuing with the first enabled set after the sequence is completed.
For EDR packets, the parameter sets apply for 20 packets each.
For LE, each enabled set of parameters in the "Dirty Transmitter Setting" is used. After
the specified Number of Packets per Set (specification defines 50 packets) is transmit-
ted, a following enabled set is used. After the sequence is completed, the transmission
continues with the first enabled set.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState on page 113

Start Phase
Enters a start phase.
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The start phase of the sine wave used to drift the modulated Bluetooth signal around
center frequency + carrier frequency offset is set here.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase on page 115

Modulation Index Mode
Requires option R&S SMM-K117 and "Bluetooth Mode" > "Bluetooth Low Energy".
Specifies the mode of the modulation index h that is standard or stable.
"Standard" Standard modulation index with range hstandard = 0.450 to h = 0.550

"Stable" Stable modulation index with range hstable = 0.495 to h = 0.505

Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode on page 114

Frequency Drift Rate
Sets the frequency drift rate.
A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate on page 114

Frequency Drift Deviation (+/-)
Enters a frequency drift deviation.
A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation on page 113

Number of Packets per Set
For "Bluetooth Mode = Bluetooth Low Energy", specifies the number of test packets to
be transmitted per enabled dirty transmitter set.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet on page 114

Dirty Transmitter Setting
Indicates the dirty transmitter parameters according to the Bluetooth BR test specifica-
tion.

State ← Dirty Transmitter Setting
Activates or deactivates the corresponding parameter set.
If deactivated, the parameters are skipped in the sequence, and the next active set is
used.
Remote commands ...:LONG:SET<ch>:... are used for BR and LE packets. The
instrument provides configuration of up to 10 sets (SET1 to SET10).

Dirty transmitter test settings



Bluetooth configuration and settingsR&S®SMM-K60/-K117

39User Manual 1179.2054.02 ─ 06

Remote commands ...:SHORt:SET<ch>:... are used for EDR packets. The
instrument provides configuration of up to 3 sets (SET1 to SET3).
For basic rate packets, each enabled set applies to 20ms of signal. For EDR packets,
each enabled set applies to 20 packets.
For LE, each enabled set applies to 50 test packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STATe
on page 117
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe
on page 118

Carrier Frequency Offset kHz ← Dirty Transmitter Setting
Determines a carrier frequency offset.
The center frequency of the modulated RF carrier is offset by the specified value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset
on page 115
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset
on page 117

Symbol Timing Error ← Dirty Transmitter Setting
Sets the symbol timing error in ppm.
The symbol timing error modifies the symbol clock frequency by the specified value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror
on page 117
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror
on page 118

Modulation Index ← Dirty Transmitter Setting
(Only for basic rate packets)
Sets the modulation index.
The modulation index h specifies the frequency deviation, defined as:

 is the "symbol rate" and  is the "frequency deviation".
According to the Bluetooth specification, the modulation index can vary between 0.28
and 0.35.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:MINDex
on page 116

Dirty transmitter test settings



Bluetooth configuration and settingsR&S®SMM-K60/-K117

40User Manual 1179.2054.02 ─ 06

3.3  Channel settings - BR/EDR

This dialog provides access to the "Bluetooth Basic Rate + EDR" settings. For LE set-
tings, refer to Chapter 3.5, "Channel settings - LE", on page 49.

Access:

1. Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR".

2. Select "Channel".

The dialog contains the parameters to define the packet type and provides access
to the packet type configuration dialog. The graphic shows the frame structure of
the selected packet type.

Settings:

Packet Type.................................................................................................................. 40
Sequence Length.......................................................................................................... 40
Slot Timing.................................................................................................................... 41
Packet Configuration.....................................................................................................41

Packet Type
Selects the packet type.
The available packets depend on the selected Transport Mode.
All packet types as defined in the Bluetooth specification are supported. For an over-
view, see Chapter 2.2.1, "Bluetooth packet types for BR/EDR", on page 13.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PTYPe on page 119

Sequence Length
Selects the sequence length in frames of the generated signal. The signal repeats after
the specified number of frames.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SLENgth on page 119

Channel settings - BR/EDR
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Slot Timing
Selects the timing mode for the Rx slot.
The graphic below shows the frame structure of the selected Packet Type and slot tim-
ing.

Tx test mode Loopback test mode

A transmitted packet has a duration of N × 625 μs where N is an odd integer larger
than 0. N depends on the type of the transmitted packet. In "Tx Test" mode, N = 1 for
Rx slots.
"Tx Test Mode"

The transmitted Rx package takes 625 symbols, regardless of the
selected packet type.

"Loopback Test Mode"
Extends the Rx slot time according to the selected packet type.
For example, the Rx slot of Packet Type > DH3 takes 3 x 625 sym-
bols.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:STIMing on page 120

Packet Configuration
Access the "Packet Configuration" dialog, see Chapter 3.4, "Packet configuration - BR/
EDR", on page 41.
The current data source for packet and the data whitening state are displayed next to
the button.
Remote command: 
n.a.

3.4  Packet configuration - BR/EDR

Access:

1. Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR".

Packet configuration - BR/EDR
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2. Select "Bluetooth > Channel > Packet Configuration".

The dialog contains the parameters for configuring the packet type.
Available settings vary according to the selected Packet Type and data source.

Settings:

Packet Configuration.....................................................................................................43
└ Data Source for Packet...................................................................................43
└ Data Whitening............................................................................................... 43
└ Synchronize LAP with BD_ADDR...................................................................43
└ LAP for Sync Word......................................................................................... 43
└ Bluetooth Device Address (BD_ADDR)..........................................................43

Header.......................................................................................................................... 44
└ Logical Transport Address.............................................................................. 44
└ Flow Control....................................................................................................44
└ Acknowledgment.............................................................................................44
└ SEQN Start Value........................................................................................... 45

Payload......................................................................................................................... 45
└ Data Source....................................................................................................45
└ Data Length.................................................................................................... 46
└ EIR packet follows.......................................................................................... 46
└ Flow Control....................................................................................................46
└ Scan Repetition Mode.....................................................................................46
└ Class of Device...............................................................................................47

DV Payload................................................................................................................... 47
└ Data Source (Voice Field)...............................................................................47
└ Data Source....................................................................................................48
└ Data Length.................................................................................................... 48
└ Flow Control....................................................................................................48

Data...............................................................................................................................49
└ Packet Length.................................................................................................49

Packet configuration - BR/EDR



Bluetooth configuration and settingsR&S®SMM-K60/-K117

43User Manual 1179.2054.02 ─ 06

Packet Configuration
In this section, specify general Bluetooth BR/EDR packet properties.

Data Source for Packet ← Packet Configuration
The data sent for each packet can be comfortably edited with the packet editor, or filled
with a predefined ALL data sequence.
"Packet Editor" Enables the edit mode to configure the packet fields individually.
"All Data" Fills the generated packets with the selected data source. This mode

is useful if you need to load predefined data contents from a data list
file or the data contents of the packet are not of interest.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket on page 124

Data Whitening ← Packet Configuration
Activates the data whitening.
Evenly distributed white noise is ideal for the transmission, and real data can be forced
to look similar to white noise with different methods called "Data Whitening".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening on page 125

Synchronize LAP with BD_ADDR ← Packet Configuration
(Available for FHS packets)
Activates synchronization of the LAP for Sync Word and the Bluetooth Device Address
> LAP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP on page 128

LAP for Sync Word ← Packet Configuration
(Available for FHS packets)
Sets the 24 bits lower address part (LAP) in the 64 bits sync word separately, if "Syn-
chronize LAP with BD_ADDR > OFF".
The LAP is obtained automatically from the Bluetooth device address "BD_ADDR >
LAP", if "Synchronize LAP with BD_ADDR > ON".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord on page 126

Bluetooth Device Address (BD_ADDR) ← Packet Configuration
Enters the Bluetooth device address. Each Bluetooth device has allocated a unique
48-bit Bluetooth device address (BD_ADDR).
The BD_ADDR can take any values except the 64 reserved LAP values: 0x9E8B00 –
0x9E8B3F.
"NAP" Selects non-significant address part.

The length of NAP is 16 bits or 4 hexadecimal figures.
"UAP" Selects upper address part.

The length of UAP is 8 bits or two hexadecimal figures.

Packet configuration - BR/EDR
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"LAP" Selects lower address part.
The length of LAP is 24 bits or 6 hexadecimal figures.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap on page 121
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap on page 122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap on page 121

Header
Access:
Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Header".

Provides header settings.

Logical Transport Address ← Header
Available for all packet types except ID packet.
Enters the logical transport address for the header.
Each Peripheral, that is active in a piconet, is assigned a primary logical transport
address (LT_ADDR). The all-zero LT_ADDR is reserved for broadcast messages.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress on page 126

Flow Control ← Header
Available for all packet types except ID packet.
Sets the FLOW bit in the header. This bit indicates start or stop of transmission of
packets over the ACL logical transport.
"Go" Allows the other devices to transmit new data.
"Stop" Stops the other devices from transmitting data temporarily.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl on page 126

Acknowledgment ← Header
Available for all packet types except ID packet.
Sets the ARQN bit of the packet header.
"NAK" Request to retransmit the previous payload.
"ACK" Previous payload has been received successfully.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement on page 120

Packet configuration - BR/EDR
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SEQN Start Value ← Header
Available for all packet types except ID packet.
Sets the start value of the header SEQN bit.
The SEQN bit is present in the header to filter out retransmissions in the destination.
The signal generator is altering this bit automatically on consecutive frames, if a
sequence length of at least two frames is set.
"0" The SEQN bit starts with 0.
"1" The SEQN bit starts with 1.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue on page 128

Payload
Access:
Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Payload".

Provides payload settings.

Data Source ← Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Selects the data source used for the payload.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "Modulation Data" in the R&S SMM100A user manual.
● Section "File and Data Management" in the R&S SMM100A user manual.

Packet configuration - BR/EDR
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● Section "Data List Editor" in the R&S SMM100A user manual
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA on page 122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern on page 123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection on page 123

Data Length ← Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Enters the payload data length in bytes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth on page 124

EIR packet follows ← Payload
Available for FHS packets.
Indicates that an extended inquiry response packet can follow.
"Yes" Indicates that an EIR packet follows.
"No" Indicates that EIR does not follow.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows
on page 125

Flow Control ← Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)
Sets the FLOW bit in the payload (flow control per logical link)
"Go" Indicates start of transmission of ACL packets after a new connection

has been established.
"Stop" Indicates stop of transmission of ACL packets before an additional

amount of payload data is sent.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl on page 127

Scan Repetition Mode ← Payload
Available for FHS packets.
The 2-bit scan repetition field indicates the interval between two consecutive page
scan windows, determines the behavior of the paging device.
"R0" The scan interval is equal to the scan window TW_page_scan (contin-

uous scan) and maximal 1.28s.
"R1" The scan interval is maximal 1.28s.
"R2" The scan interval is maximal 2.56s.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode on page 128

Packet configuration - BR/EDR
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Class of Device ← Payload
Available for FHS packets.
A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice on page 122

DV Payload
Access:
Select "Bluetooth > Transport Mode = SCO > Channel > Packet Type = DV > Packet
Configuration > Data Source for Packet = Packet Editor > DV Payload".

Provides DV payload settings.

Data Source (Voice Field) ← DV Payload
(Available for DV packets)
Selects the data source for the voice field.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "Modulation Data" in the R&S SMM100A user manual.
● Section "File and Data Management" in the R&S SMM100A user manual.
● Section "Data List Editor" in the R&S SMM100A user manual

Packet configuration - BR/EDR
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa on page 129
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern on page 123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection
on page 124

Data Source ← DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Selects the data source used for the payload.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "Modulation Data" in the R&S SMM100A user manual.
● Section "File and Data Management" in the R&S SMM100A user manual.
● Section "Data List Editor" in the R&S SMM100A user manual
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA on page 122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern on page 123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection on page 123

Data Length ← DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Enters the payload data length in bytes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth on page 124

Flow Control ← DV Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)
Sets the FLOW bit in the payload (flow control per logical link)
"Go" Indicates start of transmission of ACL packets after a new connection

has been established.

Packet configuration - BR/EDR
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"Stop" Indicates stop of transmission of ACL packets before an additional
amount of payload data is sent.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl on page 127

Data
Access:
Select "Packet Configuration > Data Source for Packet = All Data > Data".

Provides data settings.

Packet Length ← Data
(Available in "All Data" mode and for all packet types except ID packet.)
Enters the packet length in symbols.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth on page 127

3.5  Channel settings - LE

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. Select "Channel".

The tab provides settings to configure channel settings and general packet set-
tings.

Channel settings - LE
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To display Bluetooth LE event or frame sequences

Depending on the channel type packet type and packet format, the "Channel" tab dis-
plays a chart at the bottom that illustrates sequences of the corresponding events or
frames. The following steps provide examples to illustrate default sequences for differ-
ent channel types.

1. To display the sequence for an advertising channel, select the following:

a) Select "Channel Type" > "Advertising".
b) Select, for example, "Packet Type" > "ADV_DIRECT_IND".

The chart displays one sequence of ADV_DIRECT_IND packets including markers
for event start and event stop.

2. To display the sequence for a data channel, select the following:

a) Select "Channel Type" > "Data".
b) Select, for example, "Packet Type" > "DATA".

The chart displays one sequence of DATA PDUs including markers for event start
and event stop.

Channel settings - LE
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Channel Type
Determines the channel type.
"Advertising" Selects channel type advertising.
"Data" Selects the data channel type.

Devices in a connected state transmit the data channel packets in
connection events with a start point and an interval.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CTYPe on page 131

Packet Type
Selects the packet type that is the PDU type.
Available packet types depend on the channel type and installed options, see the
tables Table 3-4 and Table 3-5.
Table 3-4: Packet/PDU types and channel types

Packet/PDU type Channel type Option

ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND, SCAN_REQ, SCAN_RSP, CON-
NECT_IND

Advertising R&S SMM-K60

DATA, CONTROL_DATA Data R&S SMM-K60

TEST PACKET Advertising, data R&S SMM-K60

CONTINUOUS Advertising, Data R&S SMM-K60

ADV_EXT_IND *), AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_REQ, AUX_SCAN_RSP,
AUX_CONNECT_REQ, AUX_CONNECT_RSP

Advertising R&S SMM-K117

*) PDU type ADV_EXT_IND is available for LE 1M PHY and LE Coded PHY. For more
information, see data sheet.
CONTROL_DATA packets/PDUs depend on the controller role and installed options.

Channel settings - LE
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Table 3-5: CONTROL_DATA PDU and controller role

CONTROL_DATA PDU Controller role Option

LL_CONNECTION_UPDATE_IND, LL_CHAN-
NEL_MAP_IND, LL_ENC_REQ, LL_FEATURE_REQ,
LL_PAUSE_ENC_REQ

Central R&S SMM-K60

LL_ENC_RSP, LL_UNKNOWN_RSP, LL_FEATURE_RSP,
LL_PAUSE_ENC_RSP

Peripheral R&S SMM-K60

LL_TERMINATE_IND, LL_START_ENC_REQ,
LL_START_ENC_RSP, LL_VERSION_IND,
LL_REJECT_IND

Central or Peripheral R&S SMM-K60

LL_PHY UPDATE_IND Central R&S SMM-K117

LL_PERIPHERAL_FEAT_REQ, LL_CONNEC-
TION_PARAM_RSP, LL_PHY_RSP, LL_MIN_USED_CHAN-
NELS_IND

Peripheral R&S SMM-K117

LL_CONNECTION_PARAM_REQ, LL_REJECT_EXT_IND,
LL_PING_REQ, LL_PING_RSP, LL_LENGTH_REQ,
LL_LENGTH__RSP, LL_PHY_REQ, LL_CTE_REQ,
LL_CTE_RSP, LL_PERIODIC_SYNC_IND,
LL_CLOCK_ACCURACY_REQ, LL_CLOCK_ACCU-
RACY_RSP

Central or Peripheral R&S SMM-K117

How to: "To display Bluetooth LE event or frame sequences" on page 50
Remote command: 
[:SOURce<hw>]:BB:BTOoth:UPTYpe on page 132

Packet Format
Selects the packet format that is the format according to the physical layer (PHY) that
supports the PDU type.
"LE 1M" LE uncoded PHY with 1 Msymbol/s modulation
"LE 2M" Requires R&S SMM-K117.

LE uncoded PHY with 2 Msymbol/s modulation
"LE Coded" Requires R&S SMM-K117.

LE coded PHY with 1 Msymbol/s modulation
See also Table 2-22.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PFORmat on page 131

Duty Cycle
Requires R&S SMM-K117 and "Packet Type" > "ADV_DIRECT_IND".
Specifies the duty cycle for directed advertising.
"High" Transmits the "ADV_DIRECT_IND" packet expecting an advertising

event interval.
"Low" Transmits the "ADV_DIRECT_IND" packet expecting an advertising

event interval and advertising event delay.
See also "Advertising Event Interval" on page 56.

Channel settings - LE
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:DCYCle on page 131

Sequence Length
Selects the number of frames or events depending on the packet type. The signal
repeats after this number.
The packet types SCAN_REQ, CONNECT_IND, AUX_SCAN_REQ and AUX_CON-
NECT_REQ define the sequence length in frames. All other packets use events.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:USLength on page 133

Bluetooth Controller Role
Requires "Channel Type" > "Advertising"/"Data".
Determines the controller role. Depending on the channel type, displays the controller
role or you can select it.

Bluetooth controller
role

Channel type PDU type

Advertiser (read-only) Advertising ADV_IND, ADV_DIRECT_IND, ADV_NON-
CONN_IND, ADV_SCAN_IND, SCAN_RSP,
ADV_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP, AUX_CON-
NECT_RSP, TEST PACKET

Scanner (read-only) Advertising SCAN_REQ, AUX_SCAN_REQ

Initiator (read-only) Advertising CONNECT_IND, AUX_CONNECT_IND

Central Data DATA, CONTROL_DATA

Peripheral Data DATA, CONTOL_DATA

See also "Payload" on page 24 and Table 3-5.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:BCRole on page 130

Bluetooth Controller State
Requires "Packet Type" > "Data"/"CONTROL_DATA".
Displays the state of the Bluetooth controller.
"Connected" Controller connected using a data channel.
"Disconnected" Controller disconnected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:BCText? on page 108

Corrupted CRC Every 2nd Packet
If enabled, sets the ratio of packets with CRC faults to 50%. 50% of packets are gener-
ated with correct CRC. This setting is appropriate for packet error rate (PER) report
integrity tests.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CCRC:STATe on page 130

Channel settings - LE
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Payload Type
Requires "Packet Type" > "CONTINUOUS".
Specifies the pattern for continuous packets. The transmitted packets do not contain
packet header information.
For supported payload types, refer to "Payload Type" on page 89.

Duration
Requires "Packet Type" > "CONTINUOUS".
Specifies the transmission duration.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DURation on page 134

Modulation Format
Requires "Packet Type" > "CONTINUOUS".
Specifies the physical layer.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:MFORmat on page 133

Event Configuration/Frame Configuration
Access the configuration"Event Configuration" dialog, if the sequence length of the
packet type is expressed in events, and accordingly, the "Frame Configuration" dialog,
if it is expressed in frames, see Chapter 3.6, "Event / Frame configuration - LE",
on page 54.
Also, the button displays the data whitening state, see "Data Whitening" on page 63.

Test Packet Configuration
Requires "Packet Type" > "TEST PACKET".
Accesses the "Test Packet Configuration" dialog, see Chapter 3.8, "Test packet config-
uration - LE", on page 88.

3.6  Event / Frame configuration - LE

Access:

1. Select "Bluetooth > General > Bluetooth Mode > Bluetooth Low Energy"

2. Select "Channel > Event / Frame Configuration".

The "Event" or "Frame" dialogs vary, depending on the used channel type.

Event / Frame configuration - LE
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Figure 3-1: Event configuration dialog of the advertising channel type (advertiser)

Figure 3-2: Frame configuration dialog of the advertising channel type (scanner)

Figure 3-3: Event configuration dialog of the data channel type

The dialogs provide settings to configure event or frame settings. Also, they pro-
vide access to the packet configuration dialogs.
The graphics show the distribution of the packets, the physical channel mapping
and the channel indices. The channel table gives an overview of the used channels
and their assignments.
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Settings

● Advertising event / frame settings...........................................................................56
● Data event settings................................................................................................. 58
● Channel table settings.............................................................................................61

3.6.1  Advertising event / frame settings

The following section describes the parameters necessary for the advertising event or
frame configuration.

Settings:

Advertising Event Interval............................................................................................. 56
Periodic Advertising Interval..........................................................................................56
Advertising Event Delay................................................................................................ 56
Scan Window................................................................................................................ 57
Scan Interval................................................................................................................. 57
Advertising Packet Interval............................................................................................57
Transmit Window Offset................................................................................................ 57
Transmit Window Size...................................................................................................58
Packet Configuration.....................................................................................................58
Channel Table............................................................................................................... 58

Advertising Event Interval
Sets the time interval between two consecutive advertising events, regarding the start-
ing points.
Note: This parameter is relevant for advertising event configuration and for the packet
types ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND and ADV_SCAN_IND.
Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: ADV_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND.
Remote command: 
For packet type "ADV_DIRECT_IND" and duty cycle high:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval on page 137
For all others:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval on page 137

Periodic Advertising Interval
Sets the time interval between the start of two AUX_SYNC_IND PDUs from the same
advertising set.
Option R&S SMM-K117 is required.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
on page 141

Advertising Event Delay
Sets a time delay between the start times of two consecutive advertising events. The
value is added to the advertising event interval.
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Note: This parameter is relevant for advertising event configuration and for the packet
types ADV_IND, ADV_DIRECT_IND with low duty cycle, ADV_NONCONN_IND and
ADV_SCAN_IND.
Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: ADV_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay on page 137

Scan Window
Sets the length of the window during which the scanner is operating in the advertising
channel.
Note that the scan window is less or equal to the value of the scan interval.
Note: This parameter is relevant for advertising frame configuration and for the packet
type SCAN_REQ.
Within the option R&S SMM-K117, the packet type AUX_SCAN_REQ is also relevant
for the setting.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow on page 143

Scan Interval
Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.
Note: This parameter is relevant for advertising frame configuration and for the packet
type SCAN_REQ.
Within the option R&S SMM-K117, the packet type AUX_SCAN_REQ is also relevant
for the setting.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval on page 143

Advertising Packet Interval
Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.
Note: This parameter is relevant for advertising frame configuration and for the packet
type SCAN_RSP.
Within the option R&S SMM-K117, the packet type AUX_SCAN_RSP is also relevant
for the setting.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval on page 138

Transmit Window Offset
Displays the start point of the transmit window.
Note: This parameter is relevant for advertising frame configuration and for the packet
type CONNECT_IND.
Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: AUX_CONNECT_REQ, AUX_CONNECT_RSP.
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This parameter is set in the packet configuration dialog, see "Transmit Window Offset"
on page 74.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
on page 180

Transmit Window Size
Indicates the size of the transmit window, regarding to the start point.
Note that the scan window size is less or equal to the value of the connection interval.
Note: This parameter is relevant for advertising frame configuration and for the packet
type CONNECT_IND.
Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: AUX_CONNECT_REQ, AUX_CONNECT_RSP.
The parameter is set in the packet configuration dialog, see "Transmit Window Size"
on page 73.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo? on page 144

Packet Configuration
Opens the dialog for setting the corresponding packet configuration.
This dialog is described in Chapter 3.7, "Packet configuration - LE", on page 62.

Channel Table
Selects the channel to be used for configured packets. The description is covered in
Chapter 3.6.3, "Channel table settings", on page 61.

3.6.2  Data event settings

The following section describes the parameters necessary for the data event connec-
tion.

Settings:

No. Of Tx Packets/Event...............................................................................................58
Connection Event Interval............................................................................................. 59
LL Connection Mode..................................................................................................... 59
Long Term key (hex)..................................................................................................... 60
Selected Data Channel Index....................................................................................... 60

No. Of Tx Packets/Event
Sets the number of Tx packets per event.
Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.
Note: This parameter is relevant for data event connection settings.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber on page 142
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Connection Event Interval
Set the time interval between the start points of two consecutive connection events.
Subsequent transmissions within an event are separated by this parameter to separate
connecting event starting points in time.
Note: This parameter is relevant for data event connection settings and advertising
frame configuration with the packet type DATA and all CONTROL_DATA packet types.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
on page 163

LL Connection Mode
Select the link layer connection mode. To provide safe transmission of payload data,
the data in the packet can be encrypted. If activated, the payload data follows MIC
(message authentication code).
Note: This parameter is relevant for data event connection settings.
The following table shows which types of packets can be encrypted and / or unencryp-
ted.
Table 3-6: Data packet encryption

Packet type encryp-
ted

unen-
crypted

 Packet type encryp-
ted

unen-
crypted

DATA x x  LL_UNKNOWN_RSP x x

LL_CONNEC-
TION_UPDATE_IND

x x LL_FEATURE_REQ x x

LL_CHANNEL_MAP_IND x x LL_FEATURE_RSP x x

LL_TERMINATE_IND x x LL_PAUSE_ENC_REQ - x

LL_ENC_REQ - x LL_PAUSE_ENC_RSP x -

LL_ENC_RSP - x  LL_VERSION_IND x x

LL_START_ENC_REQ - x  LL_REJECT_IND x x

LL_START_ENC_RSP x -     

Table 3-7: Encryption of additional packet types within R&S SMM-K117:

Packet type encryp-
ted

unen-
crypted

 Packet type encryp-
ted

unen-
crypted

LL_PERIPHERAL_FEA-
TURE_REQ

x x  LL_PHY_RSP x x

LL_CONNEC-
TION_PARAM_REQ

x x LL_PHY_UPDATE_IND x x

LL_CONNEC-
TION_PARAM_RSP

x x LL_MIN_USE_CHAN-
NELS_IND

x x

LL_REJECT_EXT_IND x x LL_CTE_REQ x x

LL_PING_REQ x x  LL_CTE_RSP x x

LL_PING_RSP x x  LL_PERIODIC_SYNC_IND x x
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Packet type encryp-
ted

unen-
crypted

 Packet type encryp-
ted

unen-
crypted

LL_LENGTH_REQ x x  LL_CLOCK_ACCU-
RACY_REQ

x x

LL_LENGTH_RSP x x  LL_CLOCK_ACCU-
RACY_RSP

x x

LL_PHY_REQ x x     

"Un-encrypted" Payload data is transmitted without encoding. Example of packet type
data:

"Encrypted" The link layer connection runs in encrypted mode. Example of packet
type data:

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode on page 138

Long Term key (hex)
Indicates the time the controller needs to receive the long-term key from the host. After
this time, the controller is ready to enter into the last phase of encryption mode setup.
Note: This parameter is relevant for data event connection settings. In encrypted
mode, the code can be edited.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey on page 139

Selected Data Channel Index
Indicates the number of the first active data channel.
The data channel is selected for each connection event. The Central and Peripheral
determine the used data channel by selecting from the list of used channels (see
"Channel Table" on page 61).
Note: This parameter is relevant for data event connection settings.
Displays the data channel index currently selected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI? on page 142
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3.6.3  Channel table settings

Access:

1. Follow the directions in Chapter 3.6, "Event / Frame configuration - LE",
on page 54.

2. Select "Channel Table"

The dialog varies, depending on the used channel type.

The channel table displays all possible channels and with their characteristics and
selects the channels to be used for generated packets. Channel frequencies are indi-
cated above the channel table.

Settings:

Channel Table
The channel table displays configured parameters characterizing the channel and the
current state.
Every channel is represented with bit positioned as per the data channel index. LSB
represents data channel index 0 and the bit in position 36 represents data channel
index 36.
If the channel is used, its channel bit is to be set to '1'. Bit value '0' indicates that the
channel is unused.
The bits in positions 37, 38 and 39 must be set to zero upon transmission and ignored
upon receipt.
"Center Frequency"

Indicates the center frequency of a channel. The graphical represen-
tation is displayed above the channel table.

"Channel Index"
Indicates the channel index. The graphical representation is dis-
played above the channel table.

"Channel Type"
Indicates the channel type. The graphical representation of possible
transmission position is displayed above the channel table.
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"Channel State"
Specifies the channels to be used for generated packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:
CHANnel<ch0>:STATe on page 136
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:
CHANnel<ch0>:STATe on page 136
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DCMTable:CHANnel<ch0>:STATe
on page 136

3.7  Packet configuration - LE

Access:

1. Select "Bluetooth" > "General".

2. "Bluetooth Mode" > "Bluetooth LE".

3. Select "Channel" > "Channel Type" > "Advertising"/"Data".

4. Select "Event Configuration"/"Frame Configuration".

5. In the opening dialog, select "Packet Configuration".

The dialog provides settings to configure the parameters of the selected packet
type.

Settings:

● General packet configuration.................................................................................. 63
● Header configuration...............................................................................................63
● Main payload configuration dialog...........................................................................67
● Additional payload configuration dialogs.................................................................83

Packet configuration - LE



Bluetooth configuration and settingsR&S®SMM-K60/-K117

63User Manual 1179.2054.02 ─ 06

3.7.1  General packet configuration

This section describes the upper part of the "Packet Configuration" tab.

Settings:

Data Whitening..............................................................................................................63
Access Address............................................................................................................ 63

Data Whitening
Activates data whitening.
Evenly distributed white noise is ideal for the transmission and real data can be forced
to look similar to white noise with different methods called "Data Whitening". Applied to
the PDU and CRC fields of all packet types, whitening is used to avoid long equal
sequences in the data bit stream.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
on page 150

Access Address
Sets the access address of the link layer connection.
Bluetooth LE transmissions are based on an interface packet format that consists of a
preamble (8 bits) the access address (32 bits), the PDU and CRC (24 bits).
Access address is used to identify communications on a physical channel, and to
exclude or ignore packets on different physical channels. The channels are using the
same PHY channels in physical proximity.
The structure of access address depends on the packet type:
● Data channel packets

The access address is a pseudo-random LL connection address, generated by the
initiator of the LL connection. The address has to follow some specific rules, which
are described in the Bluetooth LE technology.

● Advertising channel packets
The address is fixed to 01101011011111011001000101110001 with the leftmost bit
sent first and being the LSB.

Note: This parameter is relevant for all available package types specified in event or
frame configuration of a data or advertiser channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
on page 151

3.7.2  Header configuration

1. Follow the description in Chapter 3.7, "Packet configuration - LE", on page 62.
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2. Select "Header".

The tab provides settings to configure the PDU header settings.

Settings:

NESN Start Value..........................................................................................................64
SN Start Value...............................................................................................................64
Channel Selection......................................................................................................... 64
CRC Initial..................................................................................................................... 65
CTEInfo Present............................................................................................................65
CTEInfo Configuration...................................................................................................65

└ CTETime.........................................................................................................65
└ CTEType.........................................................................................................66
└ Antenna Number.............................................................................................66
└ AntennaX Gain................................................................................................66

Devices Tx/Rx Address Type........................................................................................ 66

NESN Start Value
Sets the start value of the next expected packet from the same device in the LL con-
nection ("Next Expected Sequence Number"). This parameter can be set in the first
event. From the second event, this field is not indicated.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue
on page 152

SN Start Value
Sets the sequence number of the packet. This parameter can be set in the first event.
From the second event, this field is not indicated.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue
on page 152

Channel Selection
Requires option R&S SMM-K117.
Specifies the algorithm of channel selection signaled via advertising packet types.
"Algorithm #1" Channel selection only for connection events.
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"Algorithm #2" Channel selection for connection events and periodic advertising
packets.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection

CRC Initial
Sets the initialization value for the 24 bits cyclic redundancy check (CRC) calculation.
A packet has been received correctly, when it has passed the CRC check.
Note: This parameter is relevant for data channel types and for advertising packet type
CONNECT_IND.
Within R&S SMM-K117 also for AUX_CONNECT_REQ.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue
on page 151

CTEInfo Present
Activates the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent
on page 152

CTEInfo Configuration
Requires "CTEInfo Present = On".
Accesses the CTEInfo configuration dialog, in which you define CTE length and the
CTE method used for direction finding.

Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.

CTETime ← CTEInfo Configuration
Sets the CTETime comprising the length of constant tone extension field of the Blue-
tooth LE PDU.

Packet configuration - LE



Bluetooth configuration and settingsR&S®SMM-K60/-K117

66User Manual 1179.2054.02 ─ 06

Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe
on page 153

CTEType ← CTEInfo Configuration
Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe
on page 153

Antenna Number ← CTEInfo Configuration
Requires "CTEType > AoD(1us)/AoD(2us)"
Specifies the number of antennas for angle of departure (AoD) direction finding
method. You can select up to four antennas, that are used for direction finding.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber on page 154

AntennaX Gain ← CTEInfo Configuration
Requires "CTEType > AoD(1us)/AoD(2us)"
Specifies the gain of the antenna "AntennaX", where X is 0 to 3 depending on the num-
ber of antennas. You can specify the antenna gain information of up for four individual
antennas for direction finding.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> on page 154

Devices Tx/Rx Address Type
Selects the address type of a Bluetooth LE device. Depending on the Bluetooth con-
troller role, either the Tx or Rx or both address types are assigned.
The format of the device address differs depending on the selected address type.
Note: This parameter is relevant for advertising event or frame configuration. The
Bluetooth controller role and the packet type determine the available entries.
Device address type and corresponding packet types:
● "Tx" for the packet types ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,

ADV_SCAN_IND, SCAN_REQ, SCAN_RSP and CONNECT_IND
Within R&S SMM-K117 also with the packet types ADV_EXT_IND,
AUX_ADV_IND, AUX_CHAIN_IND, AUX_SYNC_IND, AUX_SCAN_REQ,
AUX_SCAN_RSP and AUX_CONNECT_REQ
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● "Rx" for the packet types ADV_DIRECT_IND, SCAN_REQ and CONNECT_IND
"Public" Allocates a unique 48-bit address to each Bluetooth LE device. Public

addresses use an organizationally unique identifier (OUI) obtained
from the IEEE registration authority.

"Random" Allocates a 48-bit random static device address to each Bluetooth LE
device. A random address is optional. It can be directly generated by
the beacon.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe
on page 175

3.7.3  Main payload configuration dialog

1. Follow the description in Chapter 3.7, "Packet configuration - LE", on page 62.

2. Select "Payload".

The tab provides settings to configure the PDU payload.

Settings:

Device Address............................................................................................................. 68
Data Source.................................................................................................................. 70
Data Length...................................................................................................................71
Unknown Type (hex)..................................................................................................... 71
Peripheral Latency........................................................................................................ 71
LL Connection Timeout................................................................................................. 71
Connection Evt Interval................................................................................................. 71
Connection Instant........................................................................................................ 72
Show / Hide Data Channel (Mapping) Table................................................................. 72
Hop Length....................................................................................................................72
Random Vector (hex).................................................................................................... 72
Encrypted DIVersifier (hex)........................................................................................... 73
Session Key iD (hex).....................................................................................................73
Initialization Vector (hex)............................................................................................... 73
Feature Set Length....................................................................................................... 73
Transmit Window Size...................................................................................................73
Transmit Window Offset................................................................................................ 74
Sleep Clock Accuracy................................................................................................... 74
Error Code.....................................................................................................................74
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Version Number(hex).................................................................................................... 75
SubVersion Number(hex)..............................................................................................75
Company Id(hex)...........................................................................................................75
Advertising Mode.......................................................................................................... 75
Target's Device Address................................................................................................75
Extended Header.......................................................................................................... 75

└ AdvA............................................................................................................... 76
└ TargetA............................................................................................................76
└ CTE Info..........................................................................................................76
└ AdvData Info................................................................................................... 76
└ AuxPtr............................................................................................................. 77
└ SyncInfo..........................................................................................................77
└ TxPow.............................................................................................................77
└ ACAD Length..................................................................................................77
└ ACAD..............................................................................................................77
└ AList / Pattern................................................................................................. 78

Min. / Max. Interval........................................................................................................78
Preferred Periodicity......................................................................................................78
Ref. Connection Event Count........................................................................................78
Offset Setting Table.......................................................................................................79
Max Rx Octets / Max Tx Octets.................................................................................... 79
Max Rx Time / Max Tx Time..........................................................................................79
Rx PHY / Tx PHY.......................................................................................................... 79
M_TO_S_PHY/S_TO_M_PHY......................................................................................80
Reject Opcode.............................................................................................................. 80
PHYs............................................................................................................................. 80
Min Used Channels.......................................................................................................81
ID(hex).......................................................................................................................... 81
SyncInfo Configuration..................................................................................................81
Connection Event Count............................................................................................... 81
Last Pa Event Counter.................................................................................................. 81
SID(hex)........................................................................................................................ 82
Address Type................................................................................................................ 82
PHY...............................................................................................................................82
Sync Connection Event Counter................................................................................... 83
MinCTELenReq.............................................................................................................83
CTETypeReq.................................................................................................................83
Graph............................................................................................................................ 83

Device Address
Sets the Bluetooth device address. A device address for the LE physical channel is
defined in volume 6, part B, section 1.3 of the core specification for Bluetooth wireless
technology.
Devices are identified using a device address. Devices use a public device address or
a random device address, refer to "Devices Tx/Rx Address Type" on page 66.
With Bluetooth wireless technology up to the version 4.2, the following address formats
are defined:
● "Public Address Type" is the unique 48-bits identity address of each Bluetooth LE

device.
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The public address is given from the registration authority IEEE and is composed
of:
– LSB: 24 bits = company_assigned
– MSB: 24 bits = company_id

● "Random Address Type" is an optional 48-bits random static device address.
● "Private Address Type" is a resolvable 48-bits optional address.

A private address is composed of:
– LSB: 24 bits = hash
– MSB: 24 bits = random

Since version 5.0, the device address format is in accordance with BD_ADDR for
BR/EDR with the exception that LAP values does not apply. Unless the public device
address is also used for a BR/EDR controller.
● NAP: Selects non-significant address part. The length of NAP is 16 bits or 4 hexa-

decimal figures.
● UAP: Selects upper address part. The length of UAP is 8 bits or two hexadecimal

figures.
● LAP: Selects lower address part. The length of LAP is 24 bits or 6 hexadecimal fig-

ures.
The NAP+UAP can take any values except the 64 reserved LAP values: #H9E8B00 –
#H9E8B3F.
Option R&S SMM-K117 is required for the address formats since Bluetooth version
5.0.
For advertising channel PDU types, refer to "Payload" on page 24.
Remote command: 
Company_Assigned and Company_Id in advertisers device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID
on page 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
on page 158
Company_Assigned and Company_Id in scanner's device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
on page 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID
on page 158
Company_Assigned and Company_Id in initiator's device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
on page 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID
on page 158
NAP+UAP and LAP in advertiser's device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap
on page 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP
on page 159
NAP+UAP and LAP in initiators device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap
on page 160

Packet configuration - LE



Bluetooth configuration and settingsR&S®SMM-K60/-K117

70User Manual 1179.2054.02 ─ 06

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP
on page 159
NAP+UAP and LAP in scanners device address
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap
on page 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP
on page 159
NAP+UAP and LAP in scanner’s or initiator’s target device address (TargetA) to which
the advertisement is directed.
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap
on page 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP
on page 159

Data Source
Selects the data source used for the payload.
Note: This parameter is relevant for event configuration and packet types DATA,
ADV_IND, ADV_NONCONN_IND and ADV_SCAN_IND.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "Modulation Data" in the R&S SMM100A user manual.
● Section "File and Data Management" in the R&S SMM100A user manual.
● Section "Data List Editor" in the R&S SMM100A user manual
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA
on page 163
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DPATtern on page 164
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DSELection on page 164
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Data Length
Enters the payload data length in bytes.
Note: This parameter is relevant for event configuration with packet types ADV_IND,
ADV_NONCONN_IND and ADV_SCAN_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth
on page 165

Unknown Type (hex)
Enables that an invalid control packet is indicated.
The "CtrType" field indicates the value of the LL control packet that caused the trans-
mission of this packet.
This parameter is relevant for data event configuration with the packet type
LL_UNKNOWN_RSP (Peripheral).
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe
on page 179

Peripheral Latency
Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.
Note: This parameter is relevant for data event and advertising frame configuration
with the packet types LL_CONNECTION_UPDATE_IND and CONNECT_IND.
Within R&S SMM-K117 also for AUX_CONNECT_REQ.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
on page 177
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
on page 173

LL Connection Timeout
Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost.
Note: This parameter is relevant for data event and advertising frame configuration
with the packet types LL_CONNECTION_UPDATE_IND and CONNECT_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
on page 169
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
on page 173

Connection Evt Interval
Sets new connection event interval between the start points of two consecutive con-
nection events. Subsequent transmissions within an event are separated by this
parameter to separate connecting event starting points in time.
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Note: This parameter is relevant for data event connection settings and advertising
frame configuration with the packet types LL_CONNECTION_UPDATE_IND and CON-
NECT_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
on page 172

Connection Instant
Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.
Both the Central and the Peripheral have a 32-bit connection event counter per LL con-
nection. It is reset to zero on the first connection event of the LL connection and incre-
mented by one on every elapsed connection event interval of the LL connection.
Note: This parameter is relevant for data event configuration with the packet types
LL_CONNECTION_UPDATE_IND and LL_CHANNEL_MAP_IND.
Within the option R&S SMM-K117, the following data packet types are also relevant for
the setting: LL_PHY_UPDATE_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
on page 163

Show / Hide Data Channel (Mapping) Table
In data event and advertising frame configuration with the packet types LL_CHAN-
NEL_MAP_IND and CONNECT_IND, calls / hides the channel map table that displays
the used channels and their parameters.
The channel table is described in Chapter 3.6.3, "Channel table settings", on page 61.
Remote command: 
n.a.

Hop Length
Sets the difference from the current channel to the next channel.
The Central and the Peripherals determine the data channel in use for every connec-
tion event from the channel map. Hop_length is set for the LL connection and commu-
nicated in the CONNECT_IND packets.
Note: This parameter is relevant for data event and advertising frame configuration
with the packet type CONNECT_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
on page 169

Random Vector (hex)
Sets the random vector of the Central for device identification.
The parameter is an initialization vector provided by the host in the
HCI_ULP_Start_Encryption command.
Note: This parameter is relevant for data event configuration with the packet type
LL_ENC_REQ.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
on page 176

Encrypted DIVersifier (hex)
Sets the encrypted diversifier of the Central for device identification. The parameter is
an initialization vector provided by the host in the HCI_ULP_Start_Encryption com-
mand.
Note: This parameter is relevant for data event configuration with the packet type
LL_ENC_REQ.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
EDIVersifier on page 166

Session Key iD (hex)
Sets the portion of the Central or the portion of the Peripheral of the session key diver-
sifier (SKDm/SKDs).
Note: This parameter is relevant for data event configuration with the packet types
LL_ENC_REQ (Central) and LL_ENC_RSP (Peripheral).
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD
on page 170

Initialization Vector (hex)
Sets the portion of the Central or the portion of the Peripheral of the initialization vec-
tor(IVm/IVs).
Note: This parameter is relevant for data event configuration with the packet types
LL_ENC_REQ (Central) and LL_ENC_RSP (Peripheral).
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
on page 170

Feature Set Length
Specifies the length of feature set for Central (LL_FEATURE_REQ) or Peripheral.
For feature set setting within the option R&S SMM-K117, refer to "FeatureSet Configu-
ration" on page 87.
Note: This parameter is signaled via LL_FEATURE_REQ (Central) and LL_FEA-
TURE_RSP (Peripheral).
Within the option R&S SMM-K117, it is signaled also via LL_PERIPHERAL_FEA-
TURE_REQ.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
on page 169

Transmit Window Size
Sets the size of the transmit window, regarding to the start point.
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Note that the scan window size is less or equal to the value of the connection interval,
see "Connection Evt Interval" on page 71.
Note: This parameter is relevant for advertising frame configuration for the packet type
CONNECT_IND and for data packet type LL_CONNECTION_UPDATE_IND.
Within the option R&S SMM-K117, the following data packet types are also relevant for
the setting: AUX_CONNECT_REQ, AUX_CONNECT_RSP.
This parameter is also indicated in the "Frame Configuration Dialog".
Remote command: 
For advertising channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe
on page 180
For data channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize
on page 174

Transmit Window Offset
Sets the start point of the transmit window.
Note: This parameter is relevant for advertising frame configuration and for the packet
types CONNECT_IND and LL_CONNECTION_UPDATE_IND.
This parameter is also indicated in the "Frame Configuration Dialog".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
on page 180
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
on page 173

Sleep Clock Accuracy
Defines the clock accuracy of the Central with specified encoding. This parameter is
used by the Peripheral to determine required listening windows in the LL connection. It
is a controller design parameter known by the controller.
Note: This parameter is relevant for advertising frame configuration and the packet
types CONNECT_IND and LL_PERIODIC_SYNC_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
on page 177

Error Code
Sets the error code value to inform the remote device why the connection is about to
be terminated for a LL_TERMINATE_IND packet.
For LL_REJECT_IND packet, this parameter is used when a request was rejected. An
8-bit value is set.
Note: This parameter is relevant for data frame configuration and the packet type
LL_TERMINATE_IND and LL_REJECT_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe
on page 165
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Version Number(hex)
Sets the version of the Bluetooth controller specification (8 bits).
Note: This parameter is relevant for data frame configuration and the packet type
LL_VERSION_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
on page 179

SubVersion Number(hex)
Sets a unique 16-bit value for each implementation or revision of an implementation of
the Bluetooth controller.
Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber
on page 178

Company Id(hex)
Sets the 16-bit company identifier of the manufacturer of the Bluetooth controller.
Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID
on page 162

Advertising Mode
Requires option R&S SMM-K117.
Indicates the mode of the advertisement. All modes defined in specification are suppor-
ted.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe
on page 160

Target's Device Address
TargetA parameter, refer to "Device Address" on page 68.

Extended Header
Requires option R&S SMM-K117.
Enables the extended header for advertising packets with scanning PDUs.
If enabled, the following parameters are displayed in the table below. These parame-
ters are signaled via ADV_EXT_IND, AUX_ADV_IND, AUX_SCAN_RSP,
AUX_SYNC_IND, AUX_CHAIN_IND, AUX_CONNECT_RSP.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:
STATe on page 166

AdvA ← Extended Header
If enabled, the R&S SMM100A includes the signaling of non-significant advertising
address part (NAP), upper address part (UAP) and lower address part (LAP). The set-
tings of NAP, UAP and LAP are covered in the section "Device Address" on page 68.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe on page 166

TargetA ← Extended Header
Enables the signaling of non-significant address part (NAP), upper address part (UAP)
and lower address part (LAP). The settings of NAP, UAP and LAP are covered in the
section "Device Address" on page 68.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe on page 168

CTE Info ← Extended Header
Activates the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.
Note: This parameter is relevant for data event configuration and all data channel
packet types except TEST PACKET.
"Config" accesses the CTEInfo configuration dialog to define the CTE length and the
CTE method for direction finding. See "CTEInfo Configuration" on page 65.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
CINFo:STATe on page 167

AdvData Info ← Extended Header
Enables the signaling of advertising data information consisting of "Advertising Data
ID" and "Advertising Set ID". The setting is covered in the section "AdvDataInfo Config-
uration" on page 84.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
ADINfo:STATe on page 167
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AuxPtr ← Extended Header
Enables the secondary advertising channel. The setting is covered in the section
"AuxPtr Configuration" on page 84.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
APTR:STATe on page 167

SyncInfo ← Extended Header
Enables the signaling of SyncInfo. The presence of theSyncInfo field indicates the
presence of a periodic advertisement. The setting is covered in the section "SyncInfo
Configuration" on page 85.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
SINFo:STATe on page 167

TxPow ← Extended Header
Enables and sets the signaling of required transmit power.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TPOWer:STATe on page 168
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer
on page 178

ACAD Length ← Extended Header
Specifies the length of additional controller advertising data (ACAD) field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth
on page 159

ACAD ← Extended Header
Specifies the pattern used for additional controller advertising data (ACAD).
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
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See also:
● Section "Modulation Data" in the R&S SMM100A user manual.
● Section "File and Data Management" in the R&S SMM100A user manual.
● Section "Data List Editor" in the R&S SMM100A user manual
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD
on page 156

AList / Pattern ← Extended Header
Specifies the path of internal data list for ACAD = "Data List" or
Sets the user-defined ACAD pattern for ACAD = "Pattern".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
APATtern on page 157
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
ASELection on page 157

Min. / Max. Interval
Specifies the minimum / maximum allowed connection interval.
Note: These parameters are signaled via LL_CONNECTION_PARAM_REQ and
LL_CONNECTION_PARAM_RSP.
Option R&S SMM-K117 is required.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
on page 139
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
on page 140

Preferred Periodicity
Requires option R&S SMM-K117.
Specifies the preferred periodicity. This value is typically a multiple of the value of the
connection interval.
Note: This parameter is signaled via LL_CONNECTION_PARAM_REQ and LL_CON-
NECTION_PARAM_RSP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
PPERiodicity on page 141

Ref. Connection Event Count
Requires option R&S SMM-K117.
Specifies connection event counter relative to the calculation of all valid offset fields
Offset0 to Offset5.
Note: This parameter is signaled via LL_CONNECTION_PARAM_REQ and LL_CON-
NECTION_PARAM_RSP.
See also Offset Setting Table.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
on page 142

Offset Setting Table
Requires option R&S SMM-K117.
Specifies the possible positions of the anchor points of the LE connection with the
updated connection parameters relative to the Ref. Connection Event Count.
Note: These parameters are signaled via LL_CONNECTION_PARAM_REQ and
LL_CONNECTION_PARAM_RSP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
OFFSet<ch0>:STATe on page 140
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
OFFSet<ch0>:VALue on page 140

Max Rx Octets / Max Tx Octets
Requires option R&S SMM-K117.
Specifies the maximum allowed payload length of a packet to be received (Rx) or
transmitted (Tx).
Note: These parameters are signaled via LL_LENGTH_REQ and LL_LENGTH_RSP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets
on page 170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
on page 170

Max Rx Time / Max Tx Time
Requires option R&S SMM-K117.
Specifies the maximum allowed time to receive (Rx) or transmit (Tx) a packet.
Note: These parameters are signaled via LL_LENGTH_REQ and LL_LENGTH_RSP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime
on page 171
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime
on page 171

Rx PHY / Tx PHY
Requires option R&S SMM-K117.
Specifies preferred physical layers in receive (Rx) and transmit (Tx) direction. For per-
mitted PHYs, refer to Table 2-22.
Note: These parameters are signaled via LL_PHY_REQ and LL_PHY_RSP.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:
STATe on page 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:
STATe on page 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:
LCOD:STATe on page 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:
STATe on page 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:
STATe on page 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:
LCOD:STATe on page 176

M_TO_S_PHY/S_TO_M_PHY
Requires option R&S SMM-K117.
Specifies the physical layers to be used in Central-to-Peripheral (C_TO_P) and Periph-
eral-to-Central (P_TO_C) direction. For permitted PHYs, refer to Table 2-22.
For Bluetooth core specifications version 5.2 and lower, the notations
"M_TO_S_PHY"/"S_TO_M_PHY" are used.
Note: This parameter is signaled via LL_PHY_UPDATE_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L1M:STATe on page 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L2M:STATe on page 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
LCOD:STATe on page 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L1M:STATe on page 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L2M:STATe on page 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
LCOD:STATe on page 172

Reject Opcode
Requires option R&S SMM-K117.
Specifies the Opcode of rejected LL control PDU. For Opcode, refer to Table 2-20.
Note: This parameter is signaled via LL_REJECT_EXT_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
on page 175

PHYs
Requires option R&S SMM-K117.
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Specifies the physical layers for which the Peripheral has a Min Used Channels
requirement.
Note: These parameters are signaled via LL_MIN_USED_CHANNELS_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:
STATe on page 174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:
STATe on page 174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:
STATe on page 174

Min Used Channels
Requires option R&S SMM-K117.
Specifies the minimum number of channels to be used on the specified PHYs.
Note: This parameter is signaled via LL_MIN_USED_CHANNELS_IND.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
on page 171

ID(hex)
Specifies the ID of the identifier specified by the Host in the CtrData field. The value is
set in hexadecimal representation.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID
on page 181

SyncInfo Configuration
Accesses the "SyncInfo Configuration" dialog. See "SyncInfo Configuration"
on page 85.

Connection Event Count
Specifies the connEventCount field in the CtrData field.
The count value is specified within the following range:
currEvent - 2^14 < connEventCount < currEvent+ 2^14
CurrEvent is the counter value for the connection event during (re-) transmission of the
LL_PERIODIC_SYNC_IND PDU.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
on page 181

Last Pa Event Counter
Requires option R&S SMM-K117.
Specifies the lastPaEventCounter field in the CtrData field.
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The lastPaEventCounter value is typically set to the PaEventCounter value in the
AUX_SYNC_IND PDU.
Specified are the following values for lastPaEventCounter and EventCounter:
● Equal values
● Values with a difference of 1 (modulo 65536)
● Values representing LL_PERIODIC_SYNC_IND and AUX_SYNC_IND timing of

less than 5 seconds
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter
on page 181

SID(hex)
Requires option R&S SMM-K117.
Specifies the SID field in the CtrData field. The value is set in hexadecimal representa-
tion.
The SID is typically set to the Advertising SID subfield of the advertising set pointing to
periodic advertising.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID
on page 183

Address Type
Requires option R&S SMM-K117.
Specifies the address type in the CtrData field.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe
on page 180

PHY
Requires option R&S SMM-K117.
Specifies the PHY field in the CtrData field. The value is set in hexadecimal represen-
tation.
The PHY information is used to indicate the PHY type used by periodic advertising.
The selection is exclusive, i.e. enabling one PHY disables the other enabled PHY.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:
STATe on page 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:
STATe on page 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:
STATe on page 182
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Sync Connection Event Counter
Requires option R&S SMM-K117.
Sets the event counter for the sync connection.
Note: This parameter is signaled via LL_PERIODIC_SYNC_IND control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter
on page 183

MinCTELenReq
Requires option R&S SMM-K117.
Specifies the minimum CTE length in the CtrData field.
Note: This parameter is signaled via LL_CTE_REQ control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 181

CTETypeReq
Requires option R&S SMM-K117.
Specifies the minimum CTE length in the CtrData field.
Note: This parameter is signaled via LL_CTE_REQ control data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq
on page 153
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 181

Graph
The figure in the packet configuration dialog shows the packet structure of the currently
selected packet type.

3.7.4  Additional payload configuration dialogs

Option R&S SMM-K117.

The following additional dialogs can be accessed from the payload tab of the packet
configuration dialog.

AdvDataInfo Configuration............................................................................................ 84
AuxPtr Configuration..................................................................................................... 84

└ Channel Table.................................................................................................84
└ Clock Accuracy............................................................................................... 85
└ Offset Units..................................................................................................... 85
└ Aux Offset....................................................................................................... 85
└ AUX PHY........................................................................................................ 85

SyncInfo Configuration..................................................................................................85
└ Sync Packet Offset......................................................................................... 86
└ Offset Units..................................................................................................... 86
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└ Offset Adjust................................................................................................... 86
└ Periodic Adv Interval.......................................................................................86
└ Secondary Advertising Channel Map Table....................................................86
└ Sleep Clock Accuracy.....................................................................................86
└ Access Address.............................................................................................. 86
└ CRC Initial Value.............................................................................................86
└ Event Counter.................................................................................................86

FeatureSet Configuration.............................................................................................. 87

AdvDataInfo Configuration
Specifies advertising data information consisting of "Advertising Data ID" and "Adver-
tising Set ID". The structure of data is displayed also graphically.
These parameters are signaled within an extended header, refer to"Extended Header"
on page 75.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID
on page 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID
on page 162

AuxPtr Configuration
The presence of the AuxPtr field indicates that some or all advertisement data is in a
subsequent auxiliary packet. The contents of the AuxPtr field describe this packet. The
structure of data is displayed also graphically.
These parameters are signaled within an extended header, refer to"Extended Header"
on page 75.

Channel Table ← AuxPtr Configuration
Selects the channel to be used as secondary advertising channel (auxiliary packet).
Every channel is represented with a bit positioned as per the data channel index. The
settings are identical with data channel table described in Chapter 3.6.3, "Channel
table settings", on page 61.

Packet configuration - LE
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Clock Accuracy ← AuxPtr Configuration
Specifies the clock accuracy of the advertiser used between the packet containing this
data and the auxiliary packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
on page 162

Offset Units ← AuxPtr Configuration
Indicates the units used by the Aux Offset parameter.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
on page 161

Aux Offset ← AuxPtr Configuration
Specifies the time from the start of the packet containing the AuxPtr field to the approx-
imate start of the auxiliary packet.
The parameter unit of time is specified by the Offset Units. The offset is determined by
multiplying the value by the unit. Set the value at least to the length of the packet plus
300 μs.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset
on page 161

AUX PHY ← AuxPtr Configuration
Specifies the physical layer used to transmit the auxiliary packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY
on page 161

SyncInfo Configuration
The presence of the SyncInfo field indicates the presence of a periodic advertisement
(using AUX_SYNC_IND PDUs). The contents of the SyncInfo field describe this peri-
odic advertisement. The structure of data is displayed also graphically.
The parameters are configurable via AUX_ADV_IND. They are signaled within an
extended header, refer to"Extended Header" on page 75.

Packet configuration - LE
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Sync Packet Offset ← SyncInfo Configuration
Specifies the time from the start of the AUX_ADV_IND packet containing the SyncInfo
field to the start of the AUX_SYNC_IND packet.
The sync packet offset consists of multiples of the set Offset Units.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
on page 178

Offset Units ← SyncInfo Configuration
Sets the offset units of the Sync Packet Offset parameter.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits
on page 177

Offset Adjust ← SyncInfo Configuration
Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the "Offset Units".
If "Offset Adjust = On", the "Sync Packet Offset" is set to 2.4567 s and "Offset Units =
300 µs".
If "Offset Units > 30 µs", the offset adjust is deactivated.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust
on page 174

Periodic Adv Interval ← SyncInfo Configuration
Refer to "Periodic Advertising Interval" on page 56.

Secondary Advertising Channel Map Table ← SyncInfo Configuration
Selects the channel to be used as secondary advertising channel (auxiliary packet).
Every channel is represented with a bit positioned as per the data channel index. The
settings are identical with data channel table described in Chapter 3.6.3, "Channel
table settings", on page 61.

Sleep Clock Accuracy ← SyncInfo Configuration
Refer to "Sleep Clock Accuracy" on page 74.

Access Address ← SyncInfo Configuration
Refer to "Access Address" on page 63.

CRC Initial Value ← SyncInfo Configuration
Refer to "CRC Initial" on page 65.

Event Counter ← SyncInfo Configuration
Counts the AUX_SYNC_IND packets that the SyncInfo field describes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
on page 165

Packet configuration - LE
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FeatureSet Configuration

Specifies the supported feature set. Information is transmitted via LL_FEATURE_REQ,
LL_FEATURE_RSP, and LL_PERIPHERAL_FEATURE_REQ.
Configurable are the features as listed in Table 3-8.
Table 3-8: Link layer features: Bit number and feature

Bit Link layer feature Bit Link layer feature

0 LE encryption 14 Channel selection algorithm #2

1 Connection parameter request procedure 15 LE power class 1

2 Extended reject indication 16 Minimum Number of Used Channels proce-
dure

3 Peripheral-initiated features exchange 17 Connection CTE request

4 LE ping 18 Connectionless CTE response

5 LE data packet length extension 19 Connectionless CTE transmitter

6 LL privacy 20 Connectionless CTE receiver

7 Extended scanner filter policies 21 Antenna switching during CTE transmis-
sion (AoD)

8 LE 2M PHY 22 Antenna switching during CTE reception
(AoD)

9 Stable modulation index - transmitter 23 Receiving constant tone extensions

10 Stable modulation index - receiver 24 Periodic advertising Sync transfer - sender

11 LE coded PHY 25 Periodic advertising Sync transfer - recipi-
ent

12 LE extended advertising 26 Sleep clock accuracy updates

13 LE periodic advertising 27 Remote public key validation

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
FSBit<ch0>:STATe on page 168

Packet configuration - LE
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3.8  Test packet configuration - LE

Access:

1. Select "Bluetooth" > "General".

2. "Bluetooth Mode" > "Bluetooth Low Energy".

3. Select "Channel" > "Packet Type" > "TEST PACKET".

4. Select "Test Packet Configuration"

The dialog provides settings to configure test packets. The graphic shows the test
packet structure and fields.

Settings:

Packet Configuration.....................................................................................................88
Packet Interval.............................................................................................................. 88
Symbols per a Bit.......................................................................................................... 89
Header.......................................................................................................................... 89
Payload......................................................................................................................... 89
Payload Type................................................................................................................ 89
Payload Length............................................................................................................. 89

Packet Configuration
In this section, configure general packet settings.

Packet Interval
Sets the time interval between two consecutive test packets, regarding the starting
points.
Test packet interval
Note: This parameter is relevant for test packet types only.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval
on page 184

Test packet configuration - LE
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Symbols per a Bit
Requires option R&S SMM-K117 and "Packet Format" > "LE Coded".
Specifies a coding for LE coded packets. The specification for Bluetooth wireless tech-
nology defines two values S for forward error correction: S = 2 symbols/bit and S = 8
symbols/bit.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit
on page 184

Header
In this section, configure CTE header settings of the test packet. See "CTEInfo Pres-
ent" on page 65 and "CTEInfo Configuration" on page 65.

Payload
In this section, configure payload type and payload length.

Payload Type
Selects the data source used for the payload test packets.
Note: This parameter is relevant for test packet types only.
"PRBS 9, 15" Pseudo-random bit sequences of the length 9 or 15 - transmission of

identical packet series.
"Predefined pattern"

11110000, 10101010, 11111111, 00000000, 00001111, or 01010101
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource
on page 185

Payload Length
Sets the test packet payload length.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength
on page 184

Test packet configuration - LE
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4  Signal control and signal characteristics
This section lists settings provided for configuring the baseband filter and configuring
power ramping of bluetooth bursts. Also settings are listed for defining the signal gen-
eration start and for generating signals necessary for synchronization with other instru-
ments.

It covers the following topics:

● Filter/clipping settings..............................................................................................90
● Power ramping settings...........................................................................................96
● Trigger settings....................................................................................................... 97
● Marker settings......................................................................................................102
● Clock settings........................................................................................................104
● Local and global connectors settings....................................................................105

4.1  Filter/clipping settings

Access:

► Select "Baseband > Bluetooth > General > Filter/Clipping".

The dialog comprises the settings, necessary to configure the baseband filter, the
modulation settings and to enable clipping.

Settings:

4.1.1 Filter settings.................................................................................................................91

4.1.2 Modulation settings....................................................................................................... 93

4.1.3 Clipping settings............................................................................................................94

Filter/clipping settings
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4.1.1  Filter settings

Access:

► Select "Baseband > Bluetooth > General > Filter/Clipping > Filter".

The dialog provides settings to configure the baseband filter.

Settings:

GFSK section................................................................................................................ 91
└ Filter................................................................................................................91
└ Roll Off Factor / BxT....................................................................................... 91
└ Impulse Length............................................................................................... 92
└ Oversampling..................................................................................................92

π/4 DQPSK / 8DPSK section........................................................................................92
└ Filter................................................................................................................92
└ Roll Off Factor / BxT....................................................................................... 92
└ Cut Off Frequency Factor............................................................................... 93

GFSK section
Provides filter settings for the GFSK section.

Filter ← GFSK section
Displays the filter used for GFSK section.
For the π/4 DQPSK section or 8 DPSK section you can set filters, see "Filter"
on page 92.
Remote command: 
n.a.

Roll Off Factor / BxT ← GFSK section
Sets the filter parameter.

Filter/clipping settings
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The filter parameter ("Roll off Factor" or "BxT") depends on the currently selected filter
type. This parameter is preset to the default for each of the predefined filters.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 on page 189
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine on page 189
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss on page 189
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine on page 191
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase on page 191

Impulse Length ← GFSK section
Displays the number of filter tabs.
If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.
Disable it to set the values manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATe] on page 187
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth on page 187

Oversampling ← GFSK section
Sets the upsampling factor.
If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.
Disable it to change the value manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling:AUTO[:STATe] on page 188
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling on page 188

π/4 DQPSK / 8DPSK section
Provides filter settings for the π/4 DQPSK / 8DPSK section.

Filter ← π/4 DQPSK / 8DPSK section
Selects the filter used for DQPSK/8DPSK sections with EDR packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:TYPE on page 187

Roll Off Factor / BxT ← π/4 DQPSK / 8DPSK section
Sets the filter parameter.
The filter parameter ("Roll off Factor" or "BxT") depends on the currently selected filter
type. This parameter is preset to the default for each of the predefined filters.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 on page 189
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine on page 189
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss on page 189

Filter/clipping settings
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[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss on page 190
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine on page 191
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase on page 191

Cut Off Frequency Factor ← π/4 DQPSK / 8DPSK section
Requires a lowpass filter.
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 190

4.1.2  Modulation settings

Access:

► Select "Baseband > Bluetooth > General > Filter/Clipping > Modulation Settings".

The tab provides settings to configure modulation settings.

Settings:

Modulation Type............................................................................................................93
Frequency Deviation..................................................................................................... 93
Modulation Index...........................................................................................................94
Symbol Rate Variation...................................................................................................94

Modulation Type
Displays the modulation type used for the current packet selection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:MTYPe on page 188

Frequency Deviation
Enter the frequency deviation of the frequency modulated part.

Filter/clipping settings
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The frequency deviation can be varied in a range from 100.0 kHz to 200.0 kHz accord-
ing to Bluetooth specification.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation on page 189

Modulation Index
Displays the modulation index resulting from the entered frequency deviation value.
Modulation index is calculated from the given frequency deviation and symbol rate val-
ues.
The modulation index h is defined as:

Where  is the "symbol rate" and  is the "frequency deviation".
According to the Bluetooth specification, the modulation index is allowed to vary
between 0.28 and 0.35.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:MINDex on page 188

Symbol Rate Variation
Enter the symbol rate.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation on page 191

4.1.3  Clipping settings

Access:

► Select "Baseband > Bluetooth > General > Filter/Clipping > Clipping".

The dialog provides settings to configure clipping.

Filter/clipping settings
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Settings:

Clipping State................................................................................................................95
Clipping Level................................................................................................................95
Clipping Mode............................................................................................................... 95

Clipping State
Switches baseband clipping on and off.
Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe on page 186

Clipping Level
Sets the limit for clipping.
This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:LEVel on page 186

Clipping Mode
Selects the clipping method. The dialog displays a graphical illustration on how this two
methods work.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:MODE on page 186

Filter/clipping settings
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4.2  Power ramping settings

Access:

► Select "Bluetooth > General > Power Ramping".

The dialog provides settings to configure power ramping.

Settings:

Ramp Function..............................................................................................................96
Ramp Time....................................................................................................................96
Rise Offset.....................................................................................................................96
Fall Offset......................................................................................................................97

Ramp Function
Selects the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.
"Linear" The transmitted power rises and falls with linear fashion.
"Cosine" The transmitted power rises and falls with a cosine-shaped edge.

This setting causes a more favorable spectrum than the "Linear" set-
ting.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction on page 192

Ramp Time
Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.
Do not switch the transmitted power abruptly at the end or the start of a burst, since the
switching operation generates excessively strong non-harmonics. The switching opera-
tion is therefore stretched over several symbol clocks.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe on page 193

Rise Offset
Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.

Power ramping settings
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Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.
Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset on page 193

Fall Offset
Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.
Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.
Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset on page 192

4.3  Trigger settings

Access:

► Select "Baseband" > "Bluetooth" > "Trigger In".

This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chapter 4.6,
"Local and global connectors settings", on page 105.
You can map trigger signals to one or more User x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

Trigger settings



Signal control and signal characteristicsR&S®SMM-K60/-K117

98User Manual 1179.2054.02 ─ 06

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:

Mode............................................................................................................................. 98
Signal Duration Unit...................................................................................................... 99
Signal Duration..............................................................................................................99
Running/Stopped.......................................................................................................... 99
Time Based Trigger.......................................................................................................99
Trigger Time.................................................................................................................. 99
Arm..............................................................................................................................100
Execute Trigger...........................................................................................................100
Source.........................................................................................................................100
Sync. Output to Ext. Trigger/Sync. Output to Trigger..................................................100
External Inhibit/Trigger Inhibit......................................................................................101
External Delay/Trigger Delay...................................................................................... 101

Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence on page 195

Trigger settings
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Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit on page 197

Signal Duration
Requires trigger "Mode" > "Single".
Enters the length of the trigger signal sequence.
Use this parameter, for example, for the following applications:
● To output the trigger signal partly.
● To output a predefined sequence of the trigger signal.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth on page 197

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe on page 196

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".
Activates time-based triggering with a fixed time reference.
The R&S SMM100A triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As trigger source, you
can use an internal trigger or an external global trigger.
How to: Chapter "Time-based triggering" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe] on page 197

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".
Sets date and time for a time-based trigger signal.
Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMM100A. If you set an earlier trigger time than the current
time, time-based triggering is not possible.
How to: Chapter "Time-based triggering" in the R&S SMM100A user manual.

"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE on page 196

Trigger settings
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"Time" Sets the time of the time-based trigger in format hh:mm:ss.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME on page 196

Arm
Stops the signal generation until subsequent trigger event occurs.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute on page 198

Execute Trigger
For internal trigger source, executes trigger manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute on page 198

Source
The following sources of the trigger signal are available:
● "Internal"

The trigger event is executed manually by the "Execute Trigger".
● "External Global Trigger"

The trigger event is the active edge of an external trigger signal provided and con-
figured at the User x connectors.

● "Baseband Sync In"
In primary-secondary instrument mode, secondary instruments are triggered by the
active edge of the synchronization signal.

How to: "Routing and activating a trigger signal" on page 97
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce on page 195

Sync. Output to Ext. Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.
● "On"

Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

● "Off"

Trigger settings
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The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut
on page 198

External Inhibit/Trigger Inhibit
Applies for external trigger signal.
Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.
For more information, see chapter "Basics" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit on page 199

External Delay/Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces
For more information, see chapter "Basics on ..." in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay on page 198

Trigger settings
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4.4  Marker settings

Access:

► Select "Baseband" > "Bluetooth" > "Marker".

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.

Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 4.6, "Local and
global connectors settings", on page 105.
You can map marker signals to one or more User x or T/M connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A adds the marker signal to the baseband signal. Also,
R&S SMM100A outputs this signal at the configured User x connector.

About marker output signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:

Mode........................................................................................................................... 102
Delay........................................................................................................................... 104

Mode
Marker configuration for up to 3 markers. The settings are used to select the marker
mode defining the shape and periodicity of the markers. The contents of the dialog
change with the selected marker mode.
How to: "Routing and activating a marker signal" on page 102
"Restart" A marker signal is generated at the start of each signal sequence.

Marker settings
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"Event/Frame Start"
A marker signal is generated at the start of each event/frame. The
term event corresponds to a Bluetooth LE event, the term frame cor-
responds to a Bluetooth BR/EDR frame.

"Event/Frame Active Part"/"Event/Frame Inactive Part"
The marker masks the active/inactive part of the event/frame. At the
start of each burst, the marker signal changes to high/low. It changes
back to low/high after the end of each burst.
Shift the marker signal at the start/end of each burst with the parame-
ters "Rising/Falling Edge Shift".
Also, for Bluetooth LE data packets higher than one, configure the
"Packet Index". The index corresponds to the transmitted Tx event
during the connection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift
on page 200
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift
on page 203
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex
on page 202

"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:
DIVider on page 202
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:
FREQuency? on page 202

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
which opens when pattern is selected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern
on page 202

Marker settings
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"On/Off Ratio"
A regular marker signal that is defined by an On/Off ratio is gener-
ated. A period lasts one On and Off cycle.
If "Marker Mode > On/Off Ratio", specify the "On Time" and "Off
Time", which are expressed as number of samples.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime
on page 201
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime
on page 201

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE on page 201

Delay
Delays the marker signal at the marker output relative to the signal generation start.
Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay on page 200

4.5  Clock settings

Access:

► Select "Baseband" > "Bluetooth" > "Clock".

This tab provides settings to select and configure the clock signal, like the clock
source and clock mode.

Defining the clock

1. Select "Clock" > "Source" to define the source of clock signal.

2. For external clock signals, define the connector for signal input. See Chapter 4.6,
"Local and global connectors settings", on page 105.
You can map clock signals to one or more User x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

Clock settings
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3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation with a symbol rate that
equals the clock rate.

About clock signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:

Clock Source...............................................................................................................105

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
How to: "Defining the clock" on page 104
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce on page 204

4.6  Local and global connectors settings

Accesses a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:
● "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block

diagram.
● "Trigger In", "Marker" and "Clock" tabs that are accessible via the "Baseband"

block in the block diagram.

See also chapter "Local and global connectors settings" in the user manual.

Local and global connectors settings
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5  Remote-control commands
The following commands are required to perform signal generation with the Bluetooth
options in a remote environment. We assume that the R&S SMM100A has already
been set up for remote operation in a network as described in the R&S SMM100A doc-
umentation. A knowledge about the remote control operation and the SCPI command
syntax is assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMM100A user manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals

OUTPut<ch> 1 to 3 Available marker signals

Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument preset/reset is rec-
ommended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The following chapters describe the commands specific to the Bluetooth options
R&S SMM-K60/R&S SMM-K117.

● General commands...............................................................................................107
● Dirty transmitter configuration............................................................................... 112
● Channel configuration commands - BR/EDR........................................................119
● Packet configuration commands - BR/EDR.......................................................... 120
● Channel configuration commands - LE.................................................................129
● Event and frame configuration commands - LE....................................................134
● Packet configuration commands - LE................................................................... 144
● Test packet configuration commands - LE............................................................ 183
● Filter/clipping commands...................................................................................... 185
● Power ramping commands................................................................................... 192
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● Trigger commands................................................................................................ 194
● Marker commands................................................................................................ 199
● Clock commands...................................................................................................203

5.1  General commands

Example: To configure time units for timing and delay commands
The default time unit of timing and delay commands is millisecond. You can set time
unit to millisecond or to second.
SOURce1:BB:BTOoth:UNIT:TIME?
// Response: "MS"
// Change time unit to seconds.
SOURce1:BB:BTOoth:UNIT:TIME S

Example: To save and recall settings
MMEM:CDIR "/var/user/"
SOURce1:BB:BTOoth:PRESet
SOURce1:BB:BTOoth:SETTing:STORe "/var/user/Bluetooth_EDR"
SOURce1:BB:BTOoth:SETTing:CATalog?
// Response: Bluetooth_EDR,Bluetooth_SCO,BTO_test
SOURce1:BB:BTOoth:SETTing:DELete "BTO_test"
SOURce1:BB:BTOoth:SETTing:LOAD "BTO_dl"
SOURce1:BB:BTOoth:SETTing:CATalog?
// Response: "Bluetooth_EDR,Bluetooth_SCO"

Example: To configure general Bluetooth BR/EDR settings
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
SOURce1:BB:BTOoth:UNIT:TIME MS
// ******************************************************************
// Set frequency and level.
// Set BR/EDR PHY and transport modes.
// Query the version of the digital standard.
// Generate and save a waveform file in the current directory.
// ******************************************************************
SOURce1:FREQuency:CW 2402000000
SOURce1:POWer:POWer -50
SOURce1:BB:BTOoth:BMODe BAS
SOURce1:BB:BTOoth:TMODe ACL
// SOURce1:BB:BTOoth:TMODe SCO
// SOURce1:BB:BTOoth:TMODe ESCO
SOURce1:BB:BTOoth:VERSion?
// Bluetooth version currently supported by the firmware, e.g. "5.4".
SOURce1:BB:BTOoth:STATe ON
SOURce1:BB:BTOoth:WAVeform:CREate "Bluetooth_EDR"

General commands
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Example: To configure general Bluetooth LE settings
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
SOURce1:BB:BTOoth:UNIT:TIME MS
// ******************************************************************
// Set frequency and level.
// Set LE PHY and query the version of the digital standard.
// Generate and save a waveform file in the current directory.
// ******************************************************************
SOURce1:FREQuency:CW 2402000000
SOURce1:POWer:POWer -10
SOURce1:BB:BTOoth:BMODe BLEN
SOURce1:BB:BTOoth:VERSion?
// Bluetooth version currently supported by the firmware, e.g. "5.4".
SOURce1:BB:BTOoth:STATe ON
SOURce1:BB:BTOoth:WAVeform:CREate "Bluetooth_LE"

[:SOURce<hw>]:BB:BTOoth:BCText?.............................................................................. 108
[:SOURce<hw>]:BB:BTOoth:BMODe............................................................................... 109
[:SOURce<hw>]:BB:BTOoth:PRESet............................................................................... 109
[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog................................................................. 109
[:SOURce<hw>]:BB:BTOoth:SETTing:DELete...................................................................110
[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD.....................................................................110
[:SOURce<hw>]:BB:BTOoth:SETTing:STORe...................................................................110
[:SOURce<hw>]:BB:BTOoth:STATe..................................................................................110
[:SOURce<hw>]:BB:BTOoth:TMODe................................................................................111
[:SOURce<hw>]:BB:BTOoth:UNIT:TIME........................................................................... 111
[:SOURce<hw>]:BB:BTOoth:VERSion?............................................................................ 111
[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate................................................................112

[:SOURce<hw>]:BB:BTOoth:BCText?

Queries the state and controller role.

Return values: 
<BcText> string

Connected
(only data channel type)
Advertiser
(only advertising channel type)
ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND
Within R&S SMM-K117 also ADV_EXT_IND, AUX_ADV_IND,
AUX_SYNC_IND, AUX_CHAIN_IND

General commands
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Scanner
(only advertising channel type)
SCAN_REQ, SCAN_RSP
Within R&S SMM-K117 also AUX_SCAN_REQ,
AUX_SCAN_RSP
Initiator
(only advertising channel type)
CONNECT_IND
Within R&S SMM-K117 also AUX_CONNECT_REQ,
AUX_CONNECT_RSP

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Usage: Query only

Manual operation: See "Bluetooth Controller State" on page 53

[:SOURce<hw>]:BB:BTOoth:BMODe <BMode>

Determines the Bluetooth mode.

Parameters:
<BMode> BASic | BLENergy

BASic
Selects Bluetooth mode BR + EDR.
BLENergy
Selects Bluetooth LE.
*RST: BASic

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Manual operation: See "Bluetooth Mode" on page 34

[:SOURce<hw>]:BB:BTOoth:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:BTOoth:STATe.

Example: See Example"To save and recall settings" on page 107.

Usage: Event

Manual operation: See "Set To Default" on page 33

[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog <Catalog>

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.bto.

General commands
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Parameters:
<Catalog> string

Returns a string of file names separated by commas.

Example: See Example"To save and recall settings" on page 107.

Manual operation: See "Save/Recall" on page 34

[:SOURce<hw>]:BB:BTOoth:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension *.bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted

Example: See Example"To save and recall settings" on page 107.

Manual operation: See "Save/Recall" on page 34

[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted

Example: See Example"To save and recall settings" on page 107.

Manual operation: See "Save/Recall" on page 34

[:SOURce<hw>]:BB:BTOoth:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.bto) is assigned
automatically.

Setting parameters: 
<Filename> string

file name or complete file path

Example: See Example"To save and recall settings" on page 107.

Usage: Setting only

Manual operation: See "Save/Recall" on page 34

[:SOURce<hw>]:BB:BTOoth:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

General commands



Remote-control commandsR&S®SMM-K60/-K117

111User Manual 1179.2054.02 ─ 06

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Manual operation: See "State" on page 33

[:SOURce<hw>]:BB:BTOoth:TMODe <TMode>

Selects the transport mode.

Parameters:
<TMode> ACL | SCO | ESCO

ACL
Asynchronous connection-less mode used for a point-to-point
multipoint link between a Central and all Peripherals.
SCO
Synchronous connection-oriented mode used for a point-to-point
link between a Central and a specific Peripheral.
ESCO
Enhanced synchronous connection-oriented mode used for a
symmetric or asymmetric point-to point link between a Central
and a specific Peripheral.
*RST: ACL

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Manual operation: See "Transport Mode" on page 34

[:SOURce<hw>]:BB:BTOoth:UNIT:TIME <Time>

Sets the time unit for remote control commands.

Parameters:
<Time> S | MS

*RST: MS

Example: See Example"To configure time units for timing and delay com-
mands" on page 107.

[:SOURce<hw>]:BB:BTOoth:VERSion?

Queries the version of the specification for Bluetooth wireless technology underlying
the definitions.

Return values: 
<Version> string

General commands
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Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Usage: Query only

Options: Version 5.x requires R&S SMM-K117.

Manual operation: See "Bluetooth Version" on page 34

[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate <Filename>

Saves the current settings as an ARB signal in a waveform file (*.wv).

Setting parameters: 
<Filename> string

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 107.

Usage: Setting only

Manual operation: See "Generate Waveform" on page 34

5.2  Dirty transmitter configuration

Example: To configure a dirty transmitter
// ******************************************************************
// Set modulation index mode to stable.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:MIMode STAB

// ******************************************************************
// Reset dirty transmitter. Set frequency drift rate, start phase, 
// frequency drift deviation and number of packets 
// per dirty transmitter set (LE only). Enable dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:STDefault
SOURce1:BB:BTOoth:DTTest:FDRate 1.25
SOURce1:BB:BTOoth:DTTest:SPHase 0
SOURce1:BB:BTOoth:DTTest:FDDeviation 50
SOURce1:BB:BTOoth:DTTest:NPPSet NP50

// ******************************************************************
// Enable all long sets for LE or BR dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET1:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET2:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET3:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET4:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET5:STATe 1

Dirty transmitter configuration
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SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET6:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET7:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET8:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET9:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET10:STATe 1

// ******************************************************************
// Enable dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:DTTState 1

[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState..................................................................113
[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation.............................................................. 113
[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate.....................................................................114
[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode.................................................................... 114
[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet.................................................................... 114
[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase....................................................................115
[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault................................................................. 115
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe...................................................................... 115
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset...............................115
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:MINDex................................. 116
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STATe....................................117
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror................................ 117
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset..............................117
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe.................................. 118
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror............................... 118

[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState <DttState>

Activates the "Dirty Transmitter Test".

For EDR packets, the parameter sets apply for 20 packets each.

Parameters:
<DttState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Dirty Transmitter Test" on page 37

[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation <FdDeviation>

Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.

Parameters:
<FdDeviation> integer

Range: -100  to  100
*RST: 25

Dirty transmitter configuration
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Example: See Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Frequency Drift Deviation (+/-)" on page 38

[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate <FdRate>

Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.

Parameters:
<FdRate> 0.3 KHz | 0.5 KHz | 1.6 KHz | 10 KHz

Range: depends on packet type  to  depends on packet
type

Increment: 0.001
*RST: depends on packet type

Example: See Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Frequency Drift Rate" on page 38

[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode <MIMode>

Determines standard or stable mode for the modulation index of dirty transmitter
according to the Bluetooth core specification.

Parameters:
<MIMode> STANdard | STABle

*RST: STANdard

Example: See Example"To configure a dirty transmitter" on page 112.

Options: R&S SMM-K117

Manual operation: See "Modulation Index Mode" on page 38

[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet <NumPack>

Specifies the number of packets per dirty transmitter set.

Bluetooth mode Channel type Number of packets

BR + EDR - 50, 2, 1 packets

LE Advertising, data 50, 2, 1 packets

Parameters:
<NumPack> NP50 | NP2 | NP1

*RST: NP50

Example: See Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Number of Packets per Set" on page 38

Dirty transmitter configuration
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[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase <SPhase>

The command enters a start phase.

The start phase applies to the sine wave that is used to drift the modulated Bluetooth
signal. The drift is around the center frequency plus the carrier frequency offset.

Parameters:
<SPhase> integer

Range: 0  to  359
Increment: 1
*RST: 0
Default unit: degree

Example: SOURce1:BB:BTO:DTT:SPH 0
enters a start phase.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Start Phase" on page 37

[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault

The command calls the default settings for the Dirty Transmitter Test.

Example: SOURce1:BB:BTO:DTT:STD
calls the default settings.

Example: See also Example"To configure a dirty transmitter" on page 112.

Usage: Event

Manual operation: See "Set To Default" on page 37

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe <Table>

Opens the table settings.

Parameters:
<Table> NOTable | SHORt | LONG

Example: SOURce1:BB:BTO:PTYP DH1
calls the default settings.
SOURce1:BB:BTO:DTT:TABL LONG
See also Example"To configure a dirty transmitter" on page 112.

Example: calls the default settings.

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset <CfOffset>

Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.

Dirty transmitter configuration
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Parameters:
<CfOffset> integer

Range: -150  to  150
*RST: 1
Default unit: kHz

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:CFOF 14
sets a carrier frequency offset.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Carrier Frequency Offset kHz" on page 39

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:MINDex <MIndex>

Sets the modulation index, that specifies the frequency deviation.

The modulation index h is defined as:

with

= "symbol rate" , set with the command [:SOURce<hw>]:BB:BTOoth:SRATe:
VARiation

= "frequency deviation", set with the command [:SOURce<hw>]:BB:BTOoth:
MSETtings:FDEViation
According to the Bluetooth standard, the modulation index is allowed to vary between
0.28 and 0.35.

Parameters:
<MIndex> float

Range: 0.28  to  0.55
Increment: 0.01
*RST: 0.28

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
enters the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:MIND 0.3
enters a modulation index.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Modulation Index" on page 39

Dirty transmitter configuration
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[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STATe <State>

Activates the corresponding parameter set for the long table.

For basic rate packets, each set applies to 20 ms of signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:STAT ON
activates the set 2 in the long table.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "State" on page 38

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror <StError>

Sets a symbol timing error in ppm.

This parameter modifies the symbol clock frequency by the set value.

Parameters:
<StError> integer

Range: -150  to  150
*RST: 1
Default unit: ppm

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:STER -20
sets a symbol timing error.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Symbol Timing Error" on page 39

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset <CfOffset>

Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.
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Parameters:
<CfOffset> integer

Range: -150  to  150
*RST: 1
Default unit: kHz

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
sets the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:CFOF 65
sets a carrier frequency offset.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Carrier Frequency Offset kHz" on page 39

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe <State>

Activates the corresponding parameter set in the short table. If a set deactivated, its
parameters are skipped in the sequence. Instead, the next active set is used.

For EDR packets, each set applies to 20 packets.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
sets the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:STAT ON
activates the set 2 in the short table.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "State" on page 38

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror <StError>

Sets a symbol timing error in ppm.

The symbol timing error modifies the symbol clock frequency by the set amount.

Parameters:
<StError> integer

Range: -150  to  150
Increment: 1
*RST: 1
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Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
enters the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:STER 20
enters a symbol timing error.

Example: See also Example"To configure a dirty transmitter" on page 112.

Manual operation: See "Symbol Timing Error" on page 39

5.3  Channel configuration commands - BR/EDR

[:SOURce<hw>]:BB:BTOoth:PTYPe.................................................................................119
[:SOURce<hw>]:BB:BTOoth:SLENgth.............................................................................. 119
[:SOURce<hw>]:BB:BTOoth:STIMing...............................................................................120

[:SOURce<hw>]:BB:BTOoth:PTYPe <PType>

The available packets depend on the selected transport mode. All packet types as
defined in the Bluetooth specifications are supported.

Parameters:
<PType> ID | NULL | POLL | FHS | DM1 | DH1 | DM3 | DH3 | DM5 | DH5 |

AUX1 | ADH1 | ADH3 | ADH5 | AEDH1 | AEDH3 | AEDH5 |
HV1 | HV2 | HV3 | DV | EV3 | EV4 | EV5 | EEV3 | EEV5 |
EEEV3 | EEEV5
*RST: DH1

Example: BB:BTO:PTYP NULL
Sets a null packet.

Manual operation: See "Packet Type" on page 40

[:SOURce<hw>]:BB:BTOoth:SLENgth <SLength>

Sets the sequence length of the Bluetooth signal in number of frames. This signal is
calculated in advance and output in the arbitrary waveform generator.

Parameters:
<SLength> integer

Range: depends on the number of states in dirty transmitter
test  to  dynamic

*RST: 1

Example: BB:BTO:SLEN 10
sets the sequence length to 10 frames.

Manual operation: See "Sequence Length" on page 40
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[:SOURce<hw>]:BB:BTOoth:STIMing <SlotTiming>

Selects the Rx slot timing mode.

Parameters:
<SlotTiming> TX | LOOPback

*RST: TX

Example: BB:BTO:PTYP DH3
sets the packet type.
BB:BTO:STIM LOOP
selects loopback test mode.

Manual operation: See "Slot Timing" on page 41

5.4  Packet configuration commands - BR/EDR

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement.......................................120
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap....................................................... 121
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap.......................................................121
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap.......................................................122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice.................................................... 122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA...........................................................122
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern............................................ 123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection.........................................123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern........................................... 123
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection........................................124
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth...................................................... 124
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket...................................................124
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening..................................................125
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows..........................................125
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl.................................................... 126
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord......................................................126
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress................................................... 126
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl.....................................................127
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth...................................................... 127
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP...........................................................128
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue.................................................... 128
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode.......................................................128
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa......................................................... 129

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement
<Acknowledgement>

Sets the ARQN bit of the packet header..

Parameters:
<Acknowledgement> NAK | ACK
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NAK
Request to retransmit the previous payload.
ACK
Previous payload has been received successfully.
*RST: ACK

Example: BB:BTO:PTYP DH1
selects the packet type DH1.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:ACKN ACK
sets positive acknowledgement

Manual operation: See "Acknowledgment" on page 44

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap <BdaLap>, <BitCount>

Sets the lower address part of Bluetooth Device Address. The length of LAP is 24 bits
or 6 hexadecimal figures.

Parameters:
<BdaLap> numeric

Range: #H000000  to  #HFFFFFF
*RST: 80

<BitCount> integer
Range: 8  to  24
*RST: 24

Example: BB:BTO:PCON:BDAL #H000000,24
Sets the lower address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap <BdaNap>, <BitCount>

Enters the non-significant address part of Bluetooth Device Address. The length of
NAP is 16 bits or 4 hexadecimal figures.

Parameters:
<BdaNap> numeric

Range: #H0000  to  #HFFFF
*RST: ABCD

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: BB:BTO:PCON:BDAN #H0000,16
Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 43
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap <BdaUap>, <BitCount>

Enters the upper address part of Bluetooth Device Address. The length of UAP is 8 bits
or 2 hexadecimal figures.

Parameters:
<BdaUap> numeric

Range: #H00  to  #HFF
Increment: 1
*RST: 48

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: BB:BTO:PCON:BDAN #H00,8
Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice <CoDevice>, <BitCount>

A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.

Parameters:
<CoDevice> numeric

Range: #H000000  to  #HFFFFFF
*RST: #H0

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: BB:BTO:PTYP FHS
Sets the packet type.
BB:BTO:PCON:DSFP PED
Enables the packet editor under data source for the packet.
BB:BTO:PCON:COD #H020104,24
Sets the class of device.

Manual operation: See "Class of Device" on page 47

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA <Data>

Selects the data source used for the payload.

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
*RST: PN09
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Example: BB:BTO:PTYP FHS
sets the packet type
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:DATA ALL1
sets the data type.

Manual operation: See "Data Source" on page 45

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern <DPattern>,
<BitCount>

Selects the data for a pattern.

Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: BB:BTO:PCON:DATA PATT
Sets the data type.
BB:BTO:PCON:DATA:DPAT #B010101,6
Selects the data for a pattern with the length of 6 bits.

Manual operation: See "Data Source" on page 45

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection <DSelection>

The command selects data list file.

Parameters:
<DSelection> string

Increment: 1

Example: BB:BTO:PCON:DATA DLIS
selects the data type.
BB:BTO:PCON:DSEL bluetooth_1
selects the file for the data.

Manual operation: See "Data Source" on page 45

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern <VdPattern>,
<BitCount>

Sets the bit pattern for the voice data.

Parameters:
<VdPattern> numeric

*RST: #H0
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<BitCount> integer
Range: 1  to  64
*RST: 1

Example: BB:BTO:PCON:DATA:PATT
Selects the data type.
BB:BTO:PCON:DATA:VDPA #B010101,6
Selects the bit pattern for the voice data with the length of 24
bits.

Manual operation: See "Data Source (Voice Field)" on page 47

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection <VdSelection>

Selects the data list for voice data.

Parameters:
<VdSelection> string

Example: BB:BTO:PCON:VDAT DLIS
selects the data type.
BB:BTO:PCON:VDSE bluetooth_1
selects the file for the data.

Manual operation: See "Data Source (Voice Field)" on page 47

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth <DLength>

Sets the payload data length in bytes.

Parameters:
<DLength> integer

Range: 0  to  depends on packet type
Increment: 1
*RST: depends on packet type

Example: BB:BTO:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:DLEN 25
sets the data length.

Manual operation: See "Data Length" on page 46

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket <DsfPacket>

Selects the data source for the selected packet type.

Parameters:
<DsfPacket> PEDit | ADATa
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PED
Enables the "Packet Editor". All packet fields can be configured
individually.
ADAT
Fills the generated packets with the selected data source. Useful
if predefined data contents are loaded with a data list file or the
data contents of the packet are not of interest.
*RST: PEDit

Example: BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.

Manual operation: See "Data Source for Packet" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening <DWhitening>

Activates the "Data Whitening".

Parameters:
<DWhitening> 1 | ON | 0 | OFF

*RST: 0

Example: BB:BTO:PCON:DWH ON
activates data whitening.

Manual operation: See "Data Whitening" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows <EirPacketFollow>

Indicates that an extended inquiry response packet can follow.

Parameters:
<EirPacketFollow> YES | NO

YES
Indicates that EIR packet follows.
NO
Indicates that EIR packet does not follow.
*RST: NO

Example: BB:BTO:PCON:PTYP FHS
sets the packet type.
BB:BTO:PCON:DSFP PED
enables the packet editor under data source for the packet
BB:BTO:PCON:EIRP YES
the EIR packet follows.

Manual operation: See "EIR packet follows" on page 46
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl <HfControl>

The command sets the FLOW bit in the header. This bit indicates start or stop of trans-
mission of packets over the ACL logical transport.

Parameters:
<HfControl> GO | STOP

GO
Allows the other devices to transmit new data.
STOP
Stops the other devices from transmitting data temporarily.
*RST: GO

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet.
BB:BTO:PCON:HFC GO
allows the other devices to transmit new data.

Manual operation: See "Flow Control" on page 44

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord <LapForSW>, <BitCount>

Sets the lower address part (LAP) of the sync word for FHS packets. The length of
LAP is 24 bits or 6 hexadecimal figures.

Parameters:
<LapForSW> numeric

Range: #H000000  to  #HFFFFFF
*RST: #H000080

<BitCount> integer
Range: 8  to  24
*RST: 24

Example: BB:BTO:PCON:LFSW #H000080,24

Sets the lower address part.

Manual operation: See "LAP for Sync Word" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress <LtAddress>

The command enters the logical transport address for the header. Each Peripheral
active in a piconet is assigned a primary logical transport address (LT_ADDR). The all-
zero LT_ADDR is reserved for broadcast messages.
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Parameters:
<LtAddress> integer

Range: 0  to  7
Increment: 1
*RST: 0

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:LTAD 0
sets the logical transport address equal zero.

Manual operation: See "Logical Transport Address" on page 44

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl <PfControl>

The command sets the FLOW bit in the payload (flow control per logical link).

Parameters:
<PfControl> GO | STOP

GO
Indicates the start of transmission of ACL packets after a new
connection has been established.
STOP
Indicates the stop of transmission of ACL packets before an
additional amount of payload data is sent.
*RST: GO

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:PFC GO
allows the flow per logical link.

Manual operation: See "Flow Control" on page 46

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth <PLength>

Sets the packet length in symbols.

Parameters:
<PLength> integer

Range: 1  to  depends on packet type
Increment: 1
*RST: depends on packet type
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Example: BB:BTO:PCON:DSFP ADAT
fills the all data under data source for packet.
BB:BTO:PCON:PLEN 1
sets the packet length.

Manual operation: See "Packet Length" on page 49

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP <State>

Activates synchronization of the lower address part (LAP) of the sync word and Blue-
tooth device address.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: BB:BTO:PCON:SLAP 0

deactivates LAP synchronization.
BB:BTO:PCON:LFSW #H000080,24

sets LAP of the sync word separately.

Manual operation: See "Synchronize LAP with BD_ADDR" on page 43

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue <SnSvalue>

Sets the start value of the header SEQN bit. The SEQN bit is present in the header to
filter out retransmissions in the destination. The signal generator is altering this bit
automatically on consecutive frames, if a sequence length of at least 2 frames is set.

Parameters:
<SnSvalue> integer

Range: 0  to  1
*RST: 1

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.
BB:BTO:PCON:SNSV ONE
sets the SEQN bit of the first CRC data packet at the start of a
connection.

Manual operation: See "SEQN Start Value" on page 45

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode <SrMode>

The command indicates the interval between two consecutive page scan windows,
determines the behavior of the paging device.

Parameters:
<SrMode> R0 | R1 | R2
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R0
The scan interval is equal to the scan window T w page scan
(continuous nscan) and maximal 1.28s.
R1
The scan interval is maximal 1.28s.
R2
The scan interval is maximal 2.56s.
*RST: R0

Example: BB:BTO:PCON:PTYP FHS
sets the packet type.
BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.
BB:BTO:PCON:SRM R0
sets the scan repetition mode.

Manual operation: See "Scan Repetition Mode" on page 46

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa <VData>

Selects the data source for the voice field.

Parameters:
<VData> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
*RST: PN09

Example: BB:BTO:PCON:VDAT ALL1
sets the voice data type.

Manual operation: See "Data Source (Voice Field)" on page 47

5.5  Channel configuration commands - LE

Example: To configure general channel settings for LE
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
SOURce1:BB:BTOoth:UNIT:TIME MS

// ******************************************************************
// Select channel type, test packet, packet format, sequence length,
// controller role. Enable CRC corruption for every second packet. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe TPAC
SOURce1:BB:BTOoth:PFORmat L2M
SOURce1:BB:BTOoth:USLength 2
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SOURce1:BB:BTOoth:BCRole CENTral
SOURce1:BB:BTOoth:CCRC:STATe 1

// ******************************************************************
// Alternatively set duty cycle for ADV_DIRECT_IND
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADIN
SOURce1:BB:BTOoth:DCYCle LOW

[:SOURce<hw>]:BB:BTOoth:BCRole................................................................................130
[:SOURce<hw>]:BB:BTOoth:CCRC:STATe....................................................................... 130
[:SOURce<hw>]:BB:BTOoth:CTYPe................................................................................ 131
[:SOURce<hw>]:BB:BTOoth:DCYCle............................................................................... 131
[:SOURce<hw>]:BB:BTOoth:PFORmat............................................................................ 131
[:SOURce<hw>]:BB:BTOoth:UPTYpe...............................................................................132
[:SOURce<hw>]:BB:BTOoth:USLength............................................................................ 133
[:SOURce<hw>]:BB:BTOoth:MFORmat............................................................................133
[:SOURce<hw>]:BB:BTOoth:DURation.............................................................................134

[:SOURce<hw>]:BB:BTOoth:BCRole <BcRole>

Determines the controller role.

Depending on the selected channel type different roles are assigned to the controller.
For channel type "Data", Central or Peripheral can be assigned. If channel type "Adver-
tising" is selected, the parameter is read only and displayed directly above the graph.

Parameters:
<BcRole> CENTral | PERipheral | ADVertiser | SCANner | INITiator

CENTral
Selects Central as controller role.
PERipheral
Selects Peripheral as controller role.
ADVertiser|SCANner|INITiator
Assigned roles depending on the selected packet type of the
respective channel type.
*RST: CENTral

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Bluetooth Controller Role" on page 53

[:SOURce<hw>]:BB:BTOoth:CCRC:STATe <State>

Enables/disables the corruption of CRC for every second generated packet. If enabled,
only 50% of packets are generated with correct CRC.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Channel configuration commands - LE



Remote-control commandsR&S®SMM-K60/-K117

131User Manual 1179.2054.02 ─ 06

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Corrupted CRC Every 2nd Packet" on page 53

[:SOURce<hw>]:BB:BTOoth:CTYPe <CType>

Determines the channel type. Advertising and data are available.

Parameters:
<CType> ADVertising | DATA

ADVertising
Selects channel type advertising.
DATA
Selects channel type data. Devices in a connected state transmit
data channel packets in connection events with a start point and
an interval.
*RST: ADVertising

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Channel Type" on page 51

[:SOURce<hw>]:BB:BTOoth:DCYCle <DCycle>

Specifies duty cycle for directed advertising (packet type ADV_DIRECT_IND).

Parameters:
<DCycle> LOW | HIGH

*RST: HIGH

Example: See Example"To configure general channel settings for LE"
on page 129.

Options: R&S SMM-K117

Manual operation: See "Duty Cycle" on page 52

[:SOURce<hw>]:BB:BTOoth:PFORmat <PFormat>

Specifies the physical layer of LE signal.

Parameters:
<PFormat> L1M | L2M | LCOD

L1M
LE 1M
L2M
LE 2M
LCOD
LE coded
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*RST: L1M

Example: See Example"To configure general channel settings for LE"
on page 129.

Options: R&S SMM-K117 required for L2M, LCOD

Manual operation: See "Packet Format" on page 52

[:SOURce<hw>]:BB:BTOoth:UPTYpe <UpType>

Selects the packet type. The available packets depend on the selected channel type
and installed options.

The tables below provide an overview. For more information, see data sheet.
Table 5-1: R&S SMM-K60 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

AIND

ADINd

ANINd

SREQ

SRSP

CREQ

ADCind

DATA

CUReq

CMReq

TIND

EREQ

ADV_IND

ADV_DIRECT_IND

ADV_NONCONN_IND

SCAN_REQ

SCAN_RSP

CONNECT_IND

ADV_SCAN_IND

DATA

LL_CONNECTION_UPDATE_IND

LL_CHANNEL_MAP_IND

LL_TERMINATE_IND

LL_ENC_REQ

ERSP

SEReq

SERSp

URSP

FREQ

FRSP

TPACket

PEReq

PERSp

VIND

RIND

LL_ENC_RSP

LL_START_ENC_REQ

LL_START_ENC_RSP

LL_UNKNONW_RSP

LL_FEATURE_REQ

LL_FEATURE_RSP

TEST PACKET

LL_PAUSE_ENC_REQ

LL_PAUSE_ENC_RSP

LL_VERSION_IND

LL_REJECT_IND

Table 5-2: R&S SMM-K117 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

PREQ

PRSP

PUIN

LRSP

SFR

CPR

CPRS

REIN

PIR

PIRS

AEINd

AAINd

ACINd

LL_PHY_REQ

LL_PHY_RSP

LL_PHY_UPDATE_IND

LL_LENGTH_RSP

LL_PERIPHERAL_FEATURE_REQ

LL_CONNECTION_PARAM_REQ

LL_CONNECTION_PARAM_RSP

LL_REJECT_EXT_IND

LL_PING_REQ

LL_PING_RSP

ADV_EXT_IND

AUX_ADV_IND

AUX_CHAIN_IND

ASINd

ASReq

ASPSp

ACRSp

ACReq

MUCH

CONT

CTEQ

CTEP

PSIND

CAReq

CARSp

AUX_SYNC_IND

AUX_SCAN_REQ

AUX_SCAN_RSP

AUX_CONNECT_RSP

AUX_CONNECT_REQ

LL_MIN_USED_CHANNELS_IND

CONTINUOUS

LL_CTE_REQ

LL_CTE_RSP

LL_PERIODIC_SYNC

LL_CLOCK_ACCURACY_REQ

LL_CLOCK_ACCURACY_RSP
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Parameters:
<UpType> AIND | ADINd | ANINd | SREQ | SRSP | CREQ | ADCind |

DATA | CUReq | CMReq | TIND | EREQ | ERSP | SEReq |
SERSp | URSP | FREQ | FRSP | TPACket | PEReq | PERSp |
VIND | RIND | PREQ | PRSP | PUIN | LREQ | LRSP | SFR |
CPR | CPRS | REIN | PIR | PIRS | AEINd | AAINd | ACINd |
ASINd | ASReq | ASPSp | ACRSp | ACReq | MUCH | CONT |
CTEQ | CTEP | PSINd | CAReq | CARSp
*RST: AIND

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Packet Type" on page 51

[:SOURce<hw>]:BB:BTOoth:USLength <UsLength>

Selects the number of frames or events depending on the packet type. The signal
repeats after the specified number of frames/events.

For SCAN_REQ and CONNECT_IND packet, the sequence length is expressed in
"Frames".

For AUX_SCAN_REQ and AUX_CONNECT_REQ packet, the sequence length is
expressed in "Frames".

For LL_TERMINATE_IND packets, a default value according to the specification is
given:

Central: PeripheralLatency + 6

Peripheral: 6

For all other packet types the sequence length is expressed in "Events".

Parameters:
<UsLength> integer

Range: depends on the number of states in dirty transmitter
test  to  dynamic

*RST: 1

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Sequence Length" on page 53

[:SOURce<hw>]:BB:BTOoth:MFORmat <ModFmt>

Specifies the physical layer used for CONTINUOUS payload transmission.
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Parameters:
<ModFmt> L1M | L2M | LCOD

L1M: LE 1M
L2M: LE 2M
LCOD: LE coded
*RST: L1M

Example: See Example"To configure general channel settings for LE"
on page 129.

Options: R&S SMM-K117 required for L2M, LCOD

Manual operation: See "Modulation Format" on page 54

[:SOURce<hw>]:BB:BTOoth:DURation <Duration>

Specifies the transmission duration of CONTINUOUS payload transmission.

Command sets the values in ms. Query returns values in s.

Parameters:
<Duration> float

Range: depending on modulation format, symbols per a bit
and payload type

Default unit: ms

Example: See Example"To configure general channel settings for LE"
on page 129.

Manual operation: See "Duration" on page 54

5.6  Event and frame configuration commands - LE

Example: Configure event and frame configuration settings
// ******************************************************************
// For ADV_SCAN_IND, select advertising event interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADC
SOURce1:BB:BTOoth:ECONfiguration:AEINterval 20

// ******************************************************************
// Alternatively set advertising event interval for ADV_DIRECT_IND.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADIN
SOURce1:BB:BTOoth:ECONfiguration:ADINterval 3.75
// ******************************************************************
// Set advertising event delay, activate channel 37.
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// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:AEDelay 0
SOURce1:BB:BTOoth:ECONfiguration:ACTable:CHANnel0:STATe 1
// ******************************************************************
// For packet type SCAN_REQ, set length of the window, 
// time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe SREQ
SOURce1:BB:BTOoth:ECONfiguration:SWINdow 10
SOURce1:BB:BTOoth:ECONfiguration:SINTerval 3500

// ******************************************************************
// For packet type CONNECT_IND set transmit window,
// start point of the transmit window,
// LL connection timeout and time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe CREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe 8.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset 800 
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout 7500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval 6400

// ******************************************************************
// Alternatively select packet type LL_CONNECTION_UPDATE_IND,
// set transmit window, start point of the transmit
// window, LL connection timeout and time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize 8.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset 800
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 7500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval 6400

// ******************************************************************
// Set time interval for advertising channel and events.
// Set time delay for advertising events.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:APINterval 1.3
SOURce1:BB:BTOoth:ECONfiguration:AEINterval 15
SOURce1:BB:BTOoth:ECONfiguration:AEDelay 5

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe..................... 136
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe..................... 136
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:

CHANnel<ch0>:STATe......................................................................................... 136
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay.......................................................137
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval................................................... 137
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval....................................................137
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval....................................................138
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode.......................................................138
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey.......................................................... 139
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval........................... 139
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval............................140
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:STATe............. 140
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:VALue.............140
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval............................ 141
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity.........................141
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount............................ 142
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber.....................................................142
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI?..........................................................142
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval..................................................... 143
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow.....................................................143
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINfo?......................................................143
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo?...................................................... 144

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:
CHANnel<ch0>:STATe <State>

Indicates used and unused data channels.

Note: The previously used syntax ..:SET<ch>:STATe has been replaced
by ...:CHANnel<ch>:STATe. Compatibility to the previous commands is given.

This parameter is relevant for data event and advertising frame configuration with the
packet types LL_CHANNEL_MAP_IND, CONNECT_IND.

Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: AUX_CONNECT_IND, AUX_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:BB:BTO:ECON:ACT:CHAN:STAT ON
State in Advertising Channel Table and Secondary Advertising
Channel Table
SOURce1:BB:BTO:ECON:DCT:CHAN:STAT ON
State in Data Channel Table and Secondary Advertising Chan-
nel Table
SOURce1:BB:BTO:ECON:PCON:DCMT:CHAN:STAT ON
State in Data Channel Map Table

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Channel Table" on page 61
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay <AeDelay>

Sets a time delay between the start times of two consecutive advertising events. The
value is added to the advertising event interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<AeDelay> float

Range: 0 s to 10E-3 s
Increment: 0.1E-3
*RST: 0
Default unit: ms

Example: SOURce1:BB:BTO:ECON:AEDelay 5
Sets a delay of 5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Advertising Event Delay" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval <AdInterval>

Sets the time interval between two consecutive advertising events for packet type
"ADV_DIRECT_IND" and duty cycle high.

Command sets the values in ms. Query returns values in s.

Parameters:
<AdInterval> float

Range: 1.05E-3 s to 3.75E-3 s
Increment: 0.01E-3
*RST: 3.75E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:ADIN 13
Sets a time interval of 13 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Advertising Event Interval" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval <AeInterval>

Sets the time interval between two consecutive advertising events, with regard to the
starting points.

Command sets the values in ms. Query returns values in s.
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Parameters:
<AeInterval> float

Range: 5E-3 s to depends on oversampling
Increment: 0.1E-3
*RST: 20E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:AEIN 15
Sets a time interval of 15 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Advertising Event Interval" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval <ApInterval>

Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.

Parameters:
<ApInterval> float

Range: 1.3E-3  to  28E-3
Increment: 0.1E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:APIN 1.3
Sets a time interval of 1.3 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Advertising Packet Interval" on page 57

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode <LcMode>

Selects the link layer connection mode. In order to provide safe transmission of pay-
load data, the data in the packet can be encrypted. If activated, the payload data fol-
lows MIC (Message authentication Code).

Parameters:
<LcMode> UENC | ENC

UENC
Payload data is transmitted without encoding.
ENC
The link layer connection runs in encrypted mode.
*RST: UENC
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Example: SOURce1:BB:BTO:ECON:LCM UENC
without encoding.
SOURce1:BB:BTO:ECON:LCM ENC
in encrypted mode.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "LL Connection Mode" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey <LtKey>, <BitCount>

Indicates the time the controller needs to receive the long-term key from the host. After
this time, the controller is ready to enter into the last phase of encryption mode setup.

Parameters:
<LtKey> numeric

*RST: #H0

<BitCount> integer
Range: 128  to  128
*RST: 128

Example: SOURce1:BB:BTO:ECON:LCM ENC
SOURce1:BB:BTO:ECON:LTK
#H00000000000000000000000000000000,128
In encrypted mode, the code can be edited.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Long Term key (hex)" on page 60

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
<MNInterval>

Specifies the minimum allowed connection interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<MNInterval> float

Range: 7.5E-3 s to depending on Max. Interval
Increment: 1.25E-3 s
*RST: 7.5E-3

Example: SOURce1:BB:BTO:ECON:PCON:MNIN 7.5
Sets a time interval of 7.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Options: R&S SMM-K117

Manual operation: See "Min. / Max. Interval" on page 78
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
<MInterval>

Specifies the maximum allowed connection interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<MInterval> float

Range: 7.5E-3 s to 4000E-3 s
Increment: 1.25E-3
*RST: 7.5E-3

Example: SOURce1:BB:BTO:ECON:PCON:MXIN 12.5
Sets a time interval of 12.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Options: R&S SMM-K117

Manual operation: See "Min. / Max. Interval" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
STATe <State>

Enables / disables Offset0 to Offset5 of the offset setting table.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 134.

Options: R&S SMM-K117

Manual operation: See "Offset Setting Table" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
VALue <Offset>

Specifies Offset0 to Offset5 of the offset setting table.

Command sets the values in ms. Query returns values in s.

Parameters:
<Offset> float

Range: 0 s to depending on Max. Interval
Increment: 1.25
*RST: 0
Default unit: ms
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Example: SOURce1:BB:BTO:ECON:PCON:OFFSet0:VALue 7
SOURce1:BB:BTO:ECON:PCON:OFFSet0:VALue?
// Response: "7.5"
Sets the Offset0 to 7.5 ms. The setting 7 ms is automatically
changed to the closest multiple of 1.25 ms, which is 7.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Options: R&S SMM-K117

Manual operation: See "Offset Setting Table" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
<Interval>

Sets the time interval between the start of two AUX_SYNC_IND PDUs from the same
advertising set.

Command sets the values in ms. Query returns values in s.

Parameters:
<Interval> float

Range: 7.5E-3 s to depending on oversampling
Increment: 0.01E-3
*RST: 20E-3
Default unit: ms

Example: SOURce1:BB:BTOoth:ECON:PCON:PAINterval 10
Sets a time interval of 10 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Periodic Advertising Interval" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity
<PPeriodicity>

Specifies a value the connection interval is preferred to be a multiple of.

Parameters:
<PPeriodicity> float

Range: 0  to  depends on Max. Interval
Increment: 0.01E-3
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 134.

Options: R&S SMM-K117

Manual operation: See "Preferred Periodicity" on page 78
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
<RCECount>

Specifies the ReferenceConnEventCount field of LL_CONNECTION_PARAM_REQ.

Parameters:
<RCECount> integer

Range: 0  to  65535
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 134.

Options: R&S SMM-K117

Manual operation: See "Ref. Connection Event Count" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber <PNumber>

Sets the number of Tx packets per event.

Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.

Parameters:
<PNumber> integer

Range: 1  to  depends on connection event interval
*RST: 1

Example: SOURce1:BB:BTO:ECON:PNUM 2580
Sets the number of Tx packets per event.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "No. Of Tx Packets/Event" on page 58

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI?

Queries the number of the first active data channel.

Return values: 
<SelectedChannel> integer

Range: 0  to  36
*RST: 0

Example: SOURce1:BB:BTOoth:ECONfiguration:SDCI?
Example: See also Example"Configure event and frame configuration set-

tings" on page 134.

Usage: Query only

Manual operation: See "Selected Data Channel Index" on page 60
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval <SInterval>

Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.

Command sets the values in ms. Query returns values in s.

Parameters:
<SInterval> float

Range: 10E-3 s to depends on oversampling and the num-
ber of advertsing channel table states

Increment: 0.625E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:SINT 3.5
Sets a time interval of 3.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Scan Interval" on page 57

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow <SWindow>

Sets the length of the window during which the scanner is operating in the advertising
channel.

Note that the scan window is less or equal to the value of the scan interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<SWindow> float

Range: 10E-3 s to 10240E-3 s
Increment: 0.625E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:SWIN 10
Sets the length of the window to 10 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Manual operation: See "Scan Window" on page 57

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINfo?

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Queries the start point of the transmit window.
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Return values: 
<WoInfo> string

Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND
SOURce1:BB:BTO:ECON:PCON:WOIN?
Queries the start point of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Usage: Query only

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo?

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Queries the size of the transmit window, regarding to the start point.

Return values: 
<WsInfo> string

Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND
SOURce1:BB:BTO:ECON:PCON:WSIN?
Queries the size of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 134.

Usage: Query only

Manual operation: See "Transmit Window Size" on page 58

5.7  Packet configuration commands - LE

Example: To configure advertising packets
// ******************************************************************
// Configure packet for ADV_SCAN_IND: switch off whitening,
// set Tx device address type, AdvA, data source and length
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADC
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe PUBL
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap #H017412,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP #H9E8B00,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DATA PN09
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth 31
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// ******************************************************************
// Alternatively set periodic advertising interval for AUX_SYNC_IND
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ASIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval 

// ******************************************************************
// Select packet type AUX_ADV_IND. (All parameters of
// extended header are configurable with AUX_ADV_IND packet 
// type.) Set channel selection,
// Tx device address type, advertising mode.  
// Enable extended header for advertising PDUs. Enable all
// flags: AdvA, TargetA, AdvData Info, Aux Ptr, Sync Info,
// TxPow. Set Tx power value and ACAD length and pattern.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe AAIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection CS1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe PUBL
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe NCNS
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:AADDress:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:TADDress:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:ADINfo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:APTR:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:SINFo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:TPOWer:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer -100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth 16
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD PN16

// ******************************************************************
// Alternatively set user-defined pattern.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD PATTern
SOURce1:BB:BTOoth:ECONfiguration:PCON:ACAD:APATtern #B011000011,9
// ******************************************************************
// Alternatively set pattern from data list.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD DLISt
SOURce1:BB:BTOoth:ECON:PCON:ACAD:ASEL "p:/pattern1.dm_iqd

// ******************************************************************
// Enable AdvData Info flag, set advertising data ID and 
// advertising data set ID.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:ADINfo:STATe ON
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SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ADID #H01FF,12
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ASID #H0F,4
// ******************************************************************
// Enable and specify AuxPtr for the secondary advertising 
// channel: select AUX channel, set clock accuracy, offset unit,
// AUX offset, AUX PHY.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:APTR:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:DCTable:CHANnel0:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy T500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits U30
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:APHY L1M
// ******************************************************************
// Enable and specify SyncInfo field for the AUX_SYNC_IND 
// packet: set sync packet offset, offset unit, periodic adv 
// interval, sleep clock accuracy, access address, CRC initial 
// value. Reset event counter. Configure channel map.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:SINFo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval 20
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy SCA0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HACDE48AC,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIV #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U30
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset?
// 99.9
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter 0
SOURce1:BB:BTOoth:ECONfiguration:PCON:DCMTable:CHANnel0:STATe 1

// ******************************************************************
// Configure advertiser, scanner and initiator device addresses.
// Company_Assigned and Company_Id in Advertiser´s Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACID #H000000,24
// Company_Assigned and Company_Id in Scanners Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCID #H000000,24
// Company_Assigned and Company_Id in Initiators Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ICAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ICID #H000000,24
// ******************************************************************
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Example: To configure data packets
// ******************************************************************
// Configure signal for DATA: select channel type, packet type,
// packet format, sequence length, role, enable CRC corruption.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:PFORmat L1M
SOURce1:BB:BTOoth:USLength 12
SOURce1:BB:BTOoth:BCRole CENTral
SOURce1:BB:BTOoth:CCRC:STATe 1

// ******************************************************************
// Configure packet type DATA: access address, CRC initial,
// NESN start, SN start values, data source, data length
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe DATA
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HDAB85479,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DATA PN09
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth 251

// ******************************************************************
// Configure payload of LL_CONNECTION_UPDATE_IND: transmit 
// window size and offset, connection event interval, Peripheral 
// latency, LL connection timeout, connection instant.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HDAB85479,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize 1.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval 7.5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PSLatency 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant 0

// ******************************************************************
// Configure the payload of LL_FEATURE_REQ: set packet
// type, feature set length and configure feature set. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe FREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength 8
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit0:STATe 1
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SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit1:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit2:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit3:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit4:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit5:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit6:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit7:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit8:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit9:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit10:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit11:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit12:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit13:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit14:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit15:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit16:STATe 0

// ******************************************************************
// Configure the payload of LL_CONNECTION_PARAM_REQ: max. and min.
// interval, Peripheral latency, LL connection timeout, preferred
// periodicity, reference connection even count
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CPR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval 10
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval 7.5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PSLatency 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity 1.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount 10
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet0:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet0:VALue 3.75
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet1:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet1:VALue 5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet2:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet2:VALue 6.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet3:STATe OFF
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet4:STATe OFF
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet5:STATe OFF

// ******************************************************************
// Configure the payload of LL_LENGTH_REQ: max. Rx and TX 
// payload octets, max. time to receive and transmit a packet.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe LREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets 27
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets 27
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime 0.328
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime 0.328
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// ******************************************************************
// Set the payload of LL_PHY_REQ: specify preferred Tx, Rx PHYs. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe PREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:STATe 0

// ******************************************************************
// Set the payload of LL_PHY_UPDATE_IND: specify PHYs for
// Central-to-Peripheral and Peripheral-to-Central direction and instant. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe PUIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant 1

// ******************************************************************
// Set the payload of LL_REJECT_EXT_IND: set reject opcode
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe REIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode #H02,8

// ******************************************************************
// Set the payload of LL_MIN_USED_CHANNELS_IND: set the controller 
// role to Peripheral, set the packet type, specify PHYs and minimum
// used channels requirement
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:BCRole PERipheral
SOURce1:BB:BTOoth:UPTYpe MUCH
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels 2

// ******************************************************************
// Set header and payload of LL_PERIODIC_SYNC_IND: enable CTE and 
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// configure CTE method, set event counter properties, specify PHYs
// and address type.
// ******************************************************************
:SOURce1:BB:BTOoth:CTYPe DATA
:SOURce1:BB:BTOoth:UPTYpe PSIN
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent 1
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe 0.016
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe AOA
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ID #HAAAA,16
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset 245.7
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U30
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust 1
// Enabling offset adjust sets the Sync packet offset to 300 µs.
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U300
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CECount 65535
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter 65535
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SID #H1,4
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe PUBL
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy SCA0
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe 1
// Enabling another PHY automatically disables the previous PHY.
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe 1
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe 1
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe? 0
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe? 0
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned #H000080,24
:SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter 65535

● General configuration............................................................................................150
● Header configuration.............................................................................................151
● Payload configuration............................................................................................154

5.7.1  General configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening.......................... 150
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress............................ 151
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue................................ 151

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
<DWhitening>

Activates or deactivates the Data Whitening. Evenly distributed white noise is ideal for
the transmission and real data can be forced to look similar to white noise with different
methods called Data Whitening. Applied to the PDU and CRC fields of all packet types,
whitening is used to avoid long equal seqeunces in the data bit stream.

Parameters:
<DWhitening> 1 | ON | 0 | OFF

*RST: 0

Packet configuration commands - LE



Remote-control commandsR&S®SMM-K60/-K117

151User Manual 1179.2054.02 ─ 06

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Data Whitening" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
<AAddress>, <BitCount>

Sets the access address of the link layer connection (32-bit string).

Parameters:
<AAddress> numeric

*RST: #HACDE48AC

<BitCount> integer
Range: 32  to  32
*RST: 32

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "Access Address" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue <CiValue>,
<BitCount>

Sets the initialization value for the CRC (Cyclic Redundancy Check, 24 bits) calcula-
tion. A packet has been received correctly, when it has passed the CRC check.

Parameters:
<CiValue> numeric

*RST: #H0

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "CRC Initial" on page 65

5.7.2  Header configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection.......................... 152
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue............................... 152
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue............................... 152
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent.............................152
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe..................................153
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq................................. 153
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe................................. 153
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0>......................................... 154
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber............................................. 154
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection
<CSelection>

Specifies the algorithm of channel selection.

Parameters:
<CSelection> CS1 | CS2

Algorithm #1 or algorithm #2
*RST: CS1

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Channel Selection" on page 64

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue <NsValue>

Sets the start value of the next expected packet from the same device in the LL con-
nection ("N"ext"E"xpected "S"equence"N"umber). This parameter can be set in the first
event. From the second event this field is not indicated.

Parameters:
<NsValue> integer

Range: 0  to  1
*RST: 1

Example: See Example"To configure data packets" on page 147.

Manual operation: See "NESN Start Value" on page 64

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue <SsValue>

Sets the sequence number of the packet. This parameter can be set in the first event.
From the second event, this field is not indicated.

Parameters:
<SsValue> integer

Range: 0  to  1
*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "SN Start Value" on page 64

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent <State>

Activates the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: See Example"To configure data packets" on page 147.

Manual operation: See "CTEInfo Present" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe <CTime>

Sets the CTETime comprising the length of constant tone extension field of the Blue-
tooth LE PDU.

Parameters:
<CTime> float

Range: 16E-6  to  160E-6
Increment: 8E-6
*RST: 16E-6

Example: See Example"To configure data packets" on page 147.

Manual operation: See "CTETime" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq <CTReq>

Sets the CTE type in the CTETypeReq field of the CtrData field of the LL_CTE_REQ
PDU.

Parameters:
<CTReq> AOD1 | AOA | AOD2

AOA
AoA Constant Tone Extension
AOD1
AoD Constant Tone Extension with 1 µs time slots
AOD2
AoD Constant Tone Extension with 2 µs time slots
*RST: AOA

Example: See Example"To configure data packets" on page 147.

Manual operation: See "CTETypeReq" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe <CType>

Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.

Parameters:
<CType> AOD1 | AOA | AOD2

AOA
AoA Constant Tone Extension
AOD1
AoD Constant Tone Extension with 1 µs time slots
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AOD2
AoD Constant Tone Extension with 2 µs time slots
*RST: AOA

Example: See Example"To configure data packets" on page 147.

Manual operation: See "CTEType" on page 66

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> <AntennaGain>

Specifies the gain of the antenna. You can specify the antenna gain infomation of up
for four individual antennas for direction finding.

Parameters:
<AntennaGain> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "AntennaX Gain" on page 66

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber <AntennaNum>

Specifies the number of antenas for angle of departure (AoD) direction finding method.
You select up to four antennas, that are used for direction finding.

Parameters:
<AntennaNum> integer

Range: 1  to  4
*RST: 1

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Antenna Number" on page 66

5.7.3  Payload configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD...................................156
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern.................... 157
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection.................157
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID....................................158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned......................... 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned......................... 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID....................................158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned.......................... 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID..................................... 158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID....................................158
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP................................... 159
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP.....................................159
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP................................... 159
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP................................... 159
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth...............................159
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe................................ 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap................................. 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap.................................. 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap................................. 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap................................. 160
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset...............................161
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits...............................161
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY...................................161
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID.................................... 162
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy.......................... 162
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID......................................162
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant.............................. 163
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval............................. 163
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA................................... 163
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATtern.....................164
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection................. 164
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth.............................. 165
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe................................ 165
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter............................. 165
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier.......................... 166
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe.................... 166
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:AADDress:STATe....166
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:STATe.........167
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:STATe.......... 167
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:STATe..........167
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:STATe..........167
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TADDress:STATe.... 168
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TPOWer:STATe...... 168
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe................ 168
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength..............................169
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth.............................. 169
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout............................169
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector...............................170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector............................... 170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets............................ 170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets.............................170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD.................................. 170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD...................................170
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime............................... 171
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime................................171
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels........................ 171
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:STATe..............172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe..............172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe........... 172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:STATe..............172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe..............172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATe........... 172
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval............................172
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout......................... 173
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency............................173
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset............................ 173
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize................................174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust...............................174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe................. 174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe................. 174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe...............174
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe................................ 175
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYpe................................175
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode.............................175
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe................176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe................176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:STATe.............176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe................176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe................176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:STATe............. 176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor...............................176
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy......................... 177
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency............................. 177
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits...............................177
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset..............................178
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber............................178
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer............................... 178
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe................................. 179
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber............................. 179
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset..............................180
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe..................................180
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe..................................180
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount.............................. 181
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID........................................ 181
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter..........................181
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq...............................181
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe....................182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe....................182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe................. 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter......................... 183
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID...................................... 183

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD <Data>

Specifies the pattern source used for additional controller advertising data (ACAD).

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
ALL0 / ALL1
All 0 or all 1 pattern
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PATTern
User-defined pattern. The pattern can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:APATtern on page 157
PNxx
Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.
DLISt
Internal ACAD data list is used. The data list can be specified
via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:ASELection on page 157
*RST: PN09

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "ACAD" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern
<DPattern>, <BitCount>

Specifies user-defined pattern. The settings is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD
PATTern
Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AList / Pattern" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection
<DSelection>

Specifies data list file. The settings is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACADDLISt
Parameters:
<DSelection> string

Path and file name.
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Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AList / Pattern" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID <Acid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
<AcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
<ScAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID <Scid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
<IcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID <Icid>,
<BitCount>

Sets the advertiser´s device address. For advertising channel packets, the format of
the device address differs, depending on the selected address type.

● "Public Address Types"
The public address is given from the registration authority IEEE and is composed
of:
– LSB: 24 bits = company_assigned
– MSB: 24 bits = company_id

● "Random Address Type" is a 48-bits random static device address.
● "Private Address Type"

A private address is optional and composed of:
– LSB: 24 bits = hash
– MSB: 24 bits = random

Parameters:
<Icid> numeric

*RST: #HACDE48

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "Device Address" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID <Adid>,
<BitCount>

Specifies "Advertising Data ID" in hexadecimal format to be signaled within an exten-
ded header.
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Parameters:
<Adid> numeric

*RST: #H000

<BitCount> integer
Range: 12  to  12
*RST: 12

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AdvDataInfo Configuration" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP <Lap>,
<BitCount>

Sets the lower address part (LAP) of Bluetooth device address. Commands for the
advertising ..:ALAP, initiating ..:ILAP, scanning ..:SLAP PDUs of advertising
channel type are provided. In addition, a command is provided for scanner’s or initia-
tor’s target device address to which the advertisement is directed ..:TLAP.

Parameters:
<Lap> numeric

*RST: #H000080

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Device Address" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth <Length>

Specifies the length of ACAD data pattern.

Parameters:
<Length> integer

Range: 0  to  62
*RST: 27

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117
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Manual operation: See "ACAD Length" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe <AMode>

Indicates the mode of the advertisement.

Parameters:
<AMode> NCNS | CNS | NCS

NCNS: Non-connectable, non-scannable
CNS: Connectable, non-scannable
NCS: Non-connectable, non-scannable
*RST: NCNS

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Advertising Mode" on page 75

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap <NapUap>,
<BitCount>

Sets the non-significant address part (NAP) and upper address part (UAP) of Bluetooth
device address. Commands for the advertising ..:ANUap, initiating ..:INUap, and
scanning ..:SNUap PDUs of advertising channel type are provided. In addition, a
command is provided for scanner’s or initiator’s target device address to which the
advertisement is directed ..:TNUap.

Parameters:
<NapUap> numeric

*RST: #HACDE48

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Device Address" on page 68
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset <AOffset>

Specifies the time from the start of the packet containing the AuxPtr field to the approx-
imate start of the auxiliary packet. The offset is determined by multiplying the value by
the unit, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
Parameters:
<AOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Aux Offset" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits <Unit>

Indicates the units used by the "Aux Offset" parameter, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset
Parameters:
<Unit> U30 | U300

U30: 30 µs
U300: 300 µs
*RST: U30

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Offset Units" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY <APhy>

Specifies the physical layer used to transmit the auxiliary packet.

Parameters:
<APhy> L1M | L2M | LCOD

LE 1M, LE 2M, LE coded PHY
*RST: L1M

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AUX PHY" on page 85
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID <Asid>,
<BitCount>

Specifies the "Advertising Set ID" in hexadecimal format to be signaled within an
extended header.

Parameters:
<Asid> numeric

*RST: #H0

<BitCount> integer
Range: 4  to  4
*RST: 4

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AdvDataInfo Configuration" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
<CAccuracy>

Specifies the clock accuracy of the advertiser used between the packet containing this
data and the auxiliary packet.

Parameters:
<CAccuracy> T500 | T50

T500: 51 ppm to 500 ppm
T50: 0 ppm to 50 ppm
*RST: T500

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Clock Accuracy" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID <Cid>,
<BitCount>

Sets the company identifier of the manufacturer of the Bluetooth Controller. A 16 bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.

Parameters:
<Cid> numeric

*RST: 0
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<BitCount> integer
Range: 16  to  16
*RST: 16

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Company Id(hex)" on page 75

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
<CInstant>

Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.

Parameters:
<CInstant> integer

Range: 1  to  depends on sequence length
*RST: 1

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Connection Instant" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
<CInterval>

Sets the time interval between the start points of two consecutive connection events for
the packet type DATA and all CONTROL_DATA packet types.

Command sets the values in ms. Query returns values in s.

Parameters:
<CInterval> float

Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Connection Event Interval" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA <Data>

Selects the pattern source used for the payload.

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
ALL0 / ALL1
All 0 or all 1 pattern
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PATTern
User-defined pattern. The pattern can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DPATtern on page 164
PNxx
Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.
DLISt
Internal data list is used. The data list can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DSELection on page 164
*RST: PN09

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "Data Source" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATtern
<DPattern>, <BitCount>

Specifies the user-defined pattern. The setting is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA
PATTern
Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Data Source" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection
<DSelection>

Specifies data list file. The setting is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATADLISt
Parameters:
<DSelection> string

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "Data Source" on page 70
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth
<DLength>

Sets the payload data length in bytes.

Parameters:
<DLength> integer

Range: 0  to  255 (advertiser) or 251 (data)
*RST: 31

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "Data Length" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe <ECode>,
<BitCount>

Sets the error code value to inform the remote device why the connection is about to
be terminated in case of LL_TERMINATE_IND packet. On the other hand, this param-
eter for LL_REJECT_IND packet is used for the reason a request was rejected. A 8 bit
value is set.

Note: This parameter is relevant for data frame configuration and the packet type:

● LL_TERMINATE_IND
● LL_REJECT_IND

Parameters:
<ECode> numeric

*RST: #H00

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:ECOD #H00,8
Sets the error code.

Manual operation: See "Error Code" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
<ECounter>

Counts the AUX_SYNC_IND packets that the SyncInfo field describes.

Parameters:
<ECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117
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Manual operation: See "Event Counter" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier
<EDiversifier>, <BitCount>

Sets the encrypted diversifier of the Central for device identification. The parameter is
an initialization vector provided by the host in the HCI_ULP_Start_Encryption com-
mand.

Parameters:
<EDiversifier> numeric

*RST: #H0000

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: SOURce1:BB:BTO:ECON:PCON:EDIV #H0000,16
Sets the encrypted diversifier of the Central.

Manual operation: See "Encrypted DIVersifier (hex)" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe
<State>

Enables / disables extended header for advertising packets with scanning PDUs.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Extended Header" on page 75

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe <State>

If enabled, the R&S SMM100A includes the signaling of non-significant advertising
address part (NAP) and upper address part (UAP).

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AdvA" on page 76
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:
STATe <State>

Enables / disables the signaling of advertising data information consisting of "Advertis-
ing Data ID" and "Advertising Set ID".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AdvData Info" on page 76

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:
STATe <State>

Enables / disables secondary advertising channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "AuxPtr" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:
STATe <State>

Activates the CTEInfo field in the extended header of Bluetooth LE advertising packets
in the LE uncoded PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Manual operation: See "CTE Info" on page 76

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:
STATe <State>

Enables / disables the signaling of SyncInfo field for periodic advertisement.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "SyncInfo" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe <State>

Enables / disables the signaling of non-significant address part (NAP) and upper
address part (UAP) of a target address.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "TargetA" on page 76

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TPOWer:
STATe <State>

Enables the signaling of required transmit power.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "TxPow" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe
<State>

Enables / disables features, related to bit numbers 0 to 27 for the used feature set. See
also Table 3-8.

Information is transmitted via LL_FEATURE_REQ, LL_FEATURE_RSP, LL_PERIPH-
ERAL_FEATURE_REQ.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "FeatureSet Configuration" on page 87
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
<FsLength>

Enables that the feature set length is indicated.

Parameters:
<FsLength> integer

Range: 1 to 26
*RST: 8

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Feature Set Length" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
<HLength>

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Sets the difference from the current channel to the next channel.

The Central and Peripherals determine the data channel in use for every connection
event from the channel map. Hop_length is set for the LL connection and communica-
ted in the CONNECT_IND and LL_CHANNEL_MAP_IND packets.

Parameters:
<HLength> integer

Range: 5  to  16
*RST: 5

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Hop Length" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
<LcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost for the packet type CON-
NECT_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<LcTimeout> float

Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 147.

Manual operation: See "LL Connection Timeout" on page 71
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
<MiVector>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector
<SiVector>, <BitCount>

Sets the portion of Central or the portion of the Peripheral of the initialization vector
(IVm/IVs).

Parameters:
<SiVector> numeric

*RST: #H0

<BitCount> integer
Range: 32  to  32
*RST: 32

Example: SOURce1:BB:BTO:ECON:PCON:MIV
#H0000000000000000,32
(Central).
SOURce1:BB:BTO:ECON:PCON:SIV
#H0000000000000000,32
(Peripheral).

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets
<MROctets>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
<MTOctets>

Specifies the maximum allowed payload length of a packet to be received
(..:MROCtets) or transmitted (..:MTOCtets). Information is signaled via
LL_LENGTH_REQ and LL_LENGTH_RSP.

Parameters:
<MTOctets> integer

Range: 27  to  251
*RST: 27

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "Max Rx Octets / Max Tx Octets" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD <Mskd>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD <Sskd>,
<BitCount>

Sets the portion of Central or the portion of the Peripheral of the session key diversifier
(SKDm/SKDs).
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Parameters:
<Sskd> numeric

*RST: #H0

<BitCount> integer
Range: 64  to  64
*RST: 64

Example: SOURce1:BB:BTO:ECON:PCON:MSKD
#H0000000000000000,64
(Central).
SOURce1:BB:BTO:ECON:PCON:SSKD
#H0000000000000000,64
(Peripheral).

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime <MRTime>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime <MTTime>
Specifies the maximum allowed time to receive (..:MRTime) or transmit (..:MTTime)
a packet. Information is signaled via LL_LENGTH_REQ and LL_LENGTH_RSP.

Parameters:
<MTTime> float

Range: 0.328E-3  to  17.04E-3
Increment: 0.001E-3
*RST: 17.04E-3

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "Max Rx Time / Max Tx Time" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
<Muchannels>

Specifies the minimum number of channels to be used on the specified PHYs, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:
STATe etc.

Parameters:
<Muchannels> integer

Range: 2  to  37
*RST: 2

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "Min Used Channels" on page 81
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:
STATe <STMP>

Specifies the physical layers in Central-to-Peripheral (..:MTSPhy:..) or Peripheral-
to-Central (..:STMPhy:..) direction. Information is signaled via
LL_PHY_UPDATE_IND.

You can enable one or more PHYs:
● L1M: for LE uncoded 1 Msymbol/s PHY.
● L2M: for LE uncoded 2 Msymbol/s PHY.
● LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<STMP> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "M_TO_S_PHY/S_TO_M_PHY" on page 80

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
<NcInterval>

Sets the time interval new connection events for the packet types CONNECT_IND and
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NcInterval> float

Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Connection Evt Interval" on page 71
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
<NlcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost only for the packet type
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NlcTimeout> float

Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 147.

Manual operation: See "LL Connection Timeout" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
<NsLatency>

Requires a data event and advertising frame configuration with the packet type
LL_CONNECTION_UPDATE_IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<NsLatency> integer

Range: 0  to  depends on LL connection timeout and con-
nection event interval

*RST: 0

Example: SOURce1:BB:BTO:UPTY CUR
sets packet type LL_CONNECTION_UPDATE_IND
SOURce1:BB:BTO:ECON:PCON:NSLatency 10
sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
<NwOffset>

Sets the start point of the transmit window for data event and advertising frame config-
uration with the packet type LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.
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Parameters:
<NwOffset> float

Range: 0 s to depends on connection event interval
Increment: 1.25E-3 s
*RST: 0
Default unit: ms

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Transmit Window Offset" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize <NwSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type LL_CONNEC-
TION_UPDATE_IND.

Parameters:
<NwSize> float

Range: 1.25E-3  to  depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Transmit Window Size" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust <State>

Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the ""Offset Units".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Offset Adjust" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe
<State>

Specifies the physical layers for which the Peripheral has a minimum number of used
channels requirement. Information is signaled via LL_MIN_USED_CHANNELS_IND.

You can enable one or more PHYs:
● L1M: for LE uncoded 1 Msymbol/s PHY.
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● L2M: for LE uncoded 2 Msymbol/s PHY.
● LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "PHYs" on page 80

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe <TaType>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYpe <RaType>
Selects the address type of the controller device.

Depending on the Bluetooth controller role either Tx or Rx or both address types are
assigned. Subdivided into private and random, a Bluetooth LE device address consits
of 48 bits. The format of the device address differs depending on the selected address
type.

Parameters:
<RaType> PUBLic | RANDom

PUBlic
Allocates a unique 48 bit address to each Bluetooth LE device.
The public address is given from the registration authority IEEE.
RANDom
Allocates a 48-bit address to each Bluetooth LE device. A ran-
dom address is optional.
*RST: PUBLic

Example: SOURce1:BB:BTO:ECON:PCON:TATY PUBL
SOURce1:BB:BTO:ECON:PCON:RATY RAND

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
<ROpcode>, <BitCount>

Specifies the Opcode of rejected LL control PDU. information is signaled via
LL_REJECT_EXT_IND.

Parameters:
<ROpcode> numeric

*RST: #H00

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117
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Manual operation: See "Reject Opcode" on page 80

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:
STATe <RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe
<TPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe
<TPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:
STATe <TPhys>

Specifies preferred physical layers in Rx (..:RPHYs:..) or Tx (..:TPHYs:..) direc-
tion. Information is signaled via LL_PHY_REQ and LL_PHY_RSP.

You can enable one or more PHYs: :L1M: for LE uncoded 1 Msymbol/s PHY, :L2M:
for LE uncoded 2 Msymbol/s PHY, and :LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<TPhys> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Options: R&S SMM-K117

Manual operation: See "Rx PHY / Tx PHY" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
<RVector>, <BitCount>

Sets the random vector of the Central for device identification.

The parameter is an initialization vector provided by the Host in the
HCI_ULP_Start_Encryption command.

Parameters:
<RVector> numeric

*RST: #H0

<BitCount> integer
Range: 64  to  64
*RST: 64

Example: SOURce1:BB:BTO:ECON:PCON:RVEC
#H0000000000000000,64
Sets the random vector of the Central.

Manual operation: See "Random Vector (hex)" on page 72
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
<ScAccuracy>

Defines the clock accuracy of the Central with specified encoding.

This parameter is used by the Peripheral to determine required listening windows in
the LL connection. It is a controller design parameter known by the bluetooth controller.

Parameters:
<ScAccuracy> SCA0 | SCA1 | SCA2 | SCA3 | SCA4 | SCA5 | SCA6 | SCA7

*RST: SCA0

Example: SOURce1:BB:BTO:ECON:PCON:SCAC SCA1
Sets the encoding value.

Manual operation: See "Sleep Clock Accuracy" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
<SLatency>

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<SLatency> integer

Range: 0  to  depends on LL connection timeout and con-
nection event interval

*RST: depends on LL connection timeout and connection
event interval

Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND.
SOURce1:BB:BTO:ECON:PCON:SLAT 10
Sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits <Unit>

Indicates the units used by the "Sync Packet Offset" parameter, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
Parameters:
<Unit> U30 | U300

U30
30 µs
U300
300 µs
*RST: U30
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Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Offset Units" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
<SPOffset>

Specifies the time from the start of the AUX_ADV_IND packet containing the SyncInfo
field to the start of the AUX_SYNC_IND packet. The offset is determined by multiplying
the value by the unit, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits
Parameters:
<SPOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "Sync Packet Offset" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber
<SvNumber>, <BitCount>

Sets a unique value for each implementation or revision of an implementation of the
Bluetooth Controller. A 16-bit value is set.

Note: This parameter is relevant for data frame configuration and for the packet type:

LL_VERSION_IND.

Parameters:
<SvNumber> numeric

*RST: 0

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: SOURce1:BB:BTO:ECON:PCON:SVN #H0000,16
Sets the sub version number.

Manual operation: See "SubVersion Number(hex)" on page 75

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer <TPower>

Sets the required transmit power to be signaled within an extended header.
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Parameters:
<TPower> integer

Range: -127  to  126
*RST: 0

Example: See Example"To configure advertising packets" on page 144.

Options: R&S SMM-K117

Manual operation: See "TxPow" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe <UType>,
<BitCount>

Enables that an invalid control packet is indicated.

The CtrType field indicates the value of the LL control packet that caused the transmis-
sion of this packet.

Parameters:
<UType> numeric

*RST: #H0

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:UTYP #H00,8
Enables that an invalid control packet is indicated.

Manual operation: See "Unknown Type (hex)" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
<VNumber>, <BitCount>

Sets the company identifier of the manufacturer of the Bluetooth controller. An 8-bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.

Parameters:
<VNumber> numeric

*RST: 0

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:VNUM #H00,8
Sets the version number.

Manual operation: See "Version Number(hex)" on page 75
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
<WOffset>

Sets the start point of the window transmit for data event and advertising frame config-
uration with the packet type CONNECT_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<WOffset> float

Range: 0 s to depending on connection event interval
Increment: 1.25E-3 s
*RST: 0 s
Default unit: ms

Example: See Example"Configure event and frame configuration settings"
on page 134.

Manual operation: See "Transmit Window Offset" on page 57
See "Transmit Window Offset" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe <WSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type CONNECT_IND.

Parameters:
<WSize> float

Range: 1.25E-3  to  depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Transmit Window Size" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe <AType>

Sets the address type in the payload of Bluetooth LE LL_PERIODIC_SYNC_IND pack-
ets.

Parameters:
<AType> PUBLic | RANDom

*RST: PUBLic

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Address Type" on page 82
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
<CECount>

Specifies the connection event count in the CtrData field of the LL_PERI-
ODIC_SYNC_IND control data PDU.

Parameters:
<CECount> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Connection Event Count" on page 81

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID <Id>, <BitCount>

Specifies the ID in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<Id> numeric

*RST: #HAAAA

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: See Example"To configure data packets" on page 147.

Manual operation: See "ID(hex)" on page 81

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter
<LPECounter>

Specifies the lastPaEventCounter field in the CtrData field of the LL_PERI-
ODIC_SYNC_IND PDU.

Parameters:
<LPECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Last Pa Event Counter" on page 81

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
<MCLReq>

Specifies the minimum CTE length in the CtrData field of the LL_CTE_Req PDU.
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Parameters:
<MCLReq> float

Range: 16E-6  to  160E-6
Increment: 8E-6
*RST: 16E-6

Example: See Example"To configure data packets" on page 147.

Manual operation: See "MinCTELenReq" on page 83
See "CTETypeReq" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe
<State>

Sets the LE 1M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "PHY" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe
<State>

Sets the LE 2M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "PHY" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe
<State>

Sets the LE Coded PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "PHY" on page 82
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter
<SCECounter>

Parameters:
<SCECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure data packets" on page 147.

Manual operation: See "Sync Connection Event Counter" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID <Sid>,
<BitCount>

Specifies the SID in the CtrData field of the LL_PERIODIC_SYNC_IND.

Parameters:
<Sid> numeric

*RST: #H0

<BitCount> integer
Range: 4  to  4
*RST: 4

Example: See Example"To configure data packets" on page 147.

Manual operation: See "SID(hex)" on page 82

5.8  Test packet configuration commands - LE

Example: To configure test packets
// ******************************************************************
// Set pattern, payload length, time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe TPAC
SOURce1:BB:BTOoth:DTTest:TPConfiguration:TPINterval 12.5
SOURce1:BB:BTOoth:DTTest:TPConfiguration:UPSource PAT3
SOURce1:BB:BTOoth:DTTest:TPConfiguration:UPLength 255

/ ******************************************************************
// Alternatively select packet type LE coded and set its coding.
// ******************************************************************
SOURce1:BB:BTOoth:PFORmat LCOD
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit TWO
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit................................... 184
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval........................................184
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength.........................................184
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource........................................ 185

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit <SPB>

Specifies a coding for LE coded packets. The specification for Bluetooth wireless tech-
nology defines two values S for forward error correction: S = 2 symbol/bit and S = 8
symbol/bit.

Parameters:
<SPB> TWO | EIGHt

*RST: TWO

Example: See Example"To configure test packets" on page 183.

Options: R&S SMM-K117

Manual operation: See "Symbols per a Bit" on page 89

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval <TpInterval>

Sets the time interval between two consecutive test packets, regarding the starting
points.

Command sets the values in ms. Query returns values in s.

Parameters:
<TpInterval> float

Range: 0.625E-3 s to 27.5E-3 s - depends on packet char-
acteristics

Increment: 0.625E-3 s
*RST: 0.625E-3 s
Default unit: ms

Example: See Example"To configure test packets" on page 183.

Manual operation: See "Packet Interval" on page 88

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength <UpLength>

Sets the payload length.

Parameters:
<UpLength> integer

Range: 0  to  255
*RST: 37

Example: See Example"To configure test packets" on page 183.

Manual operation: See "Payload Length" on page 89
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[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource <UpSource>

Selects the data source used for the payload test packets.

Parameters:
<UpSource> PN09 | PAT1 | PAT2 | PN15 | PAT3 | PAT4 | PAT5 | PAT6

PN9 / PN15
Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9 or 15.
PAT1
Predefined pattern: 11110000
PAT2
Predefined pattern: 10101010
PAT3
Predefined pattern: 11111111
PAT4
Predefined pattern: 00000000
PAT5
Predefined pattern: 00001111
PAT6
Predefined pattern: 01010101
*RST: PN09

Example: See Example"To configure test packets" on page 183.

Manual operation: See "Payload Type" on page 89

5.9  Filter/clipping commands
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[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine..................................................191
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase....................................................191
[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation..................................................................191

[:SOURce<hw>]:BB:BTOoth:CLIPping:LEVel <Level>

Sets the limit for level clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Parameters:
<Level> integer

Range: 1  to  100
Increment: 1
*RST: 100
Default unit: PCT

Example: SOURce1:BB:BTO:CLIP:LEV 80
Sets the limit for level clipping to 80% of the maximum level.
SOURce1:BB:BTO:CLIP:STAT ON
Activates level clipping.

Manual operation: See "Clipping Level" on page 95

[:SOURce<hw>]:BB:BTOoth:CLIPping:MODE <Mode>

The command sets the method for level clipping.

Parameters:
<Mode> VECTor | SCALar

VECTor
The reference level is the amplitude | i+jq |.
SCALar
The reference level is the absolute maximum of the I and Q val-
ues.
*RST: VECTor

Example: SOURce1:BB:BTO:CLIP:MODE VECT
Sets the amplitude as reference level.

Manual operation: See "Clipping Mode" on page 95

[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe <State>

Activates level clipping.

The value is defined with the command BB:BTO:CLIPping:LEVel, the mode of cal-
culation with the command BB:BTO:CLIPping:MODE.

Filter/clipping commands



Remote-control commandsR&S®SMM-K60/-K117

187User Manual 1179.2054.02 ─ 06

Parameters:
<State> 1 | ON | 0 | OFF

*RST: OFF

Example: SOURce1:BB:BTO:CLIP:STAT ON
Activates level clipping.

Manual operation: See "Clipping State" on page 95

[:SOURce<hw>]:BB:BTOoth:FILTer:TYPE <Type>

Selects the filters used for π/4 DQPSK and 8DPSK modulations. This opens a selec-
tion window containing all the filters available to the instrument.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape
*RST: RCOSine

Example: SOURce1:BB:BTO:FILT:TYPE RCOS
Sets the filter type RCOSine.

Manual operation: See "Filter" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth <ILength>

Sets the impulse length (the number of filter taps).

Parameters:
<ILength> integer

Range: 1  to  depends on oversampling
*RST: 32

Example: SOURce1:BB:BTO:FILT:ILEN 10
Sets the number of filter tabs to 10.

Manual operation: See "Impulse Length" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATe] <State>

Activates the impulse length state.

If activated, the most sensible parameter values are selected. The value depends on
the coherence check.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:FILT:ILEN:AUTO ON
Selects the most sensible parameters automatically.
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Manual operation: See "Impulse Length" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling <OSampling>

Sets the upsampling factor.

Parameters:
<OSampling> integer

Range: 1  to  32
*RST: 10

Example: SOURce1:BB:BTO:FILT:OSAM 10
Sets the upsampling factor to 10.

Manual operation: See "Oversampling" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling:AUTO[:STATe] <State>

Activates the upsampling factor state. If activated, the most sensible parameter values
are selected. The value depends on the coherence check. If deactivated, the values
can be changed manually.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:FILT:OSAM:AUTO ON
The most sensible parameters are selected automatically.

Manual operation: See "Oversampling" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:MINDex <MIndex>

Queries the modulation index resulting from the entered frequency deviation value.

Parameters:
<MIndex> string

Example: SOURce1:BB:BTO:FILT:MIND?
Queries the modulation index
// Response: "0.5"

Manual operation: See "Modulation Index" on page 94

[:SOURce<hw>]:BB:BTOoth:FILTer:MTYPe <MType>

Queries the modulation type used for the current packet selection.

Parameters:
<MType> string

Example: SOURce1:BB:BTO:FILT:MTYP?
Queries the modulation type
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Manual operation: See "Modulation Type" on page 93

[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation <FDeviation>

Sets the frequency deviation.

Parameters:
<FDeviation> float

Range: Depends on Bluetooth mode
Increment: 0.1
*RST: depends on Bluetooth mode

Example: SOURce1:BB:BTO:MSET:FDEV 160
Sets a frequency deviation of 160 kHz.

Manual operation: See "Frequency Deviation" on page 93

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 <Apco25>

Sets the roll-off factor for filter type APCO25.

Parameters:
<Apco25> float

Range: 0.05  to  0.99
Increment: 0.01
*RST: 0.2

Example: SOURce1:BB:BTO:FILT:PAR:APCO25 0.2
Sets the roll-off factor to 0.2 for filter type APCO25.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine <Cosine>

Sets the roll-off factor for the Cosine filter type.

Parameters:
<Cosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.1

Example: SOURce1:BB:BTO:FILT:PAR:COS 0.35
Sets the roll-off factor to 0.35 for filter type Cosine.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss <FGauss>

Sets the B x T for the Gauss filter type.

Filter/clipping commands



Remote-control commandsR&S®SMM-K60/-K117

190User Manual 1179.2054.02 ─ 06

Parameters:
<FGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:FGA 0.5
Sets B x T to 0.5 for the Gauss filter type for the GFSK section
of the packet.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs <Gauss>

Sets the B x T for the Gauss filter type.

Parameters:
<Gauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:GAUS 0.5
Sets B x T to 0.5 for the Gauss filter type for π/4 DQPSK or
8DPSK sections.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs <LPass>

Sets the cut off frequency factor for a lowpass filter (ACP Opt.).

Parameters:
<LPass> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:LPAS 1
Sets the cut off frequency factor for a lowpass filter.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92
See "Cut Off Frequency Factor" on page 93

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss <PGauss>

Sets the B x T for the Pure Gauss filter type.
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Parameters:
<PGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:PGA 0.5
Sets B x T to 0.5 for the Pure Gauss filter type.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine <RCosine>

Sets the roll-off factor for the Root Cosine filter type.

Parameters:
<RCosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.4

Example: SOURce1:BB:BTO:FILT:PAR:RCOS 0.22
Sets the roll-off factor to 0.22 for filter type Root Cosine.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase <SPhase>

Sets the BxT for the split phase filter type.

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: SOURce1:BB:BTO:FILT:PAR:SPH 0.5
Sets B x T to 0.5 for the Split Phase filter type.

Manual operation: See "Roll Off Factor / BxT" on page 91
See "Roll Off Factor / BxT" on page 92

[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation <Variation>

Sets the symbol rate.
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Parameters:
<Variation> float

Range: 4E2  to  15E6
Increment: 1E-3
*RST: 1E6

Example: BB:BTO:SRAT:VAR 1
sets the symbol rate variation to 1 MHz.

Manual operation: See "Symbol Rate Variation" on page 94

5.10  Power ramping commands

[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset..............................................................192
[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction.......................................................... 192
[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset............................................................. 193
[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe.................................................................193

[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset <FOffset>

Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.

Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.

Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.

Parameters:
<FOffset> integer

Range: -32  to  32
Increment: 1
*RST: 0

Example: BB:BTO:PRAM:FOFF 8
Adds eight symbols at the end of the burst.

Manual operation: See "Fall Offset" on page 97

[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction <RFunction>

The command selects the form of the transmitted power, i.e. the shape of the rising
and falling edges during power ramp control.

Parameters:
<RFunction> LINear | COSine

*RST: COSine
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Example: BB:BTO:PRAM:RFUN LIN
sets linear shape for the rising and falling edges during power
ramp control.

Manual operation: See "Ramp Function" on page 96

[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset <ROffset>

Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.

Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.

Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.

Parameters:
<ROffset> integer

Range: -32  to  32
Increment: 1
*RST: -2

Example: BB:BTO:PRAM:ROFF 8
Skips eight symbols at the beginning of the burst.

Manual operation: See "Rise Offset" on page 96

[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe <RTime>

Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.

Parameters:
<RTime> integer

Range: 1  to  32
Increment: 1
*RST: 2

Example: BB:BTO:PRAM:TIME 2
Extends the burst by 2 symbols at the beginning and end of the
burst.

Manual operation: See "Ramp Time" on page 96
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5.11  Trigger commands

Example: To configure an external trigger
// ******************************************************************
// Configure trigger in armed retrigger mode, set source, enable
// synchronization to external trigger, set external
// inhibit and delay.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence ARET
SOURce1:BB:BTOoth:TRIGger:SOURce EGT1
SOURce1:BB:BTOoth:TRIGger:EXTernal:SYNChronize:OUTPut 1
SOURce1:BB:BTOoth:TRIGger:EXTernal:INHibit 100
SOURce1:BB:BTOoth:TRIGger:EXTernal:DELay 10

Example: To configure an internal trigger
// ******************************************************************
// Configure trigger in single mode.
// Set source to internal, specify signal duration 
// unit and duration.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence SING
SOURce1:BB:BTOoth:TRIGger:SOURce INT
SOURce1:BB:BTOoth:TRIGger:SLUNit SEQ

SOURce1:BB:BTOoth:TRIGger:SLUNit FRAMe
SOURce1:BB:BTOoth:TRIGger:SLENgth 2

// ******************************************************************
// Alternatively configure trigger in armed retrigger  mode.
// Set source to internal. Enable Bluetooth signal, start 
// the trigger - signal generation starts.  
// Stop signal generation and wait for a trigger 
// event to restart signal generation.
// Query the current trigger signal generation status.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence ARETrigger
SOURce1:BB:BTOoth:TRIGger:SOURce INT
SOURce1:BB:BTOoth:STATe 1
SOURce1:BB:BTOoth:TRIGger:EXEcute

[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence............................................................195
[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce.................................................................195
[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe..................................................................196
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE............................................................ 196
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME............................................................. 196
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe]..........................................................197
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth................................................................ 197
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit................................................................... 197
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[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute........................................................198
[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute................................................................ 198
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut............................. 198
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay....................................................198
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit....................................................199

[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode:
● AUTO = auto
● RETRigger = retrigger
● AAUTo = armed auto
● ARETrigger = armed retrigger
● SINGle = single

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Example"To configure an internal trigger" on page 194.

Manual operation: See "Mode" on page 98

[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are:
● Internal triggering by a command (INTernal)
● External trigger signal via one of the local or global connectors

– EGT1|EGT2: External global trigger
– EGC1|EGC2: External global clock

● In primary-secondary instrument mode, the external baseband synchronization sig-
nal (BBSY)

● OBASeband|BEXTernal|EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators.
The R&S SMM100A accepts these values and maps them automatically as follows:
EXTernal = EGT1, BEXTernal = EGT2, OBASeband = INTA

Parameters:
<Source> INTernal|EGT1|EGT2|EGC1|EGC2|EXTernal|BBSY

*RST: INTernal

Example: See Example"To configure an external trigger" on page 194.

Example: See Example"To configure an internal trigger" on page 194.

Manual operation: See "Source" on page 100
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[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe <RMode>

Queries signal generation status for all trigger modes with Bluetooth modulation on.

Parameters:
<RMode> RUN | STOP

*RST: STOP

Example: See Example"To configure an internal trigger" on page 194.

Manual operation: See "Running/Stopped" on page 99

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> Range: 1  to  31
Increment: 1

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 99

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME <Time>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Time> string

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 99
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[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe] <Hour>, <Minute>, <Second>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMM100A triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:TIME
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Time Based Trigger" on page 99

[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SINGle trigger mode.

Parameters:
<SLength> integer

Range: 1  to  7000
*RST: 1

Example: See Example"To configure an internal trigger" on page 194.

Manual operation: See "Signal Duration" on page 99

[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit <SlUnit>

Defines the unit for the entry of the signal sequence length.

Parameters:
<SlUnit> FRAMe | SEQuence | EVENt

FRAMe
A single frame is generated after a trigger event.
SEQuence
A single sequence is generated after a trigger event.
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*RST: SEQuence

Example: See Example"To configure an internal trigger" on page 194.

Manual operation: See "Signal Duration Unit" on page 99

[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.

Example: See Example"To configure an internal trigger" on page 194.

Usage: Event

Manual operation: See "Arm" on page 100

[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute

Executes a trigger.

Example: See Example"To configure an internal trigger" on page 194.

Usage: Event

Manual operation: See "Execute Trigger" on page 100

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To configure an external trigger" on page 194.

Manual operation: See "Sync. Output to Ext. Trigger/Sync. Output to Trigger"
on page 100

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay <Delay>

Sets the trigger delay.

Parameters:
<Delay> float

Range: 0  to  2147483647
Increment: 0.01
*RST: 0

Example: See Example"To configure an external trigger" on page 194.

Manual operation: See "External Delay/Trigger Delay" on page 101
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[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an exter-
nal trigger event.

Parameters:
<Inhibit> integer

Range: 0  to  21.47*symbRate
*RST: 0

Example: See Example"To configure an external trigger" on page 194.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 101

5.12  Marker commands

Example: To configure a marker signal
// ******************************************************************
// Configure marker mode: set a marker at ARB sequence start.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE RESTart
// SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE STARt
// SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE ACTive

// ******************************************************************
// Alternatively configure pulse marker. Set pulse 
// divider and frequency
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE PULSe
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PULSe:DIVider 2
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PULSe:FREQuency?
// 500000

// ******************************************************************
// Alternatively configure bit pattern marker. Specify pattern.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE PATTern
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PATTern #H2,2
// ******************************************************************
// Alternatively configure on/off ratio marker. Set on/off time.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE RAT
SOURce1:BB:BTOoth:TRIGger:OUTPut1:ONTime 40000
SOURce1:BB:BTOoth:TRIGger:OUTPut1:OFFTime 20000
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Example: To configure marker delay
// ******************************************************************
// Enable fixed marker delay. Query the limit for minimum and maximum
// marker delay. Set delay for the marker signal output.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:DELay 1600

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay................................................200
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift.............................................. 200
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE................................................201
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime..............................................201
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime............................................ 201
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern............................................. 202
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex.............................................. 202
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider....................................202
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQuency?........................... 202
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift.............................................. 203

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 1
*RST: 0

Example: See Example"To configure marker delay" on page 200.

Manual operation: See "Delay" on page 104

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift <Shift>

Shifts the falling edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.

Parameters:
<Shift> float

Range: dynamic  to  dynamic
Increment: 1E-6
*RST: 0

Example: SOURce1:BB:BTO:TRIG:OUTP1:FESH 10
Shifts the falling edge of marker 1 by 75 samples.

Example: See also Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102
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[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> RESTart | STARt | ACTive | PULSe | PATTern | RATio | IACTive

RESTart
A marker signal is generated at the start of each signal
sequence.
STARt
A marker signal is generated at the start of each event/frame.
ACTive
The marker masks the active part of the event/frame. At the start
of each burst, the marker signal changes to high. It changes
back to low after the end of each burst.
PULSe
A regular marker signal is generated. The clock frequency is
defined by entering a divider. The frequency is derived by divid-
ing the symbol rate by the divider. The input box for divider
opens when "Pulse" is selected, and the resulting pulse fre-
quency is displayed below.
PATTern
A marker signal that is defined by a bit pattern is generated. The
pattern has a maximum length of 32 bits and is defined in an
input field which opens when pattern is selected.
RATio
A regular marker signal corresponding to the "Time Off" / "Time
On" specifications in the commands
SOURce1:BB:BTO:TRIGger:OUTPut:OFFTime and
SOURce1:BB:BTO:TRIGger:OUTPut:ONTime is generated.
IACTive
The marker masks the inactive part of the event/frame. At the
start of each burst, the marker signal changes to low. It changes
back to high after the end of each burst.
*RST: RESTart

Example: See Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime <OffTime>
Sets the duration of the ON and OFF periods.

Parameters:
<OffTime> integer

Range: 1  to  16777215
*RST: 1
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Example: See Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern <Pattern>, <BitCount>

Selects the data for a pattern.

Parameters:
<Pattern> numeric

*RST: #H2

<BitCount> integer
Range: 1  to  64
*RST: 2

Example: See Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex <PIndex>

For Bluetooth LE data packets higher than one, sets the packet index. The index corre-
sponds to the transmitted Tx event during the connection interval.

Parameters:
<PIndex> integer

Range: 1  to  depends on "No. Of Tx Packets/Event"
parameter

*RST: 1

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for the clock frequency.

Parameters:
<Divider> integer

Range: 2  to  1024
*RST: 2

Example: See Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the marker pulse frequency.
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Return values: 
<Frequency> float

Range: 2  to  1024
Increment: 1E-3
*RST: 2

Example: See Example"To configure a marker signal" on page 199.

Usage: Query only

Manual operation: See "Mode" on page 102

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift <Shift>

Shifts the rising edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.

Parameters:
<Shift> float

Range: dynamic  to  dynamic
Increment: 1E-6
*RST: 0

Example: SOURce1:BB:BTO:TRIG:OUTPut2:RESH -20
Shifts back the rising edge of marker 2 by 20 samples.

Example: See also Example"To configure a marker signal" on page 199.

Manual operation: See "Mode" on page 102

5.13  Clock commands

This section lists the remote control commands, necessary to configure the clock.

Example: To configure clock settings
// ******************************************************************
// Select internal clock. 
// ******************************************************************
SOURce1:BB:BTOoth:CLOCk:SOURce INTernal
// ******************************************************************
// Alternatively select external clock. Set its mode.
// ******************************************************************
SOURce1:BB:BTOoth:CLOCk:MODe SAMP

[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce.................................................................. 204
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[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce <Source>

Selects the clock source:
● INTernal: Internal clock reference
● ELCLock: External local clock
● EXTernal = ELCLock: Setting only

Provided for backward compatibility with other Rohde & Schwarz signal generators

Parameters:
<Source> INTernal

*RST: INTernal

Example: See Example"To configure clock settings" on page 203.

Manual operation: See "Clock Source" on page 105
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Glossary: Specifications
Symbols

[1]: Bluetooth SIG: Bluetooth Core Specifcation v5.4
https://www.bluetooth.com/specifications/bluetooth-core-specification
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